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ABOUT THIS MANUAL 

New users are recommended to follow this manual in order, as each 
section builds on the information introduced in previous sections.  Check 
the glossary in the back of this manual for quick explanations of 
unfamiliar terms.  An index has also been included for your convenience.      

First Time Install Checklist 

Not sure where to start?  The following checklist provides the bare bones steps necessary 

to get your MINI-T-NX system up and running.   

 TASK 

Install MINI-T-NX System (for an overview, refer to the MINI-T-NX Installation 

Quick Guide):  

 1. Connect MINI-T-NX signal wiring (see “Connecting Signal Wiring,” on page 

35). 

 Route video/audio sources to switcher input connectors. 

 Route destinations (such as a modulators and preview monitor) to switcher 

output connectors. 

 Set up video/audio sources to receive MINI-T-NX control commands via 

PRO-BUS or integrated IR as appropriate. 

 2. Connect MINI-T-NX to an Ethernet TCP/IP network (see “Configuring 

Ethernet Network Host Management,” on page 37). 

 3. Enter TCP/IP addresses into MINI-T-NX front panel (see “Configuring Front 

Panel Settings,” on page 39). 

Install & Configure MINI-T-NX Control Software, WinLGX (for an overview, refer to 

the WinLGX Installation & Configuration Quick Guide):  

 4. Load WinLGX software on a PC workstation (see “Installing WinLGX 

Software,” on page 44). 

 5. Add your MINI-T-NX’s IP address to the “Locations” database (see “Adding / 

Deleting MINI-T-NX Locations in the Site Manager,” on page 46).  If the “Add 

new controller” dialog box does not display your MINI-T-NX server’s serial 

number, check your IP address and network connections and try again. 

 6. Log into WinLGX (see “Connecting to Your MINI-T-NX Server/Controller,” on 

page 48).  If the “Add new MINI-T-NX” dialog box does not display your MINI-

T-NX’s serial number, check your IP address and network connections and try 

again. 

 7. Create user accounts and assign rights (see “Setting User Account Rights 

(Including WinLGX Password Changes)” on page 61). 
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 TASK 

 8. Set time zone and clock (see “Configuring Site Information, Clock, Updating 

Firmware, and Rebooting,” on page 66). 

 9. Configure the MINI-T-NX’s system properties (see “Configuring MINI-T-NX 

System’s Switcher Properties,” on page 85) and IR ports (see “Configuring 

MINI-T-NX IR Port Properties,” on page 88). 

 10. Configure the following device properties: 

 Internal (see “ 

 Configuring MPEG Recording Presets,” on page 90 and “Editing Internal 

MPEG Player and Recorder Device Resources,” on page 91)  

 External (see “Creating External Device Resources,” on page 95) 

 11. Check PRO-BUS interface, IR port, and switcher wiring by sending a 

command to each device from the control panel as follows: 

a. Select a device controlled by a PRO-BUS interface, or IR port in the left-

hand “Device” column on the control panel window. 

b. Send a command to the selected device from the “Device control” section 

of the control panel and ensure the device itself responds accordingly (see 

“Using Control Panel to Perform Immediate Device and Switch Actions,” 

on page 192). 

NOTE: To check video quality, switch your device to an output 

connected to a monitor.   

 12. Upload slides to the MINI-T-NX user folders through the WinLGX Storage 

Manager window and enable/authorize for display in slide shows (see 

“Managing SLIDES: Uploading to the MINI-T-NX and Authorizing for Display,” 

on page 211 or for an overview, refer to the WinLGX Slide Management 

Quick Guide). 

NOTE: Slides are displayed through the WinLGX schedule or control 

panel. 

 13. Pre-program any device and switch resources under the “Library” tab (see 

“Creating Library Resources,” on page 104). 

 14. Save your system configuration settings and resources in a MINI-T-NX image 

file (see “Saving MINI-T-NX Image Files,” on page 140). 
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 TASK 

Use WinLGX to Control MINI-T-NX System (for an overview, refer to the WinLGX 

Scheduling Quick Guide):  

 15. If not already open, load a MINI-T-NX image file (see “Opening MINI-T-NX 

Image Files,” on page 137). 

 16. Control MINI-T-NX system through either of the following: 

 Create & execute a schedule. 

 Immediately control devices through control panel. 
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INTRODUCTION 

The LEIGHTRONIX MINI-T-NX combines digital video server technology, DVD and VCR 

control, video/audio switching, and digital video messaging in one rack-mountable chassis.  

The MINI-T-NX provides fully integrated digital video playback and an MPEG recorder 

option, while providing support for your legacy equipment.  Provided with the MINI-T-NX is 

WinLGX, a software application with a programmable database of events for unattended, 

automated control.  When the MINI-T-NX “sees” a match between the current day and 

time and a programmed event, the event is executed. 

Your LEIGHTRONIX MINI-T-NX Controller is designed to be used in a host of different 

applications, including the following scenarios: 

 AUTOMATED PROGRAM BROADCASTING AND DIGITAL VIDEO MESSAGING 

MINI-T-NX Controllers are intended for use throughout the cable television and 

broadcast industry for automated program broadcasting.  Common industry 

branches include low-power television (LPTV), master-antenna television (MATV), 

and locally originated cable television channels such as public access, educational 

access, government access, and leased access.  

In addition, MINI-T-NX Controllers may be used for private in-house networks, as 

found in hospitals, hotel and resort channels, or corporate and manufacturing 

communications channels.  With MINI-T-NX Controllers, these institutions would be 

able to automatically feed programming, video signals such as character generators, 

and JPEG slides to the desired channel at the proper time. 

 UNATTENDED PROGRAM RECORDING 

MINI-T-NX Controllers are well suited for use in satellite and network recording.  

With a MINI-T-NX Controller, you are able to switch to the proper satellite at the 

desired time in order to capture the programming you need for your operations. 

MINI-T-NX Controllers may also be used for playback verification and program 

archiving. 

 TIMED EVENT SWITCHING 

MINI-T-NX Controllers are designed to accommodate complex switching tasks, such 

as Syndex Switching, channel wild-card switching, and channel sharing.  This 

expands the flexibility of your channels and your programming opportunities.  

Perform Syndex Switching by scheduling your MINI-T-NX to switch syndicated 

programming to only the channels with the corresponding syndication rights.  Use 

your MINI-T-NX to switch a different satellite signal to a channel in a process known 

as channel sharing or perform wild-card sharing by switching to any available source 

on a channel.  
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SAFETY INSTRUCTIONS 

1. Read these instructions. 

2. Keep these instructions. 

3. Heed all warnings. 

4. Follow all instructions. 

5. Do not use this apparatus near water. 

6. Clean only with dry cloth. 

7. Do not block any ventilation openings. Install in accordance with the manufacturer’s 

instructions. 

8. Do not install near any heat sources such as radiators, heat registers, stoves, or other 

apparatus (including amplifiers) that produce heat. 

9. Do not defeat the safety purpose of the grounding-type plug. A grounding-type plug 

has two blades and a third grounding prong. The third prong is provided for your 

safety. If the provided plug does not fit into your outlet, consult an electrician for 

replacement of the obsolete outlet. 

10. Protect the power cord from being walked on or pinched particularly at the plugs, 

convenience receptacles, and the point where they exit from the apparatus. 

11. Only use attachments/accessories specified by the manufacturer. 

12. Unplug this apparatus during lightning storms or when unused for long periods of time. 

13. Refer all servicing to qualified service personnel. Servicing is required when the 

apparatus has been damaged in any way, such as power-supply cord or plug is 

damaged, liquid has been spilled or objects have fallen into the apparatus, the 

apparatus has been exposed to rain or moisture, does not operate normally, or has 

been dropped. 

14. When the apparatus is turned off, certain components in the power supply and system 

board remain energized. In order to remove all electrical power from the apparatus, 

unplug the power cord from the MAINS socket outlet. 

 

 
WARNING 

To reduce the risk of electric shock, do not expose this apparatus to 

rain or moisture. 

 

 
WARNING 

This apparatus must be connected to a MAINS socket outlet with a 

protective earthing connection. 
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MINI-T-NX CONTROLLER FEATURES/SPECIFICATIONS 

NOTE: In no event shall LEIGHTRONIX be liable for any damages whatsoever 

resulting from loss of use, data, or profits, whether or not advised of the 

possibility of damage, and on any theory of liability, arising out of or in 

connection with the use or performance of the MINI-T-NX Controller and 

WinLGX software. 

FEATURE SPECIFICATIONS 

Dimensions 1.75"H X 19.00"W X 8.25"D  

Weight, without carton or 

cables 

8 lbs. 

Display 2 X 24 character vacuum fluorescent display 

Keypad Four pushbuttons which allow password protected front 

panel status and configuration 

Power  12VDC regulated input with locking coaxial power 

connector 

 External AC power adapter accepts 100–240VAC @ 

50–60Hz 

 AC power consumption 25 watts @ 120VAC 

Product Safety Certifications Certified and listed as: 

 Audio, Video and Similar Electronic Apparatus Safety 

Requirements ANSI/UL 60065, 7
th
 edition  

 Audio, Video and Similar Electronic Apparatus Safety 

requirements CAN/CSA C22.2 No. 60065:03, 1
st
 

edition 

Compliance FCC Part 15 

Internal Clock  Temperature compensated crystal oscillator 

 Battery-backed time and date 

Internal Memory  Type: 

 Internal battery-backed memory 

 Data integrity verified 

 Stores the following: 

 IP address 

 Subnet mask 

 Gateway 

 Time clock parameters 

 User login and rights information 

 Schedule information sent to MINI-T-NX 
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FEATURE SPECIFICATIONS 

 Up to 300 JPEG slides 

Ethernet Network Host 

Management 
 Remote Support: Dial-up Networking 

 Network Support Interface: 

 Eight-position, eight-conductor RJ-45 modular jack, 

10/100 BASE-T, unshielded twisted pair, Ethernet 

 Ethernet_II frame type 

 Protocol: TCP/IP 

 Services: Telnet 

 Maximum simultaneous network connections: four 

 Logging: internal 

Firmware  Updateable via Ethernet 

 Cycle redundancy check (CRC) verified at time of 

reprogram 

WinLGX Software  Compatible with Windows
®
 2000/XP operating systems 

 Control modes: 

 Drag and drop event scheduling with error/conflict 

reporting 

 System control panel for immediate control 

 Schedule event capacity: 3000 

 Library holds up to 2000 resources 

CONTROL FEATURES 

FEATURE SPECIFICATIONS 

Internal MPEG File Storage 250 GB hard drive 

Internal Switcher 8x2 internal switcher, includes: 

 7 external video/audio inputs for source switching 

 Input 8 internally tied to MPEG Player 

 Output 1: external video/audio output for on-air display 

 Output 2: external video/audio output shared by the 

internal MINI-T-NX MPEG Recorder and the “Preview” 

video/audio ports on the rear panel of the MINI-T-NX. 

Programming on any input scheduled for MPEG 

recording or manually switched to Output 2, labeled 

“Rec/Prev” in WinLGX, will display on a monitor 

connected to the “Preview” ports.   

NOTE:  Output 2 cannot be scheduled to display 
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FEATURE SPECIFICATIONS 

programming. 

1 Internal MPEG Player  Displays JPEG slides and MPEG video files 

 Full D1 MPEG-2 resolution 

 10Mb/s maximum video bit rate 

Internal MPEG Recorder 

Option 
 Configurable video/audio encode rates per recording 

 Variable bit rate encoding 

 Records for up to 6 hours 

1 PRO-BUS Port  Control up to 8 LEIGHTRONIX-supported VCRs and 

some DVD players at once through individual PRO-BUS 

device interfaces 

 Provides four-function control (PLAY, STOP, REWIND, 

and RECORD) 

2 Infrared (IR) Ports  Control up to 2 LEIGHTRONIX-supported VCRs and 

some DVD players 

 Provides four-function control (PLAY, STOP, REWIND, 

and RECORD) 
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LIMITS ON CONTROL OF DVD PLAYERS 

The LEIGHTRONIX MINI-T-NX provides two different types of DVD automation control: 

 Integrated IR: built-in infrared control ports with basic play-stop DVD player control 

and play-stop-record control for select DVD player/recorders 

 PRO-BUS: optional device control interfaces for infrared and wired remotes 

provide basic play-stop DVD player control and play-stop-record DVD 

player/recorder control for select DVD players/recorders 

Despite our best efforts, some operational functions are beyond our control. Some DVDs 

possess formatting that prevents cuing to specific disc titles and chapters. The control 

method and protocol utilized by the DVD player can also impact control of DVD playback.   

 

The following sections discuss some of the limits on the control of DVD players. 

AUTOMATIC POWER SAVING FEATURES 

Newer consumer model DVD players may automatically power off after a period of 

inactivity as part of an energy saving effort sponsored by the U.S. Government. This 

makes control difficult and, in some cases impossible. Not all consumer models have this 

energy saving feature. The effected models can sometimes be identified by an 

ENERGYSTAR
®
 label on the shipping container and often on the product itself (refer to 

www.leightronix.com for more details).  The use of commercial/professional DVD 

equipment is recommended to avoid this problem. 

PLAYBACK OF COMMERCIAL MOVIES 

Commercial movies licensed for broadcast on a cable network are often no different from 

movies rented at a local video outlet.  DVD movies usually contain formatting that forces 

the viewing of copyright warnings, movie previews, and main menus.  In some cases, 

once the DVD is placed in the DVD player, the DVD forces the player into a PLAY mode 

and cannot accept external control until certain information has been displayed in its 

entirety, hindering our ability to control the DVD. 

PLAYBACK OF YOUR OWN DVDS 

 DVDs Created with a DVD Authoring Station 

DVD authoring software in conjunction with DVD recordable drives allows the user to 

specify how a DVD will be formatted. If you are burning DVDs using a personal 

computer, use the minimum in menuing and interactivity.  If possible, burn only one 

title on the DVD.  If you intend to invest in an advanced DVD control system capable of 

addressing individual programs, you can burn multiple titles:chapters  to make better 

use of the DVD. 

  

 DVDs Created with a Stand-Alone DVD Recorder 

DVDs created on a stand-alone DVD recorder often have one main menu and one or 

more titles.  It has been observed that in most DVD players, these types of DVDs will 
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start with the first title when a PLAY command is received. Whether or not the DVD 

will continue through the disc, playing multiple titles in sequence is determined by the 

DVD recorder used to create the DVD.  The DVD recorder burns preset DVD settings 

and configuration information on the DVD during the finalization of the disc. The 

settings can vary, depending on the make and model of the DVD recorder. This 

formatting may impact playback operation. 

DVD PLAYER/RECORDER CONTROL METHODS 

 Infrared Control 

LEIGHTRONIX has made every attempt to offer support for low-cost DVD players, 

including working within the limitations of the DVD players themselves. Most low-cost 

models offer only wireless infrared control. Infrared communication limits the control 

functionality to basic PLAY-STOP-RECORD commands. This is due to the fact that 

the DVD and the DVD player rely on interactive on-screen menus for selection of 

specific programs on the disc. An automation system simply cannot receive the visual 

prompts necessary to negotiate through various levels of menus (imagine operating a 

DVD player with a wireless remote while blindfolded!).  

SUPPORTED DVD PLAYERS AND RECORDERS 

LEIGHTRONIX maintains an extensive database of supported playback and recording 

devices, including consumer, commercial, and broadcast equipment.  Although many 

consumer models are supported, LEIGHTRONIX does not test operation with every model 

and operation is not guaranteed.   

It is important that you fully understand the capabilities of the various technologies 

involved in your playback system before making a buying decision.  LEIGHTRONIX is 

ready to answer your automation system questions.  Please feel free to contact 

LEIGHTRONIX via email at sales@leightronix.com or call us at (800) 243-5589, Monday 

through Friday, 8:00 to 5:00 PM EST. 
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SLIDE FILE SPECIFICATIONS 

Create your JPEG slides with any third-party graphic software, including Adobe 

Photoshop
®
 and Corel Paint Shop

®
.  When creating slides, keep in mind that PC monitors 

utilize a different pixel shape than television monitors.  To prevent slides from appearing 

stretched when translated from a PC to a TV, refer to the resolution information below. 

NOTE: Slides/overlays with resolutions larger than 1024 x 768 cannot be uploaded to a 

MINI-T-NX. 

 Recommended slide resolutions (pixels) 

Depending on your display requirements, slides for the MINI-T-NX may be created in 

four different sizes.  Slides containing pictures and graphics should be created in a 

resolution of 720 x 540, 800 x 600, or 640 x 480 pixels.  For slides containing only text 

or that are not susceptible to aspect distortion (such as a solid background), use a 

resolution of 720 x 480 pixels.  

 Save slides as JPEG (.jpg) files.  Slide filenames may contain up to 27 characters (no 

spaces) in addition to the required “.jpg” extension. 

 If Photoshop is used to create a slide, ensure the color “ICC Profile” option is not 

selected when the slide is saved or a black screen will be displayed on air instead of 

your slide’s graphics/text. 
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MPEG FILE SPECIFICATIONS 

The MINI-T-NX record channel, internal Output 2, is shared with the “Preview” output on 

the rear panel.  The “Preview” output is not an on-air channel, but is instead meant to be 

connected to a television monitor so you may conveniently view the programming on any 

input scheduled for MPEG recording or manually switched through the control panel to the 

preview output (labeled “Rec/Prev” in WinLGX).   

MINI-T-NX MPEG RECORDER OPTION SPECIFICATIONS 

NOTE: Video being fed to the MPEG recorder must have stable sync.  Input signals 

with copy protection are not recordable.  

The MINI-T-NX internal recorder will only record for up to 6 hours.  

Digital video recording results are based on a combination of the user-defined recording 

presets and the quality of the input source.   In each new MINI-T-NX image file, the MINI-

T-NX internal MPEG recorder is automatically configured for the recording presets named 

“Good,” “Better,” and “Best” shown in Illustration 1. 

Illustration 1, MINI-T-NX MPEG Recorder Default Recording Presets 
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You may use the default recording presets or change the presets based on your recording 

needs.  When selecting your recording presets, consider how video bit rate, video 

resolution, and audio quality settings will affect the quality and file size of your recordings 

(refer to the following sections for more information).  Once you have selected your 

recording presets, create short files for playback on your MINI-T-NX to test the quality of 

your presets. 

 Video Bit Rate 

The size and overall quality of your file is directly related to the selected video bit rates.  

Select either a constant bit rate (CBR) or variable bit rate (VBR) for your file recordings 

based on the following information.  Higher bit rates result in higher quality recordings, 

but keep in mind that your file sizes will be larger and you will be able to fit less video 

onto your hard drive. 

NOTE: MPEG recording does not improve the quality of your input sources.  When 

recording a low quality source, use higher bit rate settings to record a digital 

file of equal quality.   

 Variable Bit Rate (VBR)  

When a VBR is used for recording, the MPEG recorder encodes most of the 

source at the selected minimum bit rate.  WinLGX allows you to select a minimum 

bit rate between 1.50-5.00 Mb/s, at intervals of .10.  The poorest recording quality 

results at a minimum bit rate of 1.50 Mb/s and the best at 5.00 Mb/s. 

The video maximum bit rate does not impact file size.  The MPEG recorder only 

records at the maximum bit rate when there is a lot of movement in the source and 

returns to the minimum bit rate when the movement decreases.  The maximum bit 

rate must be set at least 2 Mb/s above the minimum bit rate. 

 Constant Bit Rate (CBR) 

Use a constant bit rate (CBR) to record sources with little movement or to ensure 

all of your file records at the same bit rate.  Table 1 shows how many hours of 

video can be recorded by the MINI-T-NX onto its internal hard drive at a CBR of 4 

Mb/s. The example given in the table below is based on MPEG-2 encoding with full 

D1 resolution (720x480) video and 224Kb/sec audio bit rate.  

Table 1, Hard Drive Storage Capacities at Selected CBRs 

Total Hard Drive 

Capacity 
Hours @ 4 Mb/s 

250 GB 122 
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 Video Resolution 

The picture quality of your recorded video also depends on the selected video 

resolution.  The following lists the available options: 

 Half (352x480): choose the half screen picture size when recording files at a CBR 

or minimum VBR less than 4 Mb/s.  Files recorded at these rates contain fewer 

pixels, so the picture clarity increases when the pixels are packed into a smaller 

picture size. 

 Full (720x480): choose the full screen picture size when recording files at a CBR 

or minimum VBR of 4 Mb/s and above.  Files recorded at higher bit rates contain 

enough pixels to still look sharp when the pixels are spread out over a larger picture 

size. 

 Audio Quality Settings 

 Audio bit rate: select 224 kb/s for sources with audio tracks or 192 kb/s for sources 

with little or no audio. 

 Audio sample rate: if you intend to burn your MPEG recording to a DVD, select the 

48k sample rate to ensure compatibility with DVD players.  Otherwise, select the 

44.1k audio sample rate. 

 

ENCODING A BACKGROUND AUDIO FILE 

If you are encoding an audio MPEG file to play with a slide or slide show, use the lowest 

possible video bit rate and resolution to reduce the file’s size.   LEIGHTRONIX also 

recommends encoding the file with a solid-colored video display to further reduce the file’s 

size. 
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CREATING MPEG FILES WITH NON-LEIGHTRONIX SOURCES 

The MINI-T-NX supports MPEG-1 and MPEG-2 video encoding standards.  

LEIGHTRONIX recommends the following guidelines for MPEG video files created with 

any third party hardware or software to ensure optimal playback on the internal MINI-T-NX 

MPEG player: 

 MPEG filenames may contain up to 27 characters (no spaces) in addition to the 

required “.mpg” extension.  The MINI-T-NX will not display files with filenames 

containing spaces. 

 Files can be no larger than 16GB 

 Acceptable stream types: 

 MPEG-1 System Stream or MPEG-2 Program Stream (consisting of a single 

elementary video stream with an optional single elementary audio stream) 

NOTE: Transport stream is not possible. 

 Elementary video stream 

 Three video resolutions (pixels) are allowed.  Other resolutions are not supported. 

 352 x 240 (Horizontal x Vertical) 

 352 x 480  

 720 x 480 

 Picture rate must be 29.97 pictures per second. 

 A maximum bit rate of 5 Mb/s is allowed.  Higher rates are not supported.   

 National TV Standards Committee (NTSC) with 4:3 aspect ratio required. 

 4:2:0 sampling format required.  (Main profile at Main or Low level,  10 Mb/s) 

 IBBP group of pictures (GOP) structure recommended for best quality (30 frame 

maximum GOP size). 

 Encode header information in stream every few seconds to aid in error recovery. 

 Audio, if present, must be encoded into the MPEG file using Audio layer II. 

 Audio may be encoded at a 32, 44.1, or 48KHz sampling frequency.  LEIGHTRONIX 

recommends an audio sampling rate of 44.1 KHz for optimal performance. 
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MINI-T-NX FRONT PANEL 

Illustration 2, MINI-T-NX Front Panel 

 

KEYPAD 

The MINI-T-NX has a four-button keypad which is used to display status information and 

enter password-protected TCP/IP addresses.   

If you hold down a key for more than one second, it begins to scroll through all of the 

available options.  If you hold down the key for more than three seconds, it scrolls in turbo 

mode.  Release the key when the desired option is displayed. 

DISPLAY 

The MINI-T-NX has a high brightness, 24 character by 2 line vacuum fluorescent display 

(VFD) which displays status and password-protected TCP/IP address entry screens.   

After the MINI-T-NX has been booted up, press the up or down arrows on the Controller’s 

keypad to display the following status screens: 

 Bios Date 

The bottom line of the screen displays the date of bios on the MINI-T-NX motherboard 

(see Illustration 3, MINI-T-NX Bios Date Status Screen). 

Illustration 3, MINI-T-NX Bios Date Status Screen 

 MINI-T-NX Serial Number and Firmware Version 

The bottom line of the screen displays the serial and firmware version of the MINI-T-

NX (see Illustration 4, MINI-T-NX Serial Number and Firmware Version Status 

Screen). 

Illustration 4, MINI-T-NX Serial Number and Firmware Version Status Screen 

Fri Apr 15 12:00:00PM 

Bios Date: 03/30/07 

Fri Apr 15 12:00:00PM 

SN:030038 V20.3.0 F 
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 MINI-T-NX Display Version 

The bottom line of the screen displays the version of the MINI-T-NX display (see 

Illustration 5, MINI-T-NX Display Version Status Screen). 

Illustration 5, MINI-T-NX Display Version Status Screen 

 MINI-T-NX Firmware Date 

The bottom line of the screen displays the build date of the firmware currently loaded 

on your MINI-T-NX (see Illustration 6, MINI-T-NX Firmware Date Status Screen). 

Illustration 6, MINI-T-NX Firmware Date Status Screen 

 IP Address 

The bottom line of the screen displays the MINI-T-NX’s IP address (see Illustration 7, 

MINI-T-NX IP Address Status Screen). 

Illustration 7, MINI-T-NX IP Address Status Screen 

 Site ID 

The bottom line of the screen displays the MINI-T-NX site ID (see Illustration 8, MINI-

T-NX Site ID Status Screen). 

Illustration 8, MINI-T-NX Site ID Status Screen 

Fri Apr 15 12:00:00PM 

Display Ver: V1.0.0.1 

Fri Apr 15 12:00:00PM 

FW Built: 03/30/07 

Fri Apr 15 12:00:00PM 

IP: 10:1:1:110 

Fri Apr 15 12:00:00PM 

ID: MINI-T-NX  
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 Schedule Status 

The bottom line of the screen displays the MINI-T-NX’s schedule status (see 

Illustration 9, MINI-T-NX Schedule Status Screen). 

Illustration 9, MINI-T-NX Schedule Status Screen 

 Switcher Status 

The bottom line of the screen shows the switcher status (see Illustration 10, MINI-T-

NX Switcher Status Screen).  The first number in each pair is the input number and 

the second is the output number.  The triangle indicates the valid video status on the 

output (solid =valid video, hollow=lack of valid video). 

Illustration 10, MINI-T-NX Switcher Status Screen 

 MPEG Recorder Status 

The bottom line of the screen shows the MPEG recorder status (see Illustration 10, 

MINI-T-NX Switcher Status Screen).  The record time is indicated on the bottom line 

of the screen along with up to thirteen characters of the filename.  

Illustration 11, MINI-T-NX MPEG Recorder Status Screen 

 MPEG Player Status 

The bottom line of the screen shows the MPEG player status (see Illustration 10, 

MINI-T-NX Switcher Status Screen).  The playback time is indicated on the bottom line 

of the screen along with up to thirteen characters of the filename. 

Illustration 12, MINI-T-NX MPEG Player Status Screen 

 

Fri Apr 15 12:00:00PM 

Schedule Active 

Fri Apr 15 12:00:00PM 

7$Output  8$Rec/Prev   

Fri Apr 15 12:00:00PM 

R1:0:00:00 filename.mpg 

Fri Apr 15 12:00:00PM 

MP:0:00:00 filename.mpg 
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LEDS 

The MINI-T-NX front panel has four status light-emitting diodes (LEDs), which give at-a-

glance feedback on the most important MINI-T-NX conditions.  See Table 2, MINI-T-NX 

Front Panel LEDs, for a list of the status LEDs and their descriptions. 

Table 2, MINI-T-NX Front Panel LEDs 

LED DESCRIPTION 

 

Video Lost: the top LED flashes red when the valid video sensor 

detects video is lost and nothing is “on air.”  Check video connections 

and the condition of your sources or switch to another input.   

If a fallback has been set, the MINI-T-NX will switch to the 

programmed fallback input for each output.  It blinks once with a 

switch.   

 

Schedule Active: the second LED glows green when a schedule is 

active and being scanned for events to execute.  If this LED is off, 

your schedule is suspended and no events will happen.   

 

Management: the third LED blinks yellow when a PC connection is 

made.  This lets an operator know that someone is connected to the 

MINI-T-NX over the network, and that configuration, control, and/or 

schedule updates are being performed. 

 

Check Log: the bottom LED glows red if Severity 1 or 2 events have 

been added to the log since it was last downloaded. 
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MINI-T-NX REAR PANEL 

The MINI-T-NX rear panel includes, from left to right, top to bottom (see Illustration 13, 

MINI-T-NX Rear Panel): 

Illustration 13, MINI-T-NX Rear Panel 

 A:  7 RCA audio input connectors for external sources 

 B:  1 RCA audio output connector for on-air display 

 C:  1 RCA audio output connector for preview monitor only  

 D:  Reserved for future use 

 E:  RJ-11 PRO-BUS port 

 F:  2 infrared (IR) transmitters for LEIGHTRONIX-supported VCRs and DVD 

players 

 G:  Factory testing only 

 H:  Power cord connector 

 I: 7 RCA video input connectors for external sources 

 J:  1 RCA video output connector for internal MPEG player 

 K:  1 RCA video output connector for preview monitor only 

 L:  1 10/100 BASE-T RJ-45 Ethernet jack with corresponding LED indicators 
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CONTROLLER INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

Use this section for step-by-step instructions on connecting your MINI-T-NX system 

wiring, including devices and Ethernet.  This section also includes information on entering 

your TCP/IP and serial settings through the front panel.  For an overview of the MINI-T-

NX system installation process, refer to the MINI-T-NX Installation Quick Guide. 

PACKING LIST 

Ensure your MINI-T-NX shipment box contains the following: 

 (1) MINI-T-NX Network-Managed Video System Controller / Digital Video Server 

 (1) MINI-T-NX Manual: Installation, Configuration, and Operation Instructions 

 (1) WinLGX Network Management Software 

 (1) Part #10-0311, AC Power Cord, 6 ft. 

 (1) Part #10-4856, CAT 5e Ethernet Cable, 7 ft. 

 (2) Part #10-5135, Infrared Transmitter Cables, 6 ft. each 
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MINI-T-NX INSTALLATION OVERVIEW 

Figure 1 shows a sample connection scenario for the MINI-T-NX using the controller’s 

internal switcher.  The MINI-T-NX MPEG Player is available through MINI-T-NX Input 8, 

while the optional MPEG recorder is accessed through MINI-T-NX internal Output 2.  

Configuration and control of the MINI-T-NX and its connected devices are conducted 

through a 10/100 BASE-T Ethernet connection. 

The MINI-T-NX internal switcher provides two external outputs along with seven external 

inputs for source devices.  Output 1 is for destination equipment and Output 2 may be 

used for a preview monitor only.  In Figure 1, a variety of video and audio sources (VCRs, 

DVD players, satellite or studio feeds, character generator, etc.) are connected to the 

inputs.  The VCRs and DVD players are configured in this example system to receive 

control commands from the MINI-T-NX through external PRO-BUS interfaces and the IR 

ports on the MINI-T-NX’s rear panel.  External LEIGHTRONIX PRO-BUS interfaces 

connect input devices on a common wire to the MINI-T-NX PRO-BUS port and are 

available with infrared, mini-jack, and multi-pin connectors.  The MINI-T-NX integrated IR 

ports provide infrared control for LEIGHTRONIX-supported VCRs and DVD players. 

Figure 1, Example of MINI-T-NX System 

Mon, January 1, 12:00:00PM

   IP: 10.255.0.13 LEIGHTRONIX MINI-T-NX
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CONNECTING SIGNAL WIRING  

Throughout the following instructions, refer to Illustration 13, MINI-T-NX Rear Panel. 

1. Rack mount your MINI-T-NX as follows, ensuring that the ventilation holes on the side 

of the unit are not covered. 

NOTES: LEIGHTRONIX recommends leaving empty rack mounts above and below 

the MINI-T-NX.  The MINI-T-NX is not intended to have anything stacked 

on top of it. 

a. Insert the MINI-T-NX into the rack, aligning the holes of the Controller’s mounting 

bracket with those of the rack. 

b. Secure the MINI-T-NX to the rack with user-supplied rack screws.  

2. Route the video/audio from your VCRs, DVD players, studio/satellite feeds, character 

generator, etc. to the switcher video/audio inputs.   

3. Connect switcher video/audio Output 1 to the desired destination, such as a 

modulator.  

4. If desired, attach a monitor to the “Preview” Output video/audio ports.  The “Preview” 

Output (labeled “Rec/Prev” in WinLGX) allows you to conveniently view the 

programming on any input.   

NOTE: Any input switched to the “Preview” Output is routed to the internal MPEG 

recorder as well as the preview monitor. 

5. In order to send basic control commands (PLAY, STOP, REWIND, RECORD) to your 

external devices, connect supported VCRs and DVD players to the following 

interfaces.  For information on supported VCRs and DVD players, visit the 

LEIGHTRONIX Web site (www.leightronix.com) or contact LEIGHTRONIX at 1-800-

243-5589. 

 Attach up to two, LEIGHTRONIX-approved VCRs and/or DVD players to the MINI-

T-NX integrated IR ports.   

 Attach up to eight PRO-BUS device interfaces in a daisy chain to the MINI-T-NX 

PRO-BUS jack and connect each interface to the corresponding VCRs and/or 

DVD players.  See “Appendix C: PRO-BUS Interface Connections,” on page 234 

for further installation instructions.   

NOTES: For organizational purposes, LEIGHTRONIX recommends 

performing the following: 

 a. Set each interface’s dip switches to assign each PRO-BUS 

interface a device number from 01–16. Number the PRO-

BUS interfaces consecutively, starting with “01” at the 

interface connected to the PRO-BUS jack on the MINI-T-NX.   

 b. If possible, ensure each device’s switcher input numbers 

correspond to the device number of its PRO-BUS. 

 c. Document your entire PRO-BUS interface/device setup. 

http://www.leightronix.com/
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6. Attach the included power cord to the power cord connecter on the back of the MINI-T-

NX, and then plug it into an AC power source.  

 

CAUTION 

LEIGHTRONIX strongly recommends the use of an 

Uninterruptible Power Supply (UPS) with the MINI-T-NX.  

Damage from power loss or spikes is not covered under 

warranty. 

7. Turn on the MINI-T-NX by simultaneously pressing the right and left arrows on the 

front panel for one second. 

The MINI-T-NX will automatically boot up and display the following messages: 

a. Initial boot up screen: gives the bootware version, memory size, and memory check 

status (see Illustration 14, MINI-T-NX Bootware Screen). 

Illustration 14, MINI-T-NX Bootware Screen 

b. Boot up progress screens: give the MINI-T-NX’s boot progress (see Illustration 15, 

MINI-T-NX Boot Progress Screens).  During initialization, any saved MINI-T-NX 

settings and active schedule are implemented.  

Illustration 15, MINI-T-NX Boot Progress Screens 

 

 

8. Proceed to “Configuring Ethernet Network Host Management,” on page 37, to 

configure MINI-T-NX for remote control through Ethernet network host management. 

LEIGHTRONIX, INC. 

Boot 1.0.8  16MB ok 

LEIGHTRONIX, INC. 

Decompressing firmware.. 

LEIGHTRONIX, INC. 

Executing firmware.. 

Initializing ... 
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CONFIGURING ETHERNET NETWORK HOST MANAGEMENT 

NOTES:  Your PC must have a Windows 2000/XP/Vista/7 operating system in order 

to run WinLGX software. 

  If you will be connecting to your MINI-T-NX remotely, ensure your router is 

configured so that at least pass-through ports 20, 21, 23, 80, and 1025 are 

open to the MINI-T-NX’s IP address.  Refer to your router manual for 

further instructions. 

The MINI-T-NX Controller is designed to interact with a host PC through a 10/100 BASE-

T Ethernet TCP/IP Network.  Two of the most common connection scenarios are outlined 

below.   

CONNECTING MINI-T-NX TO AN EXISTING ETHERNET NETWORK 

1. Obtain the following from your technical support personnel or network administrator 

and enter into the front panel of your MINI-T-NX (see “Configuring Front Panel 

Settings,” on page 39): 

 IP address 

 Subnet mask 

 Gateway address 

2. Using a straight-through RJ-45 Ethernet cable, connect the MINI-T-NX’s Ethernet port 

to a 10/100 BASE-T hub or switch on the TCP/IP network. 

3. Ensure the PC from which you wish to control your MINI-T-NX has been configured 

and attached to the TCP/IP network. 

4. Ensure your Controller and PC have been properly configured for Ethernet network 

access (see “Confirming Ethernet Network Configuration,” on page 38). 

CONNECTING MINI-T-NX DIRECTLY TO A PC VIA ETHERNET 

1. If necessary, install and configure a 10/100 BASE-T Ethernet Network Interface Card 

(NIC) on the PC.  Refer to the NIC documentation and technical support for help in 

getting the NIC operational. 

2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows: 

a. Click on the Windows “Start” menu. 

b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on 

your keyboard to open the command.com window. 

c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your 

PC’s IP and subnet mask address. 

3. Enter the following IP and subnet mask addresses into the front panel of your MINI-T-

NX Controller (see “Configuring Front Panel Settings,” on page 39): 

 IP address: one number above your PC’s IP address (for example, if your PC’s IP 

address is 10.255.9.15, set your Controller’s IP address to 10.255.9.16) 
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 Subnet mask: your PC’s subnet mask address 

4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the MINI-T-

NX to the PC’s network interface card (NIC). 

5. Ensure your Controller and PC have been properly configured for Ethernet network 

access (see “Confirming Ethernet Network Configuration,” on page 38). 

CONFIRMING ETHERNET NETWORK CONFIGURATION 

Once your MINI-T-NX and PC have been configured for Ethernet access, ensure the 

Ethernet LEDs on the rear panel of your Controller are lit (see Table 3, Ethernet LED 

Indicators and Descriptions). 

Table 3, Ethernet LED Indicators and Descriptions 

LED POSITION STATE DESCRIPTION 

Left Off Ethernet link not established. 

Green Ethernet link established. 

Right Off MINI-T-NX is not transmitting on the network. 

Amber MINI-T-NX is transmitting on the network. 
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TURNING THE MINI-T-NX ON/OFF 

Turn the MINI-T-NX on/off by simultaneously pressing the right and left arrows on the 

front panel for one second. 

 

CONFIGURING FRONT PANEL SETTINGS 

NOTE: All crucial configuration information, such as user information, schedule 

information, time, and network information are stored in battery backed or flash 

memory.  Thus the MINI-T-NX Controller configuration is protected in the 

instance of an extended power failure. 

ENTERING PASSWORD 

1. Press the right arrow key from any one of the status screens to display the password 

entry screen (see Illustration 16, MINI-T-NX Password Entry Screen).   

Illustration 16, MINI-T-NX Password Entry Screen 

2. Press five-key password.   

NOTE: The factory-default password is five right arrow keys.  To change the front 

panel password, refer to “Changing Front Panel Password,” on page 65. 

3. If the password entered is correct, the MINI-T-NX’s configuration menu will be 

displayed (see Illustration 17, MINI-T-NX Configuration Menu Screen).  If an incorrect 

password is entered, the display returns to the status screens.  The menu allows you 

to edit your MINI-T-NX’s IP, subnet mask, and gateway addresses and serial port 

options.   

Illustration 17, MINI-T-NX Configuration Menu Screen 

Using arrow keys 

Enter Password:***** 

CONFIG MENU (Use `/ˆ) 

Edit XXXX               ~ 
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EDITING IP ADDRESS 

Obtain IP address from your technical support personnel or network administrator.   See 

Table 4, Editing IP Address from Front Panel, for editing instructions. 

Table 4, Editing IP Address from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit unit IP Address.”  

2. Press “→” to select “Edit unit IP Address.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any MINI-T-NX address 

changes (simultaneously press “←” and “→” for one second to turn off and repeat to 

turn back on). 

EDITING SUBNET MASK 

Obtain subnet mask address from your support personnel or network administrator.   See 

Table 5, Editing Subnet Mask from Front Panel, for editing instructions. 

Table 5, Editing Subnet Mask from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “.”  

2. Press “→” to select “Edit unit Subnet Mask.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

Enter new Subnet Mask 

   0.   0.   0.   0.  

CONFIG MENU (USE `/ˆ) 

Edit unit Subnet Mask  ~ 

 

Press right arrow to confirm IP 

Address_     

 

Enter new IP Address 

  0.  0.  0.   0    ~ 

CONFIG MENU (USE `/ˆ) 

Edit unit IP Address  ~ 
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SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any MINI-T-NX address 

changes (simultaneously press “←” and “→” for one second to turn off and repeat to 

turn back on). 

EDITING GATEWAY ADDRESS 

Obtain gateway address from your technical support personnel or network administrator.  

See Table 6, Editing Gateway Address from Front Panel, for editing instructions. 

Table 6, Editing Gateway Address from Front Panel 

GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit unit Gateway Addr.”  

2. Press “→” to select “Edit unit Gateway Addr.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any MINI-T-NX address 

changes (simultaneously press “←” and “→” for one second to turn off and repeat to 

turn back on). 

 

Press right arrow to confirm 

Gateway_        

 

Enter new Gateway 

  0.  0.  0.   0       ~ 

CONFIG MENU (USE `/ˆ) 

Edit unit Gateway Addr ~ 

 

Press right arrow to confirm 

Subnet Mask_            
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SOFTWARE INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

This section introduces the MINI-T-NX management software, WinLGX, and provides 

instructions on how to enter the configuration settings necessary to control your MINI-T-

NX through the software.  For an overview of how to install WinLGX and enter your 

configuration settings, refer to the WinLGX Installation and Configuration Quick Guide 

included with your MINI-T-NX.  Your MINI-T-NX system configuration properties describe 

your switcher, IR port, and MPEG recording presets along with the devices attached to 

your system and the media resources you wish to play on the devices.  The configuration 

properties must be entered into an image file before you can go on to creating a schedule 

of events (refer to the next section, “Software Operation,” starting on page 129, to learn 

how to create a schedule).  Each MINI-T-NX image file holds your schedule events 

along with your system, device, and library resource properties.  To avoid 

reentering your configuration information every time you create a new schedule, save an 

image once you have entered the system, device, and library properties and before 

entering any schedule events.  Open and rename this saved image each time you wish to 

create a new schedule. 
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WINLGX MINIMUM SYSTEM REQUIREMENTS 

For the best results while operating WinLGX, LEIGHTRONIX recommends using a 16-Bit 

color display adapter at 1024x768 plus the following, based on your operating system: 

NOTE: WinLGX does not have to be continuously running on your PC for standard 

MINI-T-NX operation.   

Microsoft Windows 2000 (SP4) or XP Microsoft Windows Vista/7 

1.0 GHz or faster processor 1.6 GHz or faster processor 

512 MB of RAM (1 GB recommended) 1 GB of RAM (2 GB recommended) 
 

 

INSTALLING WINLGX SOFTWARE 

1. Place the LEIGHTRONIX PRODUCT RESOURCE DISC in your CD-ROM drive.  

The HTML page shown in Illustration 18 should automatically load.   

Illustration 18, LEIGHTRONIX HTML Index Page 

 
 

If the HTML page does not load, perform the following steps: 
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a. Open the Windows “My Computer” folder. 

b. Double click your CD-ROM drive. 

2. From the LEIGHTRONIX HTML page, click the “MINI-T-NX” button.  This will load a 

new page with content specifically for your system. 
 

3. From the WinLGX software HTML page, click on the “WinLGX Software” link.  A new 

window containing the executable file will open. 

4. Double click on the file “WinLGX v* Installer.EXE” to start the installer. 

5. Choose “YES” to continue installing the software. 

6. Setup will then prompt you for a program folder.  The default is “Leightronix, Inc.,” but 

you may change it to anything you desire. 

7. Once you have selected a file path, setup installs the software and creates icons.  It 

will prompt you again when it is finished. 

8. Click “Finish” to close the installer and return to Windows. 
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ADDING / DELETING MINI-T-NX LOCATIONS IN THE SITE MANAGER 

Use the WinLGX “Site Manager” window to manage your MINI-T-NX server/controller’s 

network IP address information.  WinLGX uses each server’s IP address to locate the 

server and send/receive the server’s system information.  Manage the IP address listing of 

your MINI-T-NX server/controllers as follows: 

ADDING MINI-T-NX IP ADDRESSES 

1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the 

main toolbar to open the “Controller Site Manager” window shown in Illustration 19. 

Illustration 19, “Controller Site Manager” Window 
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2. Click “Add” on the “Controller Site Manager” window (see Illustration 19) to open the 

“Add new controller” window shown in Illustration 20.  Complete the following fields: 

Illustration 20, “Add New” Window 

 

 “IP Address”: enter the IP address displayed on the MINI-T-NX server’s front 

panel.  This address can be viewed from the front panel by pressing the up or 

down arrows until the IP Address is shown.   

NOTE: Do not enter 255.255.255.255 in the “IP Address” field. 

 Enter your user account name in the “User” field. 

 Enter your password in the “Password” field. 

NOTES:  Your username and password may only contain letters and 

numbers. 

 If you have not changed the username and password from the 

factory defaults, they are as follows: 

FACTORY-DEFAULT USERNAME AND PASSWORD FOR MINI-T-NX  

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR MINI-T-NX SERVER’S 

SERIAL #   

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 
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3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, 

serial number, and time zone displays in the “Add new” window. 

NOTE: If this is the first time your MINI-T-NX server has been added to the site 

manager database, the following information will be displayed: 

 “Site ID”: name of the product 

 “Location”: “undefined” 

 “Serial Number”: your MINI-T-NX server’s serial number 

 “Time Zone”: your time zone 

Illustration 21, “Add New” Window 

 

4. Click “OK” to enter your MINI-T-NX server in the site manager database or “Cancel” to 

abort entry.   

5. If applicable, repeat steps 2–4 for each additional MINI-T-NX server in your system. 

DELETING MINI-T-NX IP ADDRESSES FROM SITE MANAGER 

Click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the 

“Controller Site Manager” window shown in Illustration 19.  Perform the following steps: 

1. Highlight the NEXUS series IP address you wish to delete. 

2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the MINI-T-

NX IP address from the site manager location.   

3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the 

database, or click “Cancel” to discard your changes. 

CONNECTING TO YOUR MINI-T-NX SERVER/CONTROLLER 

Before you can start controlling your MINI-T-NX system(s), you must first connect to each 

of your MINI-T-NX server/controllers.  This allows WinLGX to locate the 



MINI-T-NX 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 49 

2018-06-08  WinLGX ver. 6.0.1.48 
 

server/controller(s) you wish to operate and enables the software to send your settings 

and commands to each connected MINI-T-NX system. 

1. Open the WinLGX “Site Manager” window (see Illustration 27) by performing one of 

the following:   

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 22, “Site Manager” Window 

 

2. Once the WinLGX “Site Manager” is open, you should see a list of your MINI-T-NX 

systems.  If not, refer back to “Adding / Deleting MINI-T-NX Locations in the Site 

Manager,” on page 46. 

3. If desired, reorder your MINI-T-NX server listing.  Clicking on any column header in the 

“Site Manager” sorts the associated information in ascending order, while clicking the 

header again sorts the list in descending order. 

4. Connect as follows (see Illustration 27): 

NOTE: The WinLGX title bar on the main window states whether or not you are 

connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 

holding down your keyboard “Ctrl” key and clicking each address with the left 

mouse button.     
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b. Log in with the username and password given to you by the MINI-T-NX system 

administrator.  To simultaneously log into multiple servers, all of the selected IP 

addresses must have the same username and password. 

NOTE: Connect to multiple MINI-T-NX servers with different usernames and 

passwords by logging in separately to each controller. 

If the username and password have not been changed from the factory defaults, 

enter the following: 

MINI-T-NX FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR MINI-T-NX SYSTEM’S 

SERIAL # 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 

password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will be 

displayed. 

  An administrator can assign various degrees of rights to each 

username, so not all menu items or functions may be available to a 

user. 

  The last six digits of your MINI-T-NX server’s serial number are 

viewable from the front panel (see “Configuring Front Panel 

Settings,” on page 39) and a sticker on the back of your MINI-T-NX 

server. 

c. Click “Connect” or press “Enter” to connect to the chosen MINI-T-NX 

server/controller(s) and close the login dialog box.  Once you are connected, a tab 

appears for each MINI-T-NX server/controller on the main window beneath the 

toolbar.  If you logged into more than one MINI-T-NX system, switch between the 

server/controllers by clicking on the MINI-T-NX product tabs on the main window. 



MINI-T-NX 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 51 

2018-06-08  WinLGX ver. 6.0.1.48 
 

CREATING NEW MINI-T-NX IMAGE FILES 

Before you get started entering your system settings into WinLGX, create and save a 

MINI-T-NX system image file.  MINI-T-NX system image files hold your system, device, 

and library resource properties as well as your schedule events.  MINI-T-NX image files 

have a .nmg file extension (for ex., schedule.nmg). 

NOTE: To open a saved MINI-T-NX image file, go to “Opening a Saved Image File,” on 

page 137. 

1. WinLGX automatically opens with an empty image file loaded.  If you need to clear any 

settings, select “New” under the “File” menu. 

2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 88, 

“Save As” Window.”  

Illustration 23, “Save As” Window 

 

3. From the “Save in” drop down box at the top of the window, navigate to the folder 

where you want to save the MINI-T-NX image file.   

4. Type a name for the image in the “File name” field.   

5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” 

field. 

6. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save 

as.”   



MINI-T-NX 

Software Installation & Configuration 

Page 52   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

7. As you enter your configuration settings according to the “Configuring WinLGX” 

section starting on page 52, periodically save your settings in your image file by 

selecting “Save” from the “File” menu or clicking the  toolbar button. 

 

CONFIGURING WINLGX 

ABOUT THE MAIN WINDOW COMPONENTS 

Icons to run the WinLGX software are installed on the Windows desktop and in the “Start 

Menu\Programs\Leightronix, Inc.” folder.  Choosing either of these icons opens the 

WinLGX main window shown in Illustration 24. 

Illustration 24, WinLGX Main Window 

 

The components of the main window are as follows: 

 Product Tab(s): a tab appears for each login connection so that users with more 

than one LEIGHTRONIX server/controller can switch between product views in 

WinLGX.  Each product view is self-contained, allowing users to enter separate 

configuration and scheduling information for each controller. 

 Schedule: contains any scheduled events. 

 Configuration folders window: contains the “System Configuration,” “Devices,” 

and “Library” folders. 
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 “Resources View” window: displays the icons of the folder selected in the 

configuration folders window. 

 “Properties” window:  displays the properties of the icon selected in the 

“Resources View” window. 

 Title bar: displays the program name and connection status, as well as buttons for 

minimizing, restoring/maximizing, and closing WinLGX. 

 Menu bar: contains drop-down menus of WinLGX operations (see Illustration 25, 

Menu Bar and Table 7, Menu Bar Items). 

Illustration 25, Menu Bar 

 

Table 7, Menu Bar Items 

MENU ITEM FUNCTION 

“File” 

 

Click on this menu item to display the following options: 

 “New”: returns window to default settings and removes any user scheduling 

settings (see page 51) 

 “Open”: opens file selection window for selecting image files (see page 138) 

 “Open as New”: opens file selection window to open an image file with a 

blank schedule (see page 138) 

 “Save”: saves a MINI-T-NX image that was previously saved as a file or 

opens file window for saving a MINI-T-NX image under a user-specified 

name and folder (see page 140) 

 “Save as”: opens file window for saving a MINI-T-NX image under a user-

specified name and folder (see page 140) 

 “Send”: select to send MINI-T-NX image with a schedule to the MINI-T-NX 

Controller (see page 191) 

 “Receive”: select to receive image from the connected MINI-T-NX (see 

page 139) 

 “Get log”: select to obtain log file from the connected MINI-T-NX (see page 

214) 

 “Page setup”: opens window to configure schedule printout (see page 70) 

 “Print setup”: opens window to configure the printer and paper settings (see 

page 71) 

 “Print”: click to select template and then print schedule (see page 133) 

 “Exit”: closes WinLGX program (see page 136) 
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MENU ITEM FUNCTION 

“Edit” Click on this menu item to display the following options (see 

“Scheduling/Editing/Deleting All Events,” starting on page 147): 

 “Edit”: use to edit an event in the schedule  

 “Cut”: select to remove an event from a schedule and send to WinLGX’s 

clipboard 

 “Copy”: select to copy an event in the schedule to WinLGX’s clipboard 

 “Paste”: select to paste a copied event into the schedule 

 “Delete”: select to remove an event from a schedule 

 “Select All”: select all events on the selected channel and day/WinLGX-LT 

tab configuration’s schedule event window  

“View”  Check the following options to display the corresponding toolbar, window, or 

schedule columns (see page 57): 

 “Schedule Columns”: displays a window that allows you to show and hide 

the schedule columns of your choice 

 “System Configuration View”: allows you to hide/show the “System 

Configuration View” window 

 “Resource”: allows you to hide/show the “Resource View” window 

 “Properties”: allows you to hide/show the “Properties” window  

 “Toolbar”: allows you to hide/show the main toolbar 

 “Status Bar”: allows you to hide/show the “System Configuration View” 

window 

 “Reset View”: returns the “System Configuration View,” “Resource View,” and 

“Properties” windows to their default positions on the main window 
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MENU ITEM FUNCTION 

“Tools” Click on this menu item to display the following options: 

 “Control Panel”: opens control panel window (see “Using Control Panel to 

Perform Immediate Device and Switch Actions,” beginning on page 192) 

 “Controller”: opens window for configuring LEIGHTRONIX Controller site 

information, setting clock, performing firmware updates, and rebooting (see 

page 66) 

 “Set front panel password”: opens window for setting front panel password 

(see page 65) 

 “Export/Print Templates”: opens window for creating templates that 

determine which schedule information is exported or printed (see page 68) 

 “User defined data”: opens window for configuring user-defined schedule 

event columns (see page 72) 

 “Storage Manager”: opens window for managing MPEG videos and JPEG 

slides (see page 208) 

  “Site Manager”: opens window for adding or deleting LEIGHTRONIX 

Controller locations (see page 48) 

 “User accounts”: opens window for configuring user account settings (see 

page 61) 

 “Total Backup”: opens window for saving and restoring MPEG videos, 

slides, and MINI-T-NX system information (see page 226) 

 “System tools”:  

 “Switchback editor”: provides access to the “Channel Switchback 

Editor” window.  The switchback editor allows users to quickly change 

the inputs assigned to the switchback intervals between programs (see 

page 188) 

 “Sync Library Resources”: checks MINI-T-NX image files for library 

resources and schedule events referencing MPEG files no longer on the 

MINI-T-NX’s internal hard drive (see page 190) 

 “Preferences”: opens window for configuring WinLGX main window 

components, including time format, schedule colors, sorting filter for library 

resource items, and display of schedule columns (see page 75) 

“Help” Click on “About WinLGX” to display a window with the WinLGX version number 

(see “Displaying WinLGX Version Number,” on page 132). 

 Main Toolbar: contains icons for some of the most frequently used operations 

(see Illustration 26 and Table 8, Toolbar Items). 

Illustration 26, Main Toolbar 

   

Table 8, Toolbar Items 
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TOOLBAR BUTTON FUNCTION 

 
Opens file selection window for opening an image file with a blank 

schedule (see “Opening an Image File as New” on page 138)   

 
Opens file selection window for selecting image files (see “Opening a 

Saved Image File” on page 137) 

 

Saves a MINI-T-NX image that was previously saved as a file or opens 

file window for saving a MINI-T-NX image under a user-specified name 

and folder (see “Saving MINI-T-NX Image Files,” on page 140) 

 
Displays control panel window (see “Using Control Panel to Perform 

Immediate Device and Switch Actions,” beginning on page 192) 

 
Sends MINI-T-NX image with a schedule to the MINI-T-NX (see 

“Sending MINI-T-NX Image Files,” on page 191) 

 

Receives image from the connected MINI-T-NX (see “Receiving Image 

Files from the Connected MINI-T-NX Server/Controller(s)” beginning on 

page 139) 

 

Checks MINI-T-NX image files for library resources and schedule events 

referencing MPEG files no longer on the MINI-T-NX’s storage device(s) 

(see “Checking Schedule and Library Resources for Missing MPEG 

Files” on page 190) 

 
Displays window for managing JPEG slides and MPEG videos (see 

“Managing Digital File Storage,” on page 208) 

 
Obtains log file from the connected MINI-T-NX (see “Retrieving Log 

Files,” on page 214) 

 
Opens window for saving and restoring MPEG videos, slides, and MINI-

T-NX system information (see “Appendix A: Total Backup,” on page 226) 

 

Displays window for adding or deleting MINI-T-NX locations (see 

“Adding / Deleting MINI-T-NX Locations in the Site Manager,” on page 

46) 

 
Displays window for selecting an export/print template (see “Printing 

Schedules from WinLGX,” on page 133) 

 
Returns the “System Configuration View,” “Resource View,” and 

“Properties” windows to their default positions on the main window 

 
Displays a window with the WinLGX version number (see page 132) 
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CONFIGURING THE MAIN WINDOW COMPONENTS 

 Controller Tabs: you can change the order of your controller tabs.  Simply click on 

each tab with the left mouse button and then, while holding down the left mouse 

button, drag the tab into the desired position. 

 Hiding/Displaying Toolbars, Windows, and Schedule Columns  

The “View” menu, shown in Illustration 27, may be used to hide or show the 

schedule column headings, configuration folders, “Resources View” window, 

“Properties” window, and status bar.   

Illustration 27, “View” Menu 

 

 To hide/display a window or toolbar, click on the desired checked item in the 

“View” menu to hide it on the main window or on an unchecked item to display 

it.   

The show/hide function may also be accessed by right clicking on the menu 

bar, the main toolbar or the schedule configuration folders, “Resources View,” 

or “Properties” window title bars.  Once the configuration folders, “Resources 

View,” and “Properties” windows are removed from their original positions, 

they may also be hidden by right clicking on each window’s title bar and 

selecting “Hide” in the context menu that appears. 

 

 To return the “System Configuration View,” “Resource View,” and “Properties” 

windows to their default positions on the main window, select “Reset View” in 

the “View” menu or click the  icon on the toolbar. 
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 To hide/display schedule columns, click on “Schedule Columns” in the “View” 

menu or the “Schedule” tab under “Preferences” in the “Tools” menu (see 

“Setting WinLGX Viewing and Communication ,” on page 75).  Note that the 

“Day of Week Columns” listing corresponds to the columns in the schedule 

day tabs and the “WinLGX-LT” listing corresponds to the columns in the 

schedule WinLGX-LT tab (see Illustration 28, Schedule Columns Selection 

Menu).  Perform the following steps: 

Illustration 28, Schedule Columns Selection Menu 

 

1. Click on the desired combination of the following: 

 Checked column heading if you want to hide the corresponding 

column on the schedule or on an unchecked item if you want to display 

it 

 “All” button to display all of the columns for the corresponding 

schedule tabs  

 “None” button to remove all columns from corresponding schedule 

tabs  

2. When all selections have been made, click “OK” to display changes on 

schedule or “Cancel” to abort changes. 
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 Moving Windows  

The configuration folders, “Resources,” and “Properties” windows may be moved to 

any location on the main window by clicking on the windows’ title bars and dragging 

the windows to the desired position on the main window.  To re-dock the windows 

in their original positions, click on the windows’ title bars and drag to the far right 

side of the main window. 

 Rearranging Schedule Column Headings 

To rearrange the order of the schedule column headings, click on the desired 

heading and drag it over the heading you would like it to displace.  The displaced 

heading will shift to the left of the newly positioned heading. 

 Resizing Schedule Column Widths 

To resize a column heading, move the mouse pointer over the right-side border of 

the column you wish to resize.  When the pointer changes to the resize arrows 

symbol (see Illustration 29, Resizing Schedule Column), you may perform one of 

the following: 

Illustration 29, Resizing Schedule Column 

 

 Drag the column border to the desired width. 

 Double click to resize the column so it is only wide enough to accommodate the 

column’s largest field item. 

 

 Using Subfolders to Organize “Library” Folder Resources 

 Creating library subfolders 

1. Right-click in the configuration folders window and select “New” in the right-

click menu that appears. 

2. A new subfolder will be displayed under the “Library” folder.  To rename the 

subfolder, right click on its name and select “Rename” in the right-click 

menu that appears.  Enter a new folder name. 

Resize Arrows 

Symbol 
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 Adding existing library resources to subfolders 

Right click on a library resource icon and select “Move to” in the menu that 

appears to display the window shown in Illustration 30.  Display the “Library” 

folder’s subfolders by either clicking on the “+” next to the folder icon or 

checking the “Expand all” box. 

Illustration 30, "Select Destination Folder" Window 

 

 Adding new library resources to a subfolder 

Select the desired “Library” subfolder in the configuration folders window and 

create a new library resource in the “Resources View” window. 

 Deleting a library subfolder 

Right click on the desired library subfolder and select “Delete” in the menu that 

appears. 
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SETTING USER ACCOUNT RIGHTS (INCLUDING WINLGX PASSWORD CHANGES) 

1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see 

Illustration 31).  

NOTE: This menu item will only become enabled upon login for users with 

“Administrator” rights. 

Illustration 31, “User Accounts” Window 

 

2. WinLGX user rights are described in Table 9, User Control and Configuration Rights 

(see page 63) and Table 10, User File Access Rights (see page 64).  Perform any of 

the following according to the steps below: 

 Add a user account 

 Edit a user account 

 Delete a user account 

NOTE: All functions controllable from the MINI-T-NX’s front panel are only 

restricted by the front panel password. 

3. When finished configuring user information, exit the “User Accounts” window by 

clicking the “Close” button. 
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 Add a user account 

a. Click “Add.” 

b. Enter new username and password. 

NOTES:  Logins are case sensitive. 

  Your username and password may only contain letters and 

numbers. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 

rights. 

 Click the “None” button to deselect all of the “Control and configuration” 

user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user and 

may not be deselected. 

 Individually select the rights you want the user to possess by checking the 

corresponding user rights boxes.  To deselect a right, uncheck it by clicking 

on its box. 

d. Click “Ok” to send the new user settings to the MINI-T-NX or “Cancel” to abort 

the addition. 

 Edit a user account 

NOTE: When editing the “admin” user account, only the password may be 

changed. 

a. Highlight the desired username and click “Edit.” 

b. If desired, change username and/or password. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 

rights. 

 Click the “None” button to deselect all of the “Control and configuration” 

user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user and 

may not be deselected. 

 Individually select the rights you want the user to possess by checking and 

unchecking the corresponding user rights boxes.  

d. Click “Ok” to send the new user settings to the MINI-T-NX or “Cancel” to abort 

the edit. 
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 Delete a user account 

NOTE: All slides uploaded under the user account will be deleted from the MINI-

T-NX along with the account. 

a. Highlight the desired username and click “Delete.” 

b. In the dialog box that appears, click “Yes” to delete user or “No” to abort the 

change.  

Table 9, User Control and Configuration Rights 

USER RIGHTS DESCRIPTIONS 

“Administrator (user 

accounts, firmware)” 

Allows user to change user account rights, front panel password, 

and volume names and perform firmware updates 

“Automatic slide 

authorization” 

Causes any slides uploaded by the user via the Storage Manager 

to be automatically authorized for display  

“Device (play, 

rewind, stop)” 

Allows user to cause a device to play, rewind, or stop 

“Device (record)” Allows user to cause a device to record 

“MPEG/Slide control 

(play)” 

Allows user to play an MPEG file or display a slide from the Control 

Panel; also, allows user to schedule a slide/slide show 

“MPEG/Slide control 

(record/setup)” 

Allows user to record MPEG files from the Control Panel  

“Schedule control” Allows user to stop or run a schedule  

“Site identity 

configuration” 

Allows user to edit the MINI-T-NX site name and location and 

reboot the MINI-T-NX 

“Slide Administrator” Allows user to authorize slides for display in slide shows 

“Switcher control” Allows user to perform switches from Control Panel 

“Switcher and serial 

configuration” 

Not used 

“System 

configuration 

(control/clock)” 

Allows user to set clock from the “Controller” window under the 

“Tools” menu 

“System status” This is a default right that allows all users to view the MINI-T-NX 

status from the Control Panel 

“TCP/IP 

configuration” 

Allows user to set up the TCP/IP addresses 
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Table 10, User File Access Rights 

USER RIGHTS DESCRIPTIONS 

“No file access” User prevented from performing the following: 

 Adding, renaming, or enabling JPEG slides within his 

remote user folder 

 Sending and receiving MINI-T-NX image files 

 Opening the “Storage Manager” window (see “Managing 

Digital File Storage,” on page 208, for more information on 

the Storage Manager)   

 Accessing current log files 

“Receive only” User prevented from performing the following: 

 User prevented from adding, renaming, or enabling JPEG 

slides within his remote user folder 

 User prevented from sending MINI-T-NX image files and 

moving/copying JPEG slides and MPEG files from one 

storage device to another  

“Send and receive”  User allowed to perform all JPEG slide management functions 

(add, rename, delete, enable) within his remote user folder 

 User allowed to send slides and MPEG videos to MINI-T-NX, 

but not image (schedule) files; user prevented from renaming 

and deleting files on the remote storage devices 

“Send, receive, 

rename and delete” 
 User allowed to perform all JPEG slide management functions 

(add, rename, delete, enable) within his remote user folder  

NOTE: The “admin” user and users with the “slide 

administrator” right can access slides in all remote 

user folders.  

 User allowed to perform all software functions, including 

sending and receiving MINI-T-NX images (schedules) and 

renaming and deleting JPEG slides and MPEG files on the 

remote storage devices 
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CHANGING FRONT PANEL PASSWORD 

1. Select “Set front panel password” in the “Tools” menu to open the window shown in 

Illustration 32. 

Illustration 32, “Set Front Panel Password” Window 

 

2. Click on a combination of five arrows for the new front panel password. 

3. Click “Set” to accept new password or “Clear” to cancel. 

4. Click “Done” to close the “Set Front Panel Password” window. 
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CONFIGURING SITE INFORMATION, CLOCK, UPDATING FIRMWARE, AND 

REBOOTING 

1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 33, 

“Controller” Window. 

Illustration 33, “Controller” Window 

 

2. Use the “Controller” window to set the following configuration maintenance settings.  

After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for 

confirmation to perform the action on the connected MINI-T-NX.  Clicking “Yes” opens 

a box showing location name, action status, progress bar, and connection and action 

attempt counts.  An “action completed” box appears when finished.  If the action 

appears to be stalled or if you would like to interrupt the action, click the “Cancel” 

button. 

 Site name 

Click on the “Site name” field and enter an alias into the field.  Click “Set” to make 

the change.  This name will appear on the Controller’s tab on the main window. 
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 Site location 

Click on the “Site location” field and enter the Controller’s location into the field.  

Click “Set” to make the change. 

 Time Zone 

Select the desired time zone from the list and click the “Set” button above the time 

zone field.  The list contains the standard Windows time zones for the United 

States.  If you would like the clock to automatically adjust for daylight savings time, 

check the corresponding box under the time zone field. 

 Clock 

Set your Controller’s clock using one of the following methods: 

 Use your PC’s time: click the “Set” button to the right of the “PC Current time” 

field.  WinLGX uses the PC time, PC time zone, and Controller time zone to set 

the time, adjusting the time to account for zones crossed.  All of these items 

need to be correct for the set time to be accurate. 

 Enter the date and/or time in the “User time” date and time fields.  Either type or 

use each field’s drop down menu to enter the new date and/or time and click 

the “Set” button. 

 Firmware Update 

To perform a firmware update, refer to “Updating MINI-T-NX Controller Firmware,” 

on page 219. 

 Reboot   

To reboot the connected MINI-T-NX, click the “Reboot” button. 

3. Click “Close” to close the “Controller” configuration window. 
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CREATING TEMPLATES FOR EXPORTING/PRINTING SCHEDULES 

Schedule templates allow you to determine what schedule information will be exported or 

printed.  Schedules can be exported into comma delimited or Microsoft Excel
®
 formats 

and then printed (see “Exporting Schedules,” on page 134) or printed directly from 

WinLGX (see “Printing Schedules,” on page 133). 

1. Create a schedule template per the following steps:  

a. Click “Export/Print templates” in the “Tools” menu to open the window shown in 

Illustration 34.  

Illustration 34, “Export/Print Templates” Window 

 

b. Select template display items as follows: 

NOTES:  The “Format” field is intended for future use and may only be set to 

“Report.” 

 Click “New” to clear all settings. 

` 

 Determine which event windows will be filtered for the schedule template:   

1. Check the boxes in “Day/LT” section to select the desired days (or LT). 
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2. Check the boxes in the “Channel” section to select the channel outputs that 

should be included for the selected days.   

NOTE: The channel list varies depending on your system switcher 

configuration.   

 Check the “Export/print switchbacks” checkbox to display switchback intervals 

between programs.   

 Check “Export/print all records” to include all events in the selected event 

windows.   

NOTE: This function overrides any export or print values set to “No” in the 

device and library resource and event properties. 

 Add/remove schedule fields (columns) in template as follows: 

 Add a field to the “Used” list by double clicking a field item in the “Available” 

list or selecting it and clicking “>>.” The fields in the “Used” list will be 

printed/exported in the selection order listed.   

 To add a field in a specific order within the “Used” list, highlight the “Used” 

display item you would like to display the new field before.  Double click a 

field item in the “Available” list or select it and click “>>.” The new field is 

added above the selected field (select the blank field at the bottom to add a 

field to the end of the list). 

 Remove a “Used” field, by double clicking it or selecting it and clicking “<<.” 

c. Click “Save” to save the template to a file.   

2. To revise a template: 

a. Click “Export/Print Templates” in the “Tools” menu to open the window shown in 

Illustration 34, “Export/Print Templates” Window. 

b. Click “Load.”  In the “Select Export/Print Template” window that appears, browse 

for the desired template and open.  The filename will then appear in the “Template” 

box at the top of the “Export/Print Templates” window.   

3. Click “Done” when finished to close the “Export/Print Templates” window. 
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CONFIGURING PAGE LAYOUTS FOR SCHEDULES PRINTED FROM WINLGX 

The following steps allow you to determine the page layout of schedules printed directly 

from WinLGX.   

1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 35, “Page 

Setup” Window, and configure the schedule printout according to the following 

options: 

Illustration 35, “Page Setup” Window 

 

 “Print Header information” section: check the items you want to appear at the top of 

the printout.  “Program version” refers to the top two lines shown in Illustration 36, 

Example of a Schedule Header. 

Illustration 36, Example of a Schedule Header 

WinLGX  Version 1.01.20                                                          Page 1 

Copyright © 2005,  LEIGHTRONIX, INC. 

Image Filename: MINI-T-NX.nmg 

Template Filename: nxs.xpt 

Today is: Mon Apr 18 13:02:33 2005 

  “Print Record information” section: check the items you want to appear above the 

schedule data.   

 “Field names” shows the column headers.   

 “Separator bar” inserts a line of dashes. 

 “Print Font” section: choose the font size and weight (normal/bold). 

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 
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CONFIGURING PRINTER AND PAPER SETTINGS FOR SCHEDULES PRINTED 

FROM WINLGX 

1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 37, “Print 

Setup” Window, which allows you to configure the printer and paper settings as 

follows:   

Illustration 37, “Print Setup” Window 

 

 “Printer” section: choose the desired printer from a list of your PC’s available 

printers.  When a printer is chosen, its status appears below the “Name” field.   

 “Properties” button”: click to open a window specific to the printer, so that detailed 

printer settings can be made. 

 “Paper” section: choose the size and source tray of the paper.   

 “Orientation” section: choose to print in portrait or landscape mode.  If your printing 

template has many fields (columns) chosen, you may want to print in “Landscape” 

mode to fit it all from left to right.  Print in “Portrait” mode if you don’t have many 

fields (columns) and want to fit more events on a page. 

 “Network” button: click to open a network printing window so that you can attach to 

and print to a network printer, if it is not already in the upper list.  

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 
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CONFIGURING USER-DEFINED SCHEDULE COLUMNS 

The 11 generic “Field Name” schedule columns allow you to categorize the events in your 

schedule.  Users may assign each of these columns a new heading along with a list of 

menu items that can be used to classify each event added to the schedule. Using the 

“User Defined Data” window, shown in Illustration 39, rename and add menu items to the 

desired field columns as follows: 

Illustration 38, Example of Schedule with User Defined Fields 

 

1. Click “User defined data” under the “Tools” menu to open the window shown in 

Illustration 39. 

Illustration 39, “User Defined Data” Window 

 

2. Select the fields displayed on your schedule as follows: 

 To show all fields, ensure the “Show all field names” box is checked. 

 To hide all fields, ensure the “Show all field names” box is unchecked. 
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 To hide one or more fields, uncheck the “Show” box next to the each field you 

would like to hide. 

3. Click on the field which you would like to rename.  In the “Edit Field Options” window 

that appears (see Illustration 40), perform the following: 

Illustration 40, “Edit Field Options” Window 

 

a. Enter a new schedule heading into the “Menu title” field. 

b. Add a list of menu items that will be used to define schedule events under the 

renamed column.  The number of menu items that may be added corresponds to 

the number of options shown over each section of field names on the window. 

 Add new menu items: click the “Add” button to display the “Add menu item” 

window (see Illustration 41).  Enter the desired menu item and click “OK” to add 

to the “Menu item” drop down list or “Cancel” to abort the change. 

Illustration 41, “Add Menu Item” Window 
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 Edit menu items: select the desired menu item from the drop down list and click 

the “Edit” button to display the “Edit menu item” window (see Illustration 42).  

Enter a new menu item and click “OK” to change the “Menu item” drop down 

list or “Cancel” to abort the change. 

Illustration 42, “Edit Menu Item” Window 

 

 Delete menu items: select the desired menu item from the drop down list and 

click the “Delete” button to display a confirmation window (see Illustration 43).  

Click “Yes” to change the “Menu item” drop down list or “No” to abort the 

change. 

Illustration 43, Menu Item Delete Confirmation Box 

 

4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit 

Field Options” window and return to the “User Defined Data” window. 

5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined 

Data” window. 
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SETTING WINLGX VIEWING AND COMMUNICATION PREFERENCES 

In the “Tools” menu, choose “Preferences” to open the “Preferences” window.  Perform 

the following tasks from the window’s five tabs.  Click “OK” on the bottom of the 

“Preferences” window to save changes you have made in any of the tabs or “Cancel” to 

discard them. 

Application Tab 

Click the “Application” tab (see Illustration 44, “Application” Tab) and perform any of the 

following: 

Illustration 44, “Application” Tab 

 

 “Default controller type”: select a default controller type from the drop down 

menu.  When opened, WinLGX will automatically display the window settings for 

the selected controller type.  This allows you to create and save image files when 

you are not connected to your controller. 
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 “Maximize web display”: this option does not apply to the MINI-T-NX. 

 “Sync library resources when sending or receiving image”: when this option 

is selected, WinLGX automatically checks MINI-T-NX image files for library 

resources and schedule events referencing MPEG files no longer on the MINI-T-

NX’s internal hard drive (see “Checking Schedule and Library Resources for 

Missing MPEG Files” on page 190 for more details).  The check is triggered when 

the WinLGX open, receive, and send image file operations are performed. 

 “24 hour time format”: select to change WinLGX to a 24 hour (military) time 

format.  If left unselected, WinLGX defaults to a 12 hour (A.M./P.M.) time format.   

NOTE: This does NOT change the time format on the front of your MINI-T-NX.  

 “Load image from controller after connect/login”: selecting this option causes 

the image file last sent to the Controller to be loaded after the user logs into 

WinLGX.  

 “Use passive FTP”: if your firewall is blocking your schedule and MPEG files, 

check this option and then resend the files to your MINI-T-NX.    

 “Hide event editor when dropping library objects”: if selected, an event 

properties window will not be displayed when a library item is dragged onto any of 

the schedule’s day tabs unless you are holding down the keyboard “Alt” key. 

 “Show WinLGX-LT tab in the schedule window”: select this box to display the 

corresponding tab at the bottom of the schedule window.  Refer to “WinLGX-LT 

Tab” on page 144 for more information on this tab. 

 “Default single slide length”: type or use the up/down arrows to specify the 

number of seconds WinLGX will automatically place in the “length” field for a slide 

library resource or schedule event after a slide filename is selected.  The default 

display length may be changed to a value of 5–90 seconds.  You may edit the 

“length” values for each of your single slide library resources or schedule events. 

 “Frame rounding threshold (frames)”: type or use the up/down arrows to set a 

rounding threshold from 5–29 frames (the default value is 5 frames).  This option 

allows you to control the playback duration of your MPEG files based on the last 

milliseconds of video/audio frames (1 second of an MPEG file = 30 frames).  Once 

the threshold value is set, the MPEG player will round the playback duration of any 

files with frames equal to or greater than the threshold up to the nearest second.  If 

the number of frames at the end of a file is less than the threshold value, the file’s 

playback duration will be trimmed down to the nearest second.   

 “Apply to all channel switchbacks”: when a digital library resource is dragged 

onto a schedule program interval and the “Apply to all switchbacks” option is 

checked (see page 187 for more information on filling schedule program intervals), 

the following will occur based on which of the options below is selected: 

 “By the day”: fills schedule switchback intervals between events on the selected 

channel output’s day tab 

 “By the week”: fills schedule switchback intervals between events on all of the 

channel output’s day tabs   
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 “Default control panel switch layout (for 256 or fewer crosspoints)”: this 

option does not apply to the MINI-T-NX. 

 “Total Backup application folder”: define where the MINI-T-NX Total Backup 

software application is installed by entering a file path or browsing to it with the 

yellow folder icon.  Setting this preference enables you to open the program from 

within WinLGX with the Total Backup icon or menu item. 

 Under “Log viewer,” click the button to the right of the log viewer field to select a 

software program for viewing your MINI-T-NX log files. 

 

Resource Library Tab 

Click the “Resource Library” tab (see Illustration 45, "Resource Library" Tab) and check 

the “‘Show in program guide’” property to automatically populate the corresponding fields 

when creating MPEG playback library resources (go to page 110 for more information on 

creating MPEG library resources).   

Illustration 45, "Resource Library" Tab 
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Color/Schedules Tab 

Click the “Color/Schedules” tab (see Illustration 46, “Color/Schedules” Tab) and choose 

the following text and background colors for the schedule window:  

Illustration 46, “Color/Schedules” Tab 

 

 Event rows in the schedule 

 Selected events in the schedule  

 Schedule switchback (SWB) intervals 

 Filled schedule switchback (SWB) intervals 

 “Event Properties” window fields available for editing 

 “Event Properties” window fields not available for editing 

 “Playlist” library resource events 

 

Does not apply to 

MINI-T-NX 

Color of “Playlist“ 

Library Resource 

Events  

Colors of 

Alternating 

Events in 

“Schedule” View  

Color of Selected 

Events in 

“Schedule” View 

Color of Schedule 

Switcback (SWB) 

Intervals 

Color of Schedule 

Switchback (SWB) 

Intervals Filled with 

“Playlist” Resources 

Color of Filled 

Schedule Switchback 

(SWB) Intervals 

Does not apply to 

MINI-T-NX 

Color of “Event 

Properties” Window 

Fields Available for 

Editing 

Color of  

 “Event Properties” 

Window Fields Not 

Available for Editing 

Colors Used to 

Highlight Schedule 

Events with MPEG 

Files Not on the 

Internal Hard Drive 

Checking this option will 

cause selected day and 

output channel tabs to turn 

the colors selected under 

“Schedule selection.”  Also, 

day and output channel tabs 

containing schedule events 

will change to the colors 

selected under “Schedule 

alternate text,” while tabs 

without events will remain the 

colors set under “Schedule 

normal text.” 
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Color/Control Panel Tab 

Click the “Color/Control Panel” tab (see Illustration 47, “Color/Control Panel” Tab Window) 

and choose the text and background colors for the MINI-T-NX control panel. 

Illustration 47, “Color/Control Panel” Tab Window 

 
 

Color/Other Tab 

This tab is not used for the MINI-T-NX. 
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Event Editor Tab 

Each event properties window for a device or library resource item may be configured to 

show different fields under a “minimum” and “maximum” view.  During scheduling, you 

may toggle between these views by selecting and deselecting the “Maximum view” 

checkbox on the event properties dialog (refer to Illustration 48). 

Illustration 48, Example of Event Properties Window 

 
 

Maximum View 

Selected 
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To configure the field views for your device and library event properties windows, click the 

“Event Editor” tab (see Illustration 49, “Event Editor” Tab Window) and perform the 

following: 

Illustration 49, “Event Editor” Tab Window 

 

1. Under “Format type,” select the format of the device/library event properties window 

you would like to configure. 

2. Perform any of the following options: 

 “Restore defaults” button: click to return the selected format’s minimum and 

maximum views to the factory default settings. 

 “Minimum view” column 

 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the minimum view 

for the event properties dialog. 
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 “All” button: click to show all fields within the minimum view for the event 

properties dialog.  

 “None” button: click to hide all fields within the minimum view for the event 

properties dialog. 

  “Maximum view” column 

 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the maximum view 

for the event properties dialog. 

 “All” button: click to show all fields within the maximum view for the event 

properties dialog.  

 “None” button: click to hide all fields within the maximum view for the event 

properties dialog. 

Resource View Tab 

Click the “Resource View” tab (see Illustration 50, “Resource View” Tab Window) and 

configure the icon sorting filter for your library resource items. 

Illustration 50, “Resource View” Tab Window 
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Schedule Tab 

Click the “Schedule” tab (see Illustration 51, “Schedule” Tab Window) and hide/display 

columns in the “Schedule” view.  Note that the “Day of Week Columns” listing 

corresponds to the columns in the schedule day tabs and the “WinLGX-LT” listing 

corresponds to the columns in the schedule WinLGX-LT tab.  Perform the following 

steps: 

Illustration 51, “Schedule” Tab Window 

 

1. Select the columns displayed on your schedule as follows: 

 To show all columns in the corresponding schedule tab, click the “All” button.  

 To hide all columns in the corresponding tab, click the “None” button. 

 To hide one or more columns in the corresponding tab, uncheck the boxes next to 

the columns you would like to hide. 

2. When all changes have been made, click “OK” to display changes on schedule or 

“Cancel” to abort changes. 
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CONFIGURING MINI-T-NX SYSTEM’S SWITCHER PROPERTIES 

Use the “System Configuration” folder windows to view and organize the internal 

switcher’s inputs and outputs within WinLGX.   

Click on the “System Configuration” folder on the right side of the schedule editor window 

to display the MINI-T-NX “System Configuration” windows (see Illustration 52, MINI-T-NX 

Internal Switcher Windows).  Click on the “Switch” icon and complete the following 

“Properties” fields. 

NOTE: Input and output labels, descriptions, and icon assignments are optional. 

Illustration 52, MINI-T-NX Internal Switcher Windows 
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 “Switch type”:  automatically set to “Internal.” 

 Input Settings 

In the “Input” field, select an input and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control Panel 

input button (up to 10 characters total—the number of characters that fit will 

depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 

appear when your mouse cursor moves over the corresponding Control Panel input 

button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel window. 

 Output Settings 

In the “Output” field, select an output and complete the following settings.   

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control Panel 

output button and schedule editor window channel output tab (up to 10 characters 

total—the number of characters that fit will depend on the case and characters you 

choose). 

 “Description”: type the description (up to 32 characters total) you would like to 

appear when your mouse cursor moves over the corresponding Control Panel 

output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel window. 
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 “Switchback Input”: select one of your inputs as the video source you would like 

WinLGX to automatically switch to the output at the end of a scheduled event. 

During scheduling, the switchback input may be changed in the event properties 

window.   

 “Fallback Enable”:  you may configure loss-of-video fallback settings from the 

“Fallback Enable” field for Outputs 1 and 2 as follows: 

1. Select “No” to disable the loss-of-video fallback for the selected output.  

2. Select “Yes” to enable loss-of-video fallback and display the “Delay” field.  If 

video is lost on the selected output, the configured switchback input will display 

on the output.  Delay can be set from 1–99 seconds.  This means that if valid 

video is lost from that output and not restored within its “Delay” time, the the 

switchback video source will be switched to the selected output. 

 Channel Output Assignments 

The MINI-T-NX internal switcher’s channel outputs are represented by tabs on the left 

side of the schedule window.  The MINI-T-NX automatically assigns Output 1 to 

Channel 1 and, if you have purchased the MPEG recorder option, Output 2 to Channel 

2.   
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CONFIGURING MINI-T-NX IR PORT PROPERTIES 

Click on the “System Configuration” folder on the right side of the schedule editor window 

to display the MINI-T-NX “System Configuration View” windows.  Click on the “Internal IR 

Interface” icon and complete the “Properties” fields for each MINI-T-NX IR port as follows 

(see Illustration 53, MINI-T-NX “System Configuration View” IR Port Windows): 

Illustration 53, MINI-T-NX “System Configuration View” IR Port Windows 

 

1. IR Port: configure each IR port for a VCR or DVD input device by selecting the 

corresponding format from each IR port field’s drop down list. 

2. “Manufacturer”: choose the corresponding, LEIGHTRONIX-supported manufacturer 

for each input device format (see Table 11, IR Port Configuration Options, for a list of 

the LEIGHTRONIX-supported VCR/DVD manufacturers). 

Table 11, IR Port Configuration Options 

DEVICE MANUFACTURER MODES 

VCR JVC  10 Bit  

 16 Bit A (typical for most JVC VCRs) 

VCR Panasonic Default—no selection 
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DEVICE MANUFACTURER MODES 

VCR Sony  VCR1 

 VCR2 

 VCR3 

 Institutional 

DVD Panasonic 

 

NOTE: Both modes support Panasonic DVD record 

functionality. 

 1 PLAY 

 2 PLAY: a play command from the MINI-T-NX is 

transmitted as two playback commands to the DVD 

player.  Some DVD players need 2 plays to wake 

up and play from standby, while others increase 

playback speed if a second play is received. 

DVD Pioneer  Player: issues commands for Pioneer DVD players 

 Player/Recorder: issues commands for Pioneer 

DVD player/recorders 

DVD Sony  2 STOP/2 PLAY: issues two stops and two play 

commands to ensure DVDs always start from the 

beginning  

 2 PLAY: issues two play commands to ensure 

DVDs resume from where they were last stopped 

DVD Tascam Default—no selection 

3. “Type”: configure each IR port to match the connected device’s communication mode.  

Refer to Table 11, IR Port Configuration Options, for a list of the LEIGHTRONIX-

supported VCR/DVD manufacturers and their corresponding communication modes. 

NOTE: Some of the LEIGHTRONIX-supported VCRs and DVDs are capable of 

communicating in different modes to allow multiple devices to be controlled 

by a single remote control.  The device mode is often indicated by a mode 

switch on the device’s front panel.  If your device’s mode is unknown, try 

each setting in the “Type” drop down list until control is achieved.   
 



MINI-T-NX 

Software Installation & Configuration 

Page 90   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

CONFIGURING MPEG RECORDING PRESETS FOR RECORDER OPTION 

Click on the “System Configuration” folder on the right side of the schedule editor window 

to display the MINI-T-NX “System Configuration View” windows.  Click on the “Internal 

MPEG Recorder” icon and complete the “Properties” fields for each record preset 

according to the following steps (see Illustration 54, MINI-T-NX “System Configuration 

View” Internal MPEG Recorder Windows).  For more information on recording an MPEG 

file, refer to “MPEG File Specifications,” on page 23. 

Illustration 54, MINI-T-NX “System Configuration View” Internal MPEG Recorder Windows 

 
 “Record Preset x”: if desired, click in the field and enter a new name for the preset. 

 “Video resolution”: select “Half (352x480)” or “Full (720x480)” resolution for your video 

display. 

 “Bitrate type”: select “CBR” for constant bit rate or “VBR” for variable bit rate. 
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 If you selected “VBR,” the “Min video bitrate” and “Max video bitrate” fields will be 

displayed: click on the fields and use the up/down arrows to set your minimum and 

maximum video bitrates between 1.50–5.00 Mb/sec.  WinLGX requires that an 

increment of two be left between the bit rates. 

 If you selected “CBR,” the “Video bitrate” field will be displayed: click on the field 

and use the up/down arrows to set the video bit rate between 1.50–5.00 Mb/sec. 

 “Audio bitrate”: select 192 or 224 kb/sec from the drop down list. 

 “Audio sample rate”: select 44.1 or 48 kHz from the drop down list. 

EDITING INTERNAL MPEG PLAYER AND RECORDER DEVICE RESOURCES 

The MINI-T-NX automatically displays icons for its internal MPEG player and MPEG 

recorder in the “Resources View” window for the “Devices” folder (see Illustration 55, 

“Devices” Window).  The following steps describe how to change the optional settings for 

the MINI-T-NX’s built-in devices:  

1. Click on the “Devices” folder on the right side of the schedule editor window to display 

the “Devices” window (refer to Illustration 55, “Devices” Window). 

Illustration 55, “Devices” Window  

 

2. In the “Resource View,” click on the desired MINI-T-NX internal device icon to reveal 

the corresponding properties fields.  
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MPEG Player 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent the 

player. 

 “Assigned Channel/Output”: this is the output on which your MPEG player will display.  

You can only schedule the MPEG player on its assigned output.  Whenever an MPEG 

library resource is dragged onto the MPEG player’s assigned playback channel, the 

MPEG player will automatically appear in the library resource’s “Device” field. 

 “Setup time”: if desired, indicate how long after the selected player receives a “PLAY” 

command that picture and/or sound is produced. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” is 

selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties 

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option under 

the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you can enable 

the export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event properties 

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option under 

the “Export/Print Templates” window. 
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MPEG Recorder Option 

Illustration 56, MPEG Recorder Properties 

 
 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent the 

recorder. 

 “Record Channel”: WinLGX automatically assigns to Output 2 

 “Device”: automatically labeled as the 3
rd
 device by WinLGX.  As WinLGX is designed 

to control both the MINI-T-NX and its bigger brother, the NEXUS, Device 2 in the 

software is reserved for NEXUS MPEG Player 2. 

 “Video Quality”: if desired, select an MPEG recording quality mode for your recording 

events.  This mode may be changed for each recording event action—see “Internal 

MPEG Recorder Device Resource,” starting on page 168, for more details.  

 “Record overwrite”: if desired, select one of the following: 

 “Always”: prompts WinLGX to automatically record over an existing file with the 

same name.  

 “Create unique”: if an existing filename is entered, WinLGX automatically records 

the file under the first 14 characters of the original filename followed by “yy/mm/dd-
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hh/mm/ss” (yy/mm/dd is the file record date specified as year/month/ day and 

hh/mm/ss is the file record time in hours/minutes/seconds).   

The “Record overwrite” option may be changed for each recording event action—see 

“Internal MPEG Recorder Device Resource,” starting on page 168, for more details. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” is 

selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties 

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option under 

the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
® 

formats.  If “No” is selected, then you can enable 

the export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event properties 

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option under 

the “Export/Print Templates” window. 
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CREATING EXTERNAL DEVICE RESOURCES 

A device resource icon must be created for each VCR, DVD player, and any other external 

device attached to the MINI-T-NX.  Creating a device icon causes a new set of user-

configurable information fields to be displayed in the “Properties” window.  The MINI-T-NX 

uses this information to identify your external device.  Create external device resources as 

follows: 

NOTE: An external device is any source (input) controlled by a PRO-BUS, IR, or 

switch interface. 

1. Click on the “Devices” folder on the right side of the schedule editor window to display 

the “Devices View” window (refer to Illustration 57, New Device Properties). 

Illustration 57, New Device Properties  

 

2. Right click in the “Resource View” window and select “New” to display the device type 

menu.  Select a device type to add a new device to the window (see Illustration 57, 

New Device Properties). 

3. Complete the “Properties” fields for one of the following device resources: 

 “DVD Device Resources,” on page 96 

 “Tape Device Resources,” on page 98 

 “Switch Device Resources,” on page 100 

 “GPI Output Device Resources,” on page 102 
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DVD Device Resources 

Right click in “Resource View” and select “DVD” to display the DVD properties fields 

shown in Illustration 58, DVD Device Event Properties Window.  Refer to Table 12, DVD 

Device Properties, for a description of the editable DVD device resource properties. 

Illustration 58, DVD Device Event Properties Window 

 

Table 12, DVD Device Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Automatically displays the “DVD” device format. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 
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FIELD DESCRIPTION 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 

input to a device removes the input number from the input list.     

NOTE: The “Input” field appears after “Format” is selected. 

Preferred 

Channel/Output 

You may assign a channel output to your device to automate device 

selection for same-type library resources during scheduling.  Whenever a 

DVD library resource is dragged onto this device’s preferred channel 

output, this DVD player will automatically appear in the library resource’s 

“Device” field.   

Interface Select either “PRO-BUS (PB)” or “Internal IR (IR)” as the method being 

used to control the device. 

Device Select the number of the device control interface your device is connected 

to. When a device number is chosen, it is removed from the “Device” list.  

Choices are: 

 1–8 for PRO-BUS 

 1–2 for IR 

NOTE: Ensure assigned device number reflects actual PRO-BUS 

interface connected to input device.  A PRO-BUS interface only 

responds to those PRO-BUS commands which contain its 

address. 

Setup time If desired, indicate how long after the device receives a PLAY command 

that picture and/or sound is produced. 

NOTE: The “Setup time” field appears after “Format” is selected. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you 

can enable the export function during scheduling for all or individual playlist 

resources. 
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Tape Device Resources 

Right click in “Resource View” and select “TAPE” to display the tape properties fields 

shown in Illustration 59, Tape Device Event Properties Window.  Refer to Table 13, Tape 

Device Properties, for a description of the editable tape device resource properties. 

Illustration 59, Tape Device Event Properties Window 

 

Table 13, Tape Device Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Select one of the following device formats from the drop down list: 

 ¾” 

 8mm 

 Beta SP 

 DV (digital video device) 

 DVCPRO (Panasonic digital video device) 

 DVCAM  (Sony digital video device) 

 HI-8mm 

 S-VHS 

 VHS 
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FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 

the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 

input to a device removes the input number from the input list.     

NOTE: The “Input” field appears after “Format” is selected. 

Preferred 

Channel/Output 

You may assign a channel output to your device to automate device selection 

for same-type library resources during scheduling.  Whenever a library 

resource of the same format is dragged onto this device’s preferred playback 

channel, this device will automatically appear in the library resource’s “Device” 

field.   

Interface Select either “PRO-BUS (PB)” or “Internal IR (IR)” as the method being used 

to control the device. 

Device Select the number of the device control interface your device is connected to. 

When a device number is chosen, it is removed from the “Device” list.  Choices 

are: 

 1–8 for PRO-BUS 

 1–2 for IR 

NOTE: Ensure assigned device number reflects actual PRO-BUS interface 

connected to input device.  A PRO-BUS interface only responds to 

PRO-BUS commands which contain its address. 

Setup time If desired, indicate how long after the device receives a PLAY command that 

picture and/or sound is produced. 

NOTE: The “Setup time” field appears after “Format” is selected. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” is 

selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all records” 

option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you can 

enable the export function during scheduling for all or individual playlist 

resources. 
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Switch Resources 

Right click in “Resource View” and select “SWITCH” to display the switch properties 

fields shown in Illustration 60, Switch Event Properties Window.  Refer to Table 14, 

Switch Event Properties, for a description of the editable switch resource properties. 

Illustration 60, Switch Event Properties Window 

 

Table 14, Switch Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  



MINI-T-NX 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 101 

2018-06-08  WinLGX ver. 6.0.1.48 
 

FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 

input to a device removes the input number from the input list.     

NOTE: The “Input” field appears after “Format” is selected. 

Preferred 

Channel/Output 

You may assign a channel output to your device to automate device selection 

for same-type library resources during scheduling.  Whenever a library 

resource of the same format is dragged onto this device’s preferred playback 

channel, this device will automatically appear in the library resource’s 

“Device” field.   

Interface “Switch (SW)” is automatically assigned. 

Device The device numbers for switch resources are automatically assigned. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 

is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all records” 

option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you 

can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all records” 

option under the “Export/Print Templates” window. 
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GPI Output Device Resources 

Right click in “Resource View” and select “GPI” to display the GPI properties fields shown 

in Illustration 61, GPI Event Properties Window.  Refer to Table 15, GPI Event Properties, 

for a description of the editable GPI resource properties. 

Illustration 61, GPI Event Properties Window 

 

Table 15, GPI Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Automatically displays the “GPI” device format type. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 

the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Interface “PRO-BUS (PB)” is automatically assigned. 

Device Assign a PRO-BUS interface number, 1-8, to the GPI from the drop down list. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” is 
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FIELD DESCRIPTION 

selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all records” 

option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you can 

enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all records” 

option under the “Export/Print Templates” window. 
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CREATING LIBRARY RESOURCES 

Use the “Library View” windows to create library resources for drag and drop scheduling 

of frequently aired programs.  Then just add properties for a specific MPEG video, slide, 

tape, disc, or switch action to each new library resource.  Before scheduling library 

resources for external devices, ensure you have created resources for the corresponding 

devices that each library resource will be played or recorded on (see “Creating External 

Device Resources,” starting on page 95).   

Create library resources as follows:   

1. Click on the “Library” folder on the right side of the schedule editor window to display 

the “Library View” (see Illustration 62, “Library View” Windows). 

Illustration 62, “Library View” Windows 
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2. Right-click in the “Resource View” window and select “New” in the menu to insert an 

undefined, new resource in the window (see Illustration 63, New Library Resource 

Windows). 

Illustration 63, New Library Resource Windows 

 
3. Complete the “Properties” fields for one of the following library resources: 

 “Tape and DVD Library Resources,” on page 106 

 “Switch Library Resources,” on page 108 

 “MPEG Library Resources,” on page 110 

 “MPEG Loop Library Resources,” on page 115 

 “Slide Library Resources,” on page 119 

 “Slide Show Library Resources,” on page 122 

 “MPEG File/Slide Playlist Library Resources,” on page 126  



MINI-T-NX 

Software Installation & Configuration 

Page 106   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

 

Tape and DVD Library Resources 

Create tape and DVD library resources containing properties for device media such as 

videotapes and DVDs.  Click the “Library” folder and then right click in the “Resource 

View” window and select “New.”  Select a tape or DVD “Format” in the “Properties” 

window and then edit the remaining properties described in Table 16, referring to 

Illustration 64 throughout.   

Illustration 64, Example of DVD Library Resource Properties 

 

Table 16, IR or PRO-BUS-Controlled Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 
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FIELD DESCRIPTION 

Format Choose one of the following IR or PRO-BUS-Controlled media: 

 ¾” 

 8mm 

 Beta SP 

 DV (digital video device)  

 DVCPRO (Panasonic digital video device) 

 DVCAM (Sony digital video device) 

 DVD 

 HI-8mm 

 S-VHS 

 VHS 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Length Enter the on-air length of the program medium. 

Preroll If desired, enter a length of time to indicate the amount of unwanted video 

(black, etc.) at the start of the program that you do not want playing on air. 

Reset If desired, enter time the playback device will be busy and unavailable for 

scheduling after the end of the program.  It is typically the rewind time. 

Comment To add more information about the resource, enter a description with up to 

31 characters.  The text entered in the “Title” field is automatically placed 

in the “Comment” field, but may be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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FIELD DESCRIPTION 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

 

Switch Library Resources 

Create switch library resources containing properties for switch inputs, such as studio 

feeds or external character generators (CG).  Click the “Library” folder and then right click 

in the “Resource View” window and select “New.”  Select a switch input type under 

“Format” in the “Properties” window and then edit the remaining properties described in 

Table 17, referring to Illustration 65 throughout. 

Illustration 65, Example of Switch Library Resource Properties 
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Table 17, Switch Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Length Enter the on-air length of the program medium. 

Comment To add more information about the resource, enter a description with up to 

31 characters.  The text entered in the “Title” field is automatically placed 

in the “Comment” field, but may be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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MPEG Library Resources 

Create MPEG file library resources containing properties for MPEG video files that will be 

displayed on the MINI-T-NX internal MPEG player.  Click the “Library” folder and then 

right click in the “Resource View” window and select “New.”  Select “MPEG” under 

“Format” in the “Properties” window and then edit the remaining properties described in 

Table 18, referring to Illustration 66 throughout. 

Illustration 66, MPEG Library Resource Properties 
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Table 18, MPEG Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “MPEG” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Video filename Use the “Filename” field to select the appropriate filename for the source 

as follows:  

1. Select the “Filename” field and click the button that appears to open 

the “Select File” window (see Illustration 67, “Select File” Window).  

Illustration 67, “Select File” Window 

 

2. Perform one of the following: 

 Enter a name for a file that will be recorded and then played 

within the same schedule: 

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. Schedule the file for recording on the internal MPEG recorder, 

using the same filename and length entered for the playback 

library resource.  Refer to “Internal MPEG Recorder Device 

Resource” on page 168 for further instructions scheduling an 
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FIELD DESCRIPTION 

MPEG recording event. 

d. Schedule the MPEG library playback resource after the 

MPEG file recording event (see page 180 for instructions on 

scheduling an MPEG library resource). 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept selection 

and close “Select file” window.  

 Select the desired file.  If you wish to display the file’s 

properties before accepting the selection, click “Properties” to 

display the “File Properties” window (see Illustration 68, “File 

Properties” Window).   

Illustration 68, “File Properties” Window 

 

3. From the “Select file” dialog, click “OK” to accept selection or 

“Cancel” to abort. 

Storage device The internal hard drive is automatically selected once the MPEG filename 

is picked. 

In point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to begin, 

select the “In point” field and either type the desired file start point or click 

the ellipsis button to open the control panel clip editor for the MPEG 

player. If using the control panel, specify the in point as follows: 

1. Specify the clip’s playback start point using one of the following 

methods: 

 Click the  button to start playing the file and click the  

button at the desired spot. 

 Drag the playback bar to the desired spot and click the  

button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 
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FIELD DESCRIPTION 

resource by clicking the  button. 

Out point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to end, select 

the “Out point” field and either type the desired file end point or click the 

ellipsis button to open the control panel clip editor for the MPEG player. If 

using the control panel, specify the out point as follows: 

1. Specify the clip’s playback end point using one of the following 

methods: 

 Click the  button to start playing the file and click the  

button at the desired spot. 

 Drag the playback bar to the desired spot and click the  

button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length Automatically displayed once the MPEG filename is selected.   

Video bit rate Automatically displayed once the MPEG filename is selected. 

Video bit rate 

type 

Automatically displayed once the MPEG filename is selected. 

Audio sample 

rate 

Automatically displayed once the MPEG filename is selected. 

Comment To add more information about the resource, enter a description with up to 

31 characters.  The text entered in the “Title” field is automatically placed 

in the “Comment” field, but may be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 1–

11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
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FIELD DESCRIPTION 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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MPEG Loop Library Resources 

Create MPEG loop library resources containing properties for MPEG video files that will 

be repeatedly displayed on the MINI-T-NX internal MPEG player.  Each MPEG loop library 

resource displays the selected MPEG video file for a specified number of times or loops.  

Click the “Library” folder and then right click in the “Resource View” window and select 

“New.”  Select “MPEG Loop” under “Format” in the “Properties” window and then edit the 

remaining properties described in Table 19, referring to Illustration 69 throughout. 

Illustration 69, MPEG Loop Library Resource Properties 

 

Table 19, MPEG Loop Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 
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FIELD DESCRIPTION 

Format Select “MPEG” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the ellipsis button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Video 

filename 

Use the “Filename” field to specify the file you wish to loop as follows:  

1. Select the “Filename” field and click the ellipsis button to open the 

“Select File” window (see Illustration 70, “Select File” Window).  

Illustration 70, “Select File” Window 

 

2. Perform one of the following: 

 Enter a filename for a file that will be recorded and played within 

the same schedule: 

NOTE: The MPEG recording library resource is scheduled for 

recording through the MPEG device resource.  Refer to 

“Internal MPEG Recorder Device Resource” on page 

168 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the desired record time for the file. 
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FIELD DESCRIPTION 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept selection 

and close “Select file” window.  

 Select the desired file.  If you wish to display the file’s 

properties before accepting the selection, click “Properties” to 

display the “File Properties” window (see Illustration 71, “File 

Properties” Window).   

Illustration 71, “File Properties” Window 

 

3. From the “Select file” dialog, click “OK” to accept selection or 

“Cancel” to abort. 

Storage 

device 

The internal hard drive is automatically selected once the MPEG filename 

is picked. 

Length The file length is automatically displayed once the MPEG filename is 

specified.  To specify the number of times or length of time you would like 

the file to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to display 

the “MPEG Loop Calculator” (see Illustration 72).  

Illustration 72, MPEG Loop Calculator 

 

2. Enter the number of times you would like the file to loop in the “Loop 

count” field and/or enter a length of time, up to 24 hours, in the “Loop 

length” field. 

Video bit rate Automatically displayed once the MPEG filename is selected. 
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FIELD DESCRIPTION 

Video bit rate 

type 

Automatically displayed once the MPEG filename is selected. 

Audio sample 

rate 

Automatically displayed once the MPEG filename is selected. 

Comment To add more information about the resource, enter a description with up to 

31 characters.  The text entered in the “Title” field is automatically placed 

in the “Comment” field, but may be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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Slide Library Resources 

Slide library resources contain properties for JPEG slides that will be displayed on the 

MINI-T-NX internal MPEG player.  Before creating a slide show library resource, upload 

the desired slides into a MINI-T-NX user folder(s) through the WinLGX Storage Manager 

window (see “Managing SLIDES: Uploading to the MINI-T-NX and Authorizing for 

Display,” on page 211). 

To create a library resource for a slide, click the “Library” folder and then right click in the 

“Resource View” window and select “New.”  Select “Slide” under “Format” in the 

“Properties” window and then complete the remaining properties described in Table 20, 

referring to Illustration 73 throughout. 

NOTE: The MINI-T-NX ships with sample slides in the “admin” user account folder.  

Sample slides are provided to demonstrate possible usages for the digital 

messaging feature.   

Illustration 73, Slide Library Resource Properties 
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Table 20, Slide Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters.   

Format Select “Slide” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Slide 

filename 

Use the “Slide filename” field to select the appropriate slide filename for 

the source as follows: 

1. Select the “Filename” field and click the button that appears to open 

the “Select Slide” window (see Illustration 74, “Select Slide” 

Window). 

Illustration 74, “Select Slide” Window 

 

2. Select a username from the “Users” drop down list to display the 

JPEG slides in the corresponding remote user folder. 

3. Select a slide as follows: 

 Double-click the desired file to accept selection and close “Select 

slide” window.  



MINI-T-NX 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 121 

2018-06-08  WinLGX ver. 6.0.1.48 
 

FIELD DESCRIPTION 

 Select the desired file and click “OK” to accept or “Cancel” to 

abort selection. 

User folder Automatically displayed once the slide is selected. 

Length The default slide length specified in the “Application” tab of the 

“Preferences” window is automatically displayed once the slide filename is 

selected (see page 75 for more information), but may be edited to any 

value greater than 5 seconds. 

Background If desired, select an audio source to play with your slide file display.  

Under the “Background audio input” field, perform one of the following:  

 Select an audio input. 

 Select “from MPEG” to play the audio from an MPEG file.  Load an 

MPEG file using the “MPEG filename” field that appears.   

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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Slide Show Library Resources 

Slide show library resources contain properties for sequences of JPEG slides that will be 

displayed on the MINI-T-NX internal MPEG player.  The slides displayed in a slide show 

are the slides within each of the selected user account folder(s).  Before creating a slide 

show library resource, upload your slides into the MINI-T-NX user folder(s) through the 

“Storage Manager” window and then enable and authorize the slides for display (see 

“Managing SLIDES: Uploading to the MINI-T-NX and Authorizing for Display,” on page 

211).   
 

If the slide was not uploaded by a user with the “Automatic slide authorization” or “Slide 

administrator” user right, it must also be authorized for display in slide shows by the 

“admin” user account or a user with the “Slide administrator” right (see “Managing 

SLIDES: Uploading to the MINI-T-NX and Authorizing for Display,” on page 211). 
 

To create a library resource for a slide, click the “Library” folder and then right click in the 

“Resource View” window and select “New.”  Select “Slide Show” under “Format” in the 

“Properties” window and then complete the remaining properties described in Table 21, 

referring to Illustration 75 throughout. 

NOTE: The MINI-T-NX ships with sample slides in the “admin” user account folder.  

Sample slides are provided to demonstrate possible usages for the digital 

messaging feature. 

Illustration 75, Slide Show Library Resource Properties 
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Table 21, Slide Show Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Slide Show.” 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

User list Select one or more usernames to display the JPEG slides in the 

corresponding remote user folders as follows: 

NOTE: Create a default slide to display in case the selected user folder 

is empty or does not contain approved slides (refer to 

“Managing SLIDES: Uploading to the MINI-T-NX and 

Authorizing for Display,” on page211). 

1. Select the “User list” field and click the button that appears to open 

the user selection window shown in Illustration 76, “User list” 

Window. 
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FIELD DESCRIPTION 

NOTE: The MINI-T-NX ships with sample slides in the “admin” 

user account folder.   

Illustration 76, “User list” Window 

 

2. Select the desired username(s) as follows: 

 Click the “All” button to select all usernames. 

 Click the “None” button to deselect all usernames. 

 Individually select usernames by clicking on the desired 

username boxes. 

3. Click “OK” to accept selections or “Cancel” to abort. 

Length Edit to the desired run time for the entire slide show.  The display duration 

for each slide is specified in the “Application” tab of the “Preferences” 

window (see “Setting WinLGX Viewing and Communication Preferences,” 

on page 75). 

Background If desired, select an audio source to play with your slide file display.  

Under the “Background audio input” field, perform one of the following:  

 Select an audio input. 

 Select “from MPEG” to play the audio from an MPEG file.  Load an 

MPEG file using the “MPEG filename” field that appears.   

Comment To add more information about the resource, enter a description with up to 

31 characters.  The text entered in the “Title” field is automatically placed 

in the “Comment” field, but may be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 
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FIELD DESCRIPTION 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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MPEG File/Slide Playlist Library Resources 

Create MPEG file/slide playlist library resources containing properties for multiple digital 

media files that will be displayed on the MINI-T-NX internal MPEG player.  Playlist 

resources allow users to simultaneously schedule one or more MPEG files and/or JPEG 

slides.  Click the “Library” folder and then right click in the “Resource View” window and 

select “New.”  Select “Playlist” under “Format” in the “Properties” window and then edit the 

remaining properties described in Table 22, referring to Illustration 77 and Illustration 78 

throughout. 

Illustration 77, Playlist Library Resource Properties 

 

Illustration 78, “Playlist Editor” Window 

 



MINI-T-NX 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 127 

2018-06-08  WinLGX ver. 6.0.1.48 
 

Table 22, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Playlist.” 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 

clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Resource list Select the “Resource list” field and click the button that appears to open 

the “Playlist Editor” window shown in Illustration 78 and perform the 

following steps: 

1. Under “Library View,” click on the library folder to display the 

resource you would like to add to the playlist. 

2. Select the desired resource under “Resource View.” 

3. Click the “Add” button to add resource to the “Playlist” window. 

4. Repeat steps for each additional resource you would like to place in 

the playlist. 

5. Use any of the following options to edit playlist: 

 To remove an item from the playlist, highlight the resource and 

click the “Delete” button. 

 To remove all items from the playlist, click the “Clear All” button 

and select “Yes” in the dialog that appears or “No” to abort the 

operation. 

 To reorder playlist, highlight a resource and click the “Up” and/or 

“Down” buttons to move resource into new playlist position. 

6. Click “OK” to create playlist resource or “Cancel” to abort changes. 

Length Displays total length of library resources added to playlist. 

Playlist Displays filename and length of each library resource added to playlist. 
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SOFTWARE OPERATION 

ABOUT THIS SECTION 

Introduced in the previous section, the tabs, icons, and menu items for the WinLGX 

schedule view will now be explained in greater detail.  The first part of this section teaches 

you how to use the schedule view components to add events to your MINI-T-NX image 

files for automated playback and recording.  The system, device, and library (media) 

properties must be entered into the current image file before event scheduling can occur 

(see “Software Installation & Configuration,” starting on page 43, for instructions).  To 

create a schedule, simply drag and drop your device and library icons onto the schedule 

view and then complete the corresponding event properties windows.  For an outline of the 

scheduling process, refer to the WinLGX Scheduling Quick Guide included with your 

MINI-T-NX.  This section also shows you how to use the WinLGX control panel for the 

times you wish to immediately perform switching and device control or start/stop a 

schedule. 

At the end of this section, you will learn how to manage the storage of any digital videos on 

your MINI-T-NX internal hard drive and digital slides uploaded to the MINI-T-NX internal 

memory.  With the WinLGX “Storage Manager” window, you can delete, move, and copy 

MPEG videos and slides between your local (PC) and remote storage areas.   
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PERFORMING GENERAL WINLGX OPERATIONS 

OPENING AND LOGGING INTO WINLGX 

1. Double click the WinLGX desktop icon. The login window shown in Illustration 79 

automatically appears when WinLGX is opened or when you click one of the following: 

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 79, “MINI-T-NX Site Manager” Window 

 

2. If desired, reorder your IP address listing.  Clicking on any column header in the “Site 

Manager” sorts the associated information in ascending order, while clicking the 

header again sorts the list in descending order. 

3. Log in as follows (see Illustration 79, “MINI-T-NX Site Manager” Window): 

NOTE: The WinLGX title bar on the main window states whether or not you are 

connected. 

a. Select the IP addresses of the LEIGHTRONIX Digital Server/Controller IP you 

want to log into.  You may select up to eight addresses by holding down your 

keyboard “Ctrl” key and clicking each address with the left mouse button.     

b. Log in with your username and password.  To simultaneously log into multiple 

LEIGHTRONIX Digital Server/Controllers, all of the selected IP addresses must 

have the same username and password. 
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NOTE: Connect to multiple LEIGHTRONIX Digital Server/Controllers with 

different usernames and passwords by logging in separately to each 

controller. 

If the username and password have not been changed from the factory 

defaults, enter the following: 

MINI-T-NX FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR MINI-T-NX’S SERIAL # 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  ONLY LETTERS AND NUMBERS MAY BE USED IN YOUR USERNAME AND 

PASSWORD. 

  LOGINS ARE CASE SENSITIVE. 

 IF THE CORRECT CHARACTERS ARE NOT ENTERED, AN ERROR MESSAGE 

WILL BE DISPLAYED. 

  AN ADMINISTRATOR CAN ASSIGN VARIOUS DEGREES OF RIGHTS TO EACH 

USERNAME, SO NOT ALL MENU ITEMS OR FUNCTIONS MAY BE AVAILABLE 

TO A USER. 

  THE LAST SIX DIGITS OF YOUR MINI-T-NX SERIAL NUMBER ARE VIEWABLE 

FROM THE FRONT PANEL (SEE “MINI-T-NX FRONT PANEL,” ON PAGE 27) 

AND A STICKER ON THE BACK OF YOUR MINI-T-NX. 

c. Click “Connect” or press “Enter” to connect to the chosen MINI-T-NX controller(s) 

and close the login dialog box.  Once you are connected, a tab appears for each 

MINI-T-NX on the main window beneath the toolbar.   

d. If you logged into more than one MINI-T-NX controller, switch between the 

controllers by clicking on the MINI-T-NX tabs on the main window.  
 



MINI-T-NX 

Software Operation 

Page 132   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

DISPLAYING WINLGX VERSION NUMBER 

Select “About WinLGX” in the “Help” menu or click the  main toolbar icon to open a 

window with the WinLGX version number (see Illustration 80).  Click on the window to 

close it. 

Illustration 80, About WinLGX Window 
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PRINTING SCHEDULES FROM WINLGX 

Perform the following steps to print the current schedule from WinLGX: 

1. Create a print template to select the desired schedule information for printing (see 

“Creating Templates for Exporting/Printing Schedules,” on page 68).  

2. Determine the page layout of your schedule printout (see “Configuring Page Layouts 

For Schedules Printed from WinLGX,” on page 70).  

3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the 

template selection window shown in Illustration 81. 

Illustration 81, “Select Export/Print Template” Window 

   

4. Choose the desired template from the “File name” list in the “Select Export/Print 

Template” Window (see Illustration 81) and click “Open,” or double click the template 

file to open the “Print” window.  Click “Cancel” to abort the print. 

5. In the “Print” window, configure the printer and copy settings according to the following 

steps. Click “OK” to print or “Cancel” to abort the print. 

NOTE: You may have already performed these steps through the “Print Setup” 

window.  See “Configuring Printer and Paper Settings for Schedules Printed 

from WinLGX,” on page 71. 

 “Printer” section: lets you choose the desired printer from a list of your PC’s 

available printers.  When a printer is chosen, its status appears below the printer 

“Name” field. 
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 “Properties” button: click to open a window specific to the printer, so that detailed 

printer settings can be made. 

 “Print range” is fixed at “All.”   

 “Copies” section: choose the number of schedule copies you wish to print.  If you 

choose more than one, checking “Collate” causes the printer to print each copy’s 

pages together and in order.  If “Collate” is unchecked, all of the first pages will be 

printed together, the second pages will be printed together, etc. 

EXPORTING SCHEDULES INTO MICROSOFT EXCEL
®
 OR A COMMA DELIMITED 

FORMAT 

Perform the following steps to export schedules into comma delimited or Microsoft Excel
®
 

formats: 

1. Create a template (see “Creating Templates for Exporting/Printing Schedules,” on 

page 68). 

2. Select “Save as” in the “File” menu to open the window shown in Illustration 82, which 

allows you to export the loaded schedule under a new name and a Microsoft Excel
®
 or 

comma delimited file format as follows: 

Illustration 82, “Save As” Window 

 

a. Select a folder in the “Save in” field.  The default is “MINI-T-NX images.”   

b. Type a name for the exported file in the “File name” field.  If you leave the extension 

off, WinLGX puts it on for you.   

NOTE: If you enter a name of a file that already exists, WinLGX will ask you if 

you want to overwrite it. 



MINI-T-NX 

Software Operation 

LEIGHTRONIX, INC.  Page 135 

2018-06-08  WinLGX ver. 6.0.1.48 
 

c. Select the export format (Comma Separated or Excel
®
) in the “Save as type” field.   

d. Click “Save” to open the template selection window shown in Illustration 83, “Select 

Export/Print Template” Window. 

Illustration 83, “Select Export/Print Template” Window 

 

3. Choose the desired template from the “File name” list in the “Select Export/Print 

Template” (see Illustration 83) and click “Open” or double click the template file to 

create the export schedule file.  The file can then be opened in your favorite database 

program and manipulated and printed as desired.  Click “Cancel” to abort the export. 

LOGGING OUT OF WINLGX 

To disconnect WinLGX from your MINI-T-NX and any other LEIGHTRONIX Digital 

Server/Controllers you own, perform the following steps: 

NOTE: LEIGHTRONIX Digital Server/Controllers will continue to operate while 

disconnected from WinLGX. 

1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open 

the “Site Manager” window shown in Illustration 79. 

2. Select the LEIGHTRONIX Digital Server/Controller address(es) you would like to 

disconnect.  If you want to disconnect from more than one address, hold down your 

keyboard “Ctrl” key and click on each address with the left mouse button. 

3.  Click the “Disconnect” button.  A box will appear asking whether or not you would like 

to disconnect from the current LEIGHTRONIX Digital Server/Controller location(s).  

Click “Yes” to disconnect or “No” to remain connected.   
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EXITING WINLGX 

To disconnect from your MINI-T-NX and any other LEIGHTRONIX Digital 

Server/Controllers and close the WinLGX software, perform the following steps: 

NOTE: LEIGHTRONIX Digital Server/Controllers will continue to operate while 

disconnected from WinLGX.  

1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main 

window.   

2. If an image file has not been saved for one of the connected controllers, the dialog box 

shown in Illustration 84 appears and asks if you want to save the changes.  Select one 

of the following options: 

Illustration 84, WinLGX Exit Dialog Box 

 
 

 Save to disk: click “Yes” to open the “Save As” window.  Once you browse to the 

desired file path and save your changes (see “Saving MINI-T-NX Image Files,” on 

page 140), WinLGX will automatically close.  

 Save to controller: click “Yes” to send the image file to the MINI-T-NX.  Once the 

send is complete, the MINI-T-NX will contain and execute the schedule and 

WinLGX will automatically close.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once you 

browse to the desired file path and save your changes (see “Saving MINI-T-NX 

Image Files,” on page 140), WinLGX will send the image file to the MINI-T-NX.  

Once the send is complete, the MINI-T-NX will contain and execute the schedule 

and WinLGX will automatically close.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 

open. 
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OPENING MINI-T-NX IMAGE FILES 

Each MINI-T-NX image file (.nmg) holds your schedule events along with your 

system, device, and library resource properties.  The “Software Installation & 

Configuration” section, starting on page 43, describes how to define these configuration 

properties.  The image file’s configuration properties must be entered into the current 

image file before event scheduling can occur.    

NOTE: If you have not yet created a MINI-T-NX image file, go to “Creating New MINI-

T-NX Image Files,” on page 51. 

If an unsaved image is open in WinLGX when you attempt to open another image, a dialog 

box (see Illustration 84) appears and asks if you want to save the changes.  Select one of 

the following options: 

 Save to disk: click “Yes” to open the “Save As” window.  Browse to the desired file 

path and save your changes (see “Saving MINI-T-NX Image Files,” on page 140).  

 Save to controller: click “Yes” to send the image file to your MINI-T-NX system.  

Once the send is complete, the MINI-T-NX server/controller will contain and 

execute the schedule.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once you 

browse to the desired file path and save your changes (see “Saving MINI-T-NX 

Image Files,” on page 140), WinLGX will send the image file to the MINI-T-NX 

system.  Once the send is complete, the MINI-T-NX system will contain and 

execute the schedule.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 

open. 

 

Open a MINI-T-NX server/controller image file according to one of the following 

subsections: 

 “Opening a Saved Image File,” on page 137 

 “Opening an Image File as New,” on page 138 

 “Receiving Image Files from the Connected MINI-T-NX 

Server/Controller(s),” on page 139 

 “Associating MINI-T-NX Image Files with WinLGX,” on page 140 

OPENING A SAVED IMAGE FILE 

An image file contains any data that was entered and saved in the schedule and system, 

device, and library properties windows.  Open a saved image file as follows: 

1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open the 

file selection window shown in Illustration 85.   
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Illustration 85, Open Image File Window 

 

2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 

field. 

3. Select an image file folder from the “Look in” drop down box at the top of the window.   

4. Single click a .nmg file to select it and click “Open” or double click the file.  The image 

file data is then loaded into WinLGX.   

5. As you enter/edit your schedule events according to the “Scheduling Events” section 

starting on page 142, periodically save your settings in an image file as described in 

“Saving MINI-T-NX Image Files,” on page 140. 

OPENING AN IMAGE FILE AS NEW 

Opening a previously saved image file as new causes WinLGX to load any system, 

device, and library configuration properties contained within the file.  Any schedule events 

will not be imported.  

1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to 

open the file selection window shown in Illustration 86, Open Image File as New 

Window.   
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Illustration 86, Open Image File as New Window 

 

2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 

field. 

3. Select an image file folder from the “Look in” drop down box at the top of the window.     

4. Single click a .nmg file to select it and click “Open” or double click the file.  The image 

file data minus the schedule is then loaded into WinLGX as an unnamed file.    

5. As you enter/edit your schedule events according to the “Scheduling Events” section 

starting on page 142, periodically save your settings in an image file as described in 

“Saving MINI-T-NX Image Files,” on page 140. 

RECEIVING IMAGE FILES FROM THE CONNECTED MINI-T-NX 

SERVER/CONTROLLER(S) 

An image received from a connected MINI-T-NX server/controller contains any schedule 

events and system, device, and library properties last sent to the server.   

1. Download the last image file sent to one or more of your MINI-T-NX server/controllers 

as follows: 

 One server: ensure the server’s product tab is selected and choose “Receive” in 

the “File” menu or click its  icon on the main toolbar.  A dialog box will ask 

whether you want to receive the image currently loaded on the connected MINI-T-

NX server.  Click “Yes” to complete the receive and display the status box shown in 

Illustration 87. 

Illustration 87, Image Status Window 
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Progress Bar

 

 Multiple servers: from any of the product tabs, select “Receive all” in the “File” 

menu.  For each connected server, a separate dialog box will ask whether you 

want to receive the server’s loaded image.  Click “Yes” for each server to finish 

receiving all of the images.  You will see a status box like the one shown in 

Illustration 87, each time you click “Yes.” 

2. As you enter/edit your schedule events according to the “Scheduling Events” section 

starting on page 142, periodically save your settings in an image file as described in 

“Saving MINI-T-NX Image Files,” on page 140. 

ASSOCIATING MINI-T-NX IMAGE FILES WITH WINLGX 

Associating a MINI-T-NX image (.nmg) files with WinLGX enables you to double click on 

an image file and have it automatically open in WinLGX.  Perform the following procedure: 

1. Browse to a MINI-T-NX image (.nmg) file.   

2. Right click on the MINI-T-NX image file and choose "Open with" or "Open." 

3. Choose "Select the program from a list." 

4. Browse to and choose the WinLGX executable file path.   

5. Check the "Always use ..." checkbox and click "OK." 

SAVING MINI-T-NX IMAGE FILES 

Save a copy of your current image file to your PC or network through one of the following 

options: 

 “Save” Option 

If a MINI-T-NX image has not been saved to your PC or network or has been modified, 

the “Save” option becomes enabled.  Select “Save” from the “File” menu or click the 

 toolbar button.   

 If the MINI-T-NX image already has a local filename, visible in the title bar 

(WinLGX – filename.nmg), the “Save” option saves the loaded image to that name 

without prompting, overwriting the old file.   

 If the image does not have a local filename, “Save” opens the “Save as” box shown 

in Illustration 88, allowing a name and file path to be specified. 

 “Save as” Option 
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The “Save as” option allows you to save a MINI-T-NX image under a new filename.  

Select “Save as” in the “File” menu to open the window shown in Illustration 88, “Save 

As” Window, and perform the following steps:  

Illustration 88, “Save As” Window 

 

1. From the “Save in” drop down box at the top of the window, navigate to the folder 

where you want to save the MINI-T-NX image file.   

2. Type a name for the image in the “File name” field.   

3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option 

has been selected in the “Save as type” field. 

4. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save 

as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to 

overwrite it. 
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SCHEDULING EVENTS 

The “Schedule” window, shown in Illustration 89, with a sample schedule loaded, is where 

an event schedule is created.   

Illustration 89, Schedule Window 

 
 

ABOUT SCHEDULE WINDOW COMPONENTS 

Controller Tabs 

For each controller you are logged into, a separate tab appears on the main window.  Click 

on a tab to display the corresponding controller view and then enter your scheduling 

information for the selected controller. 

Channel Output Tabs 

NOTE: The output labels and channel/output assignments are entered in the “System 

Configuration View” (see “Configuring MINI-T-NX System’s Switcher 

Properties,” on page 85). 

 Output 1 tab: use to schedule events that contain switches on Output 1 tab window.   

 “Rec/Prev” tab: users with the MPEG record option may schedule MPEG recording 

events on this tab window. 

Day Tabs 

Day tabs are used to schedule events on specified days.  The day tabs perform output 

and device conflict checking across all of the channel tabs, so that an output or a device 

can never have more than one event scheduled at the same time.   

Each event contains all of the starting and ending actions for a program, and thus uses up 

a block of time for the length of the program.  WinLGX orders these blocks vertically in the 

schedule window, one row per event, so that for a particular output on a particular day, you 

can see the day’s 24 hours divided into programs. 

Product 

Tab 

Channel 

Output Tabs 

Day Tabs 
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 Locked Events 

If an event is locked, it has a fixed time entered by the user.  This allows it to be 

scheduled away from the end of the previous event or away from the beginning of 

the day.  If this is done, a schedule switchback interval is indicated between the 

events, or at the beginning of the day.  Each switchback interval equals the length 

of time separating the preceding event from the next scheduled event.  Switchback 

intervals appear in a different color (yellow by default). 

 Unlocked Events 

An unlocked event’s time is assigned by WinLGX to coincide with the ending time 

of the event above it.  This time is not fixed and will be adjusted by WinLGX if 

events above the unlocked events are inserted, deleted, moved, or modified. If an 

added or edited event’s time or length causes it to overlap an unlocked event, the 

unlocked event will move downward in the schedule if it can. 

 

NOTE: If adding, editing, or deleting an event causes two events to conflict, an error 

message appears.  If the added/edited event is one of the conflicting events, 

the event it conflicts with is listed, the error is described, and the outcome is 

given.  If the added/edited/deleted event is not one of the conflicting events, the 

two conflicting events are listed, the error is described, and the outcome is 

given.  Use this information to correct the conflict. 
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WinLGX-LT Tab 

The WinLGX-LT tab has its own date/day and time entry and does not assign blocks of 

time in a linear fashion like the day tabs (see Illustration 90, WinLGX-LT Tab Event 

Window).   

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, 

select the “Show WinLGX-LT tab in the schedule window” option on the 

“Application” tab of the Tools\Preferences window. 

Illustration 90, WinLGX-LT Tab Event Window 

 
 

The WinLGX-LT tab is useful in the following situations: 

NOTE: The WinLGX-LT tab does not prevent two events from occupying the same 

time. 

 When you would like to use the same event on multiple days, schedule the event 

on the WinLGX-LT tab once and avoid having to recreate or copy the event on 

multiple day tabs.  

 If you would like to create a schedule that encompasses more than the next seven 

days, use the WinLGX-LT tab and schedule according to date. 

 Schedule a device-only event without a switch on the WinLGX-LT tab to test a 

device-only event action before sending it to the destination or to perform 

nonplayback events such as recording. 
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Channel and Day/WinLGX-LT Tab Configurations 

A separate event window is displayed for each pair of channel and day tabs (see Table 23, 

Controller Tab Configurations).  In addition, the WinLGX-LT tab displays a single event 

window for all days and channels.   

NOTE: Output 2, labeled “Rec/Prev” on the WinLGX schedule window, is automatically 

assigned to the internal MPEG recorder.   

Table 23, Controller Tab Configurations 

MINI-T-NX CHANNEL OUTPUT 

TABS 

# OF SCHEDULE EVENT 

WINDOWS 

Without MPEG record 

option 
Output 1 

8 event windows (1 channel x 7 

days + 1 WinLGX-LT tab) 

With MPEG record 

option 
Output 1–Output 2 

15 event windows (2 channels x 7 

days + 1 WinLGX-LT tab) 

 

Schedule Columns 

The schedule window columns display the events’ fields, giving all the information and 

actions of the event.  When the schedule window contains an event, the columns can be 

moved and resized by dragging the headers and header boundaries.  A horizontal scroll 

bar at the bottom of the window is used to view all of the columns.  For a listing of the 

fields, see Table 24, Schedule Columns. 

Table 24, Schedule Columns 

FIELD DESCRIPTION 

Time  Program’s scheduled time: reflects time of any initial switch and the beginning 

of the program time block.  If the event time is fixed (locked), this field will also 

contain a thumbtack symbol .   

Title  Name of the event.  The title may be assigned in the resource’s “Title” field 

either when the resource is configured or when it is added to the schedule.  If 

the row consists of a switchback interval between events, the field shows which 

user-configured input or video source switchback will be displayed during the 

interval. 

Interface/ 

Device  

Number and name of the event’s interface and corresponding device, if any. 

Format  Format selected for the device or library resource in the “Properties” window. 

Input  Number and name of the device or switch input that will be taken to the output at 

the scheduled time (shown in “Time” field). 

Output  Number and name of the output the initial input switches to at the schedule time 

(shown in “Time” field). 
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FIELD DESCRIPTION 

Channel  Number and name of the channel in which the event resides. 

Setup  Time the device takes to produce video and/or sound after receiving a PLAY 

command. 

Preroll  Indicates amount of unwanted video (black, etc.) at the beginning of the 

program.   

In point If assigned, indicates an MPEG video’s playback starting point 

Out point If assigned, indicates an MPEG video’s playback ending point  

Length  Length of the program block and the time between initial and ending switches, if 

any.  WinLGX subtracts “End” from “Time” to obtain the “Length” value. 

Reset  Time the device is busy and unavailable for scheduling after the end of the block 

(“End”), usually due to rewind time. 

Start CMD  Device command that occurs initially at “Start.”  

End CMD  Device command that occurs at “End” (usually “Stop” or “Rewind”). 

Switchback  Indicates the input that is switched to the event’s output following the “End” 

command.  Back to back events have the “End” time of the first event equal to 

the “Time” of the second event.  This puts the first event’s switchback at the 

same time as the second event’s initial switch.  If this occurs, the MINI-T-NX 

cancels the switchback. 

Start  Indicates time of the initial device command.   WinLGX subtracts “Setup” plus 

“Preroll” from “Time” to obtain the “Start” value, which is the start time of the 

device command.  “Start” is not included in the time block used for vertical 

positioning within the schedule. The time progression is as follows:   

1. At the time shown in the schedule “Start” field, a PLAY command is 

issued. 

2. The event waits for “Setup” and “Preroll” to complete before performing 

the initial switch.   

End  Indicates end of the program block, end time of the device command, and 

switchback, if any.  WinLGX adds “Length” to “Time” to obtain the “End” value. 

Filename (1) Displays the filename of the chosen MPEG or slide file. 

Storage 

Device (1) 

Indicates the storage device of the chosen MPEG file or user list for a slide file. 

Record 

Preset 

Displays the title of the selected record preset for an MPEG recording event. 

Overwrite Displays the selected file overwrite option for an MPEG recording event. 
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FIELD DESCRIPTION 

Record CC 

data 

Indicates whether or not an MPEG recording event will capture any closed 

caption data from the source. 

Filename (2) Displays the filename of the MPEG file chosen as the audio background for a 

slide or slide show event. 

Storage 

Device (2) 

Indicates the storage device of the MPEG file chosen as the audio background 

for a slide or slide show event. 

Audio Input Indicates the audio input selected for a slide or slide show event. 

Print  Determines if the event will be included in a print operation. 

Export  Determines if the event will be included in an export operation. 

Media ID Assigned by user as a library tracking number. 

Field Name 

(1–11) 

Schedule column headings that may be assigned by user. 

SCHEDULING/EDITING/DELETING ALL EVENTS 

Scheduling an Event on a Day/Channel Output Event Window 

1. Select a scheduling event window as follows: 

a. Click the desired day tab to select the day you want the event to occur. 

b. If your MINI-T-NX has the record option, select one of the following channel tabs: 

 MPEG recording events only: select the “Rec/Prev” tab (see “Editing Internal 

MPEG Player and Recorder Device Resources,” on page 91 for more 

information on configuring channel output tabs). 

NOTE: Any input scheduled on the “Rec/Prev” tab is routed to the internal 

MPEG recorder as well as any preview monitor attached to the 

“Preview” ports on the rear panel of the MINI-T-NX. 

 All other events: channel output tab 
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2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event 

window.  This opens an “Event properties” box with editable event information like the 

one shown in Illustration 91, Day/Channel Output Event Properties Box. 

Illustration 91, Day/Channel Output Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 

(described on pages 156–188) and enter the new information.  An icon can be 

dragged and dropped into a day/channel output event window in the following five 

ways: 

 Empty Window—the event is locked and given the initial time of 12:00 A.M. 

(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 

used.) 

 Initial Switcback Interval—if an event is dragged into a switchback interval at the 

start of the day (1
st
 row), it is locked and given the initial time of 12:00 A.M.  

(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 

used.) 

 Any Other Switchback Interval—the event is initially unlocked, with a time equal to 

the “End” time of the previous event. 

 On Top of an Unlocked Event—the new event is initially unlocked and given the 

time of the event on which it was dragged.  The existing event is pushed downward 

and out of the way if possible.  If not, an error box appears.  Dragging an icon on 

top of a locked event instantly generates an error. 
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 Below the Bottom Event—the event is initially unlocked, with a time equal to the 

“End” time of the previous event. 

Scheduling an Event on the WinLGX-LT Event Window 

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, select 

the “Show WinLGX-LT tab in the schedule window” option on the “Application” 

tab of the Tools\Preferences window. 

1. Click the “WinLGX-LT” tab to open the corresponding event window.   

2. Drag an icon from the “Device” or “Library” “Resource View” onto the WinLGX-LT 

event window.  This opens an event properties box like the one shown in Illustration 

92, WinLGX-LT Event Properties Box.   

Illustration 92, WinLGX-LT Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 

(described on pages 156–180) and enter the new information.  The WinLGX-LT event 

properties box is the same as the event edit box displayed for the day/channel output 

event windows with the following exceptions. 

 There is no Lock/Unlock checkbox; you must enter a time for each event.   

 If an output assignment is desired, the output must be selected from the “Output” 

field drop down menu.   

 A date and/or day(s) must be selected as follows: 

NOTE: If a date is selected, the event happens on that date.  If days are 

selected, the event happens on those days.  If both are selected, the 

event happens on the selected date and days. 
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a. To select a date, change “Absolute date” to “Yes.”  A date field appears below to 

allow date entry.   

b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be 

toggled quickly by double clicking on the day name. 

4. If desired, you may edit the properties of a device or library resource and then apply 

those changes to any events added to the WinLGX-LT event window by performing 

the following steps: 

a. Select the desired device or library resource icon. 

b. Click on the desired editable resource fields in the “Properties” window and make 

the changes.  

c. WinLGX displays a dialog box that gives you the option to merge the resource 

editing changes into each event in the WinLGX-LT event window that was created 

from the same resource. 

Copying/Cutting/Pasting an Event 

To move or replicate an event or group of events to another location on the schedule, 

perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 

menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” and 

“A” keys. 

2. Copy, cut (if you wish to move event), and paste by selecting the function you wish to 

perform from either the “Edit” menu or the right-click popup menu.   

3. In the “Event Properties” box that appears once the paste has been completed, click 

“Ok” if one event was pasted or “Ok to all” if more than one event was pasted.   

NOTE: If the event(s) is pasted into a schedule switchback interval of a shorter 

duration than the event(s) itself, WinLGX will display a dialog asking 

whether or not you would like to trim/discard the ending playlist items to fit 

the switchback interval or abort the operation. 

Editing an Event 

To edit an event in the schedule, double click event, right click event and choose “Edit” in 

the right-click menu, or select “Edit” from the “Edit” menu.  Edit the event information in 

the “Event properties” box that appears.  To add or change the event information, click on 

each of the desired editable fields (described on pages 156–180) and enter the new 

information. 

Deleting an Event 

If the first event in the schedule window is deleted, the next event is locked in place, if 

necessary.  If any other event is deleted, any unlocked events immediately below it will 
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float up until they rest against the event above (unless this causes a device conflict, in 

which case the first unlocked event will be locked in place).   

To delete an event(s), perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 

menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” and 

“A” keys. 

2. Press the “Delete” key, right click event and choose “Delete” in the right-click menu, or 

select “Delete” from the “Edit” menu.  You will be prompted for confirmation before the 

event is deleted.  If you selected multiple events, one of the following dialog boxes is 

displayed: 

 If you selected a list of events that includes non-“Playlist” resource events, 

the dialog shown in Illustration 93 appears.  Perform one of the following options: 

Illustration 93, Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in a list of 

selected events.  

 “Delete all events?”: click “OK” to simultaneously delete all of the selected 

events.   

 “Skip this event?”: click “OK” to keep the current selection in a list of selected 

events. 
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 If you only selected any “Playlist” resource events, the dialog shown in 

Illustration 94 appears.  Perform one of the following options: 

Illustration 94, Playlist Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in the playlist.  

 “Delete entire playlist?”: click “OK” to simultaneously delete the entire playlist.  

 “Delete entire playlist in all switchbacks?”: this option will be enabled if the 

selected playlist was placed in the switchback intervals between programs.  

Click “OK” to simultaneously delete all instances of the playlist from the 

selected channel output’s switchback intervals. 

 

Replacing Library Resource Events 

By performing the following steps, you can replace one or more schedule events created 

with the same library resource with any library resource of the same format: 

NOTE: WinLGX considers MPEG videos, JPEG slides, and JPEG slide shows to be 

the same format.  

1. If you would like to change your library resource before using it to replace event(s), 

select the library resource in the “Resource View” window and then edit its resource 

properties. 

2. Drag a library resource onto a same-format library resource event you would like to 

replace.  The event properties window for the library resource will open, displaying a 

“Replace” button on the bottom of the window (see Illustration 95).   
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Illustration 95, "Replace" Button on Event Properties Window 

 

3. If desired, edit the properties of the library resource. 

4. Click the “Replace” button to open the “Find and Replace” window shown in Illustration 

96.  This window gives you a variety of options for replacing the selected event or all 

schedule events like the selected one with the dragged library resource.   

5. To make a replacement, click one of the replacement buttons on the bottom of the 

“Find and Replace” window.  The replacement buttons are described in Illustration 96.     
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NOTE: If your library resource is too long for the schedule time slot, you will be 

given the option to trim the resource to fit or cancel the replacement. 

Illustration 96, "Find and Replace" Window 

 
 

If you plan to replace multiple instances of the selected event, pay attention to the 

indicators above the replacement buttons on the “Find and Replace” window.  The 

indicators give a quick overview of how many instances of the selected event exist 

throughout your schedule.  Here is a quick description of each indicator: 

 “Day/Ch: x of x:” the second “x” indicates how many instances of the selected 

library resource event exist on the current day tab and channel output tab window, 

while the first “x” shows how many of the events have been replaced on the same 

window 

 “Ch: x of x:” the second “x” indicates how many instances of the selected library 

resource event exist on the current channel output tab windows, while the first “x” 

shows how many of the events have been replaced on the same windows 

 “Sch: x of x:” the second “x” indicates how many instances of the selected library 

resource event exist on all of the day and channel output tab windows, while the 

first “x” shows how many of the events have been replaced on the same windows 

 

Inserting Library Resource Events 

By performing the following steps, you can insert a library resource into the time slot of an 

unlocked library resource event of the same format.  The inserted event will take the start 
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time of the event onto which it was dragged.  Unlocked events below the inserted event 

will be automatically pushed downward in the schedule by an amount of time equal to the 

length of the inserted event.   

NOTES:  WinLGX considers MPEG videos, JPEG slides, and JPEG slide shows to 

be the same format. 

  If there are locked events above and/or below the selected event, the 

desired time slot may not be long enough to accommodate the dragged 

library resource.   

 If there is not a switchback interval between the selected event and a 

locked event, the “Insert” button will be unavailable on the resource’s 

“Event Properties” window.   

 If there is a short switchback interval between the selected event and a 

locked event, you will be given the option of trimming the resource to fit 

the available time slot or cancelling the insert. 

1. If you would like to change your library resource before inserting it in your schedule, 

select it in the “Resource View” window and then edit its resource properties. 

2. Drag a library resource onto an unlocked library resource event of the same format.  

The event properties window for the library resource will open. If there is enough time 

available to accommodate the new resource’s length, an “Insert” button will be 

displayed on the bottom of the window (see Illustration 97).   

Illustration 97, "Insert" Button on Event Properties Window 

 

3. If desired, edit the properties of the library resource. 

4. Click the “Insert” button to assign the selected event’s start time to the dragged library 

resource event.  All unlocked events below the inserted event will shift downward in the 

schedule by an amount of time equal to the length of the inserted event. 
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SCHEDULING/EDITING DEVICE RESOURCES 

Adding or editing device resource events opens windows like the examples shown in this 

section.  Editable event fields are highlighted in each event properties window.  Click “OK” 

to submit the event or “Cancel” to abort the add/edit.   

DVD Device Resources 

Dragging a DVD device resource onto the schedule reveals a box like Illustration 98, DVD 

Device Event Properties Window.  Refer to Table 25, Editable DVD Device Properties, for 

a description of the editable event properties. 

Illustration 98, DVD Device Event Properties Window 

 

Table 25, Editable DVD Device Properties 

FIELD DESCRIPTION 

Lock box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the “Time” 

field to become enabled, allowing the user to enter a fixed execution time for 

the event.  Unlocking an event disables the “Time” field, causing WinLGX to 

assign a time to the event that starts at the end of the event above it in the 

schedule. 
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FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Device Ensure you have selected the device you wish to schedule. 

Setup time If desired, indicate how long after the device receives a “PLAY” command that 

picture and/or sound is produced. 

NOTE: The “Setup time” field appears after “Format” is selected. 

Length This must be entered to indicate the duration of the event. 

Preroll  Enter as needed.  Indicates amount of video at start of a program that you do 

not want playing on air.   

Reset Enter time the playback device will be busy and unavailable for scheduling after 

the end of the program.  It is typically the rewind time. 

Time If the event is locked, the event “Time” can be modified.  This is the scheduled 

“On-Air” time of the event. 

Event Start— 

Command 

Chose either the “PLAY” or “RECORD” command.  It will almost always be 

“PLAY.” 

Event End— 

Command 

Choose from the following commands:  “STOP,” “PAUSE,” or “<None>.”  It will 

usually be “STOP.” 

NOTE: For DVD, check your interface manual and switches to determine 

the actions performed by the “STOP” command.  By default, 

“STOP” stops the DVD at the current location. 

Switchback 

input  

Use to enter the input to be taken to the output at the end of the event. 

Comment Use to enter a description with up to 31 characters.   

Media ID Assign as a library tracking number. 

Field Name 1–

x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event records by 

checking the “Export/print all records” option under the “Export/Print 

Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into comma 

delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you can enable 

the export function for all of the resource’s event records by checking the 

“Export/print all records” option under the “Export/Print Templates” window. 
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FIELD DESCRIPTION 

Maximum view Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” view (for 

instructions, see “Event Editor Tab” on page 81).  To toggle between these 

views, select and deselect the “Maximum view” checkbox. 

 

Tape Device Resources 

Dragging a tape device resource onto the schedule reveals a box like Illustration 99, Tape 

Device Event Properties Window.  Refer to Table 26, Editable Tape Device Properties, for 

a description of the editable event properties. 

Illustration 99, Tape Device Event Properties Window 

 

Table 26, Editable Tape Device Properties 

FIELD DESCRIPTION 

Lock box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the “Time” 

field to become enabled, allowing the user to enter a fixed execution time for the 

event.  Unlocking an event disables the “Time” field, causing WinLGX to assign 

a time to the event that starts at the end of the event above it in the schedule. 

Title Allows a name of up to 31 characters to be entered. 
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FIELD DESCRIPTION 

Device Ensure you have selected the device you wish to schedule. 

Setup time If desired, indicate how long after the device receives a “PLAY” command that 

picture and/or sound is produced. 

NOTE: The “Setup time” field appears after “Format” is selected. 

Length This must be entered to indicate the duration of the event. 

Preroll  Enter as needed.  Indicates amount of video at start of a program that you do 

not want playing on air.   

Reset Enter time the playback device will be busy and unavailable for scheduling after 

the end of the program.  It is typically the rewind time. 

Time If the event is locked, the event “Time” can be modified.  This is the scheduled 

“On-Air” time of the event. 

Event Start— 

Command 

Chose either the “PLAY” or “RECORD” command.  It will almost always be 

“PLAY.” 

Event End— 

Command 

Choose from the following commands:  “STOP,” “REWIND,” or “<None>.”  It 

will usually be “STOP.” 

Switchback 

input  

Use to enter the input to be taken to the output at the end of the event. 

Comment Use to enter a description with up to 31 characters.   

Media ID Assign as a library tracking number. 

Field Name 1–

x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event records by 

checking the “Export/print all records” option under the “Export/Print 

Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into comma 

delimited or Microsoft Excel
®
 formats.  If “No” is selected, then you can enable 

the export function for all of the resource’s event records by checking the 

“Export/print all records” option under the “Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” view (for 

instructions, see “Event Editor Tab” on page 81).  To toggle between these 

views, select and deselect the “Maximum view” checkbox. 
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Switch Device Resources 

Dragging a switch device resource onto the schedule reveals a box like Illustration 100, 

Switch Device Event Properties Window.  Refer to Table 27, Editable Switch Device 

Event Properties, for a description of the editable event properties. 

Illustration 100, Switch Device Event Properties Window 

 

Table 27, Editable Switch Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure you have selected the device you wish to schedule. 

Length Enter duration of the event. 
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FIELD DESCRIPTION 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the event. 

Comment Use to enter a description with up to 31 characters.   

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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GPI Output Device Resources 

NOTE: GPI output devices can only be scheduled on the WinLGX-LT tab. 

Dragging a GPI device resource onto the schedule reveals a box like Illustration 101, GPI 

Output Device Event Properties Window.  Refer to Table 28, Editable GPI Output Device 

Event Properties, for a description of the editable event properties. 

Illustration 101, GPI Output Device Event Properties Window 

 

Table 28, Editable GPI Output Device Event Properties 

FIELD DESCRIPTION 

Title Allows a name up to 31 characters to be typed. 

Device Select the number (1–16) of the PRO-BUS interface your device is 

connected to. When a device number is chosen, it is removed from 

the “Device” list.  

NOTE: Ensure assigned device number reflects actual PRO-BUS 

interface connected to input device.  A PRO-BUS interface 

only responds to those PRO-BUS commands which 

contain its address. 

Length Enter the event duration.  
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FIELD DESCRIPTION 

Absolute date If you would like to schedule the GPI event on a specific date, select 

“Yes” to display the “Start date” field and enter the desired date. 

Sunday–Saturday If you would like to schedule the GPI event on a specific day, change 

the desired day field(s) from “No” to “Yes.” 

Time Enter the start time for the event.  This is the scheduled “On-Air“ time 

of the event. 

Command Depending on how you configured your GPI PRO-BUS interface’s dip 

switches (refer to your PRGPI PRO-BUS Interface Manual for more 

details), the wire pair selections in the drop down list: 

1. Close the corresponding GPI output until a command is sent to 

close a different GPI output. 

Or 

2. Pulse the corresponding GPI output closed for 750 mS.  

Media ID Assign as a library tracking number. 

Field Name 1–x Assign desired schedule column headings. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported 

into comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, 

then you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 81).  

To toggle between these views, select and deselect the “Maximum 

view” checkbox. 

 



MINI-T-NX 

Software Operation 

Page 164   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

Internal MPEG Player Device Resource 

Dragging the MINI-T-NX MPEG player device resource onto the schedule reveals a box 

like Illustration 102, MPEG Player Event Properties Window.  Refer to Table 29, Editable 

MPEG Player Event Properties, for a description of the editable event properties. 

Illustration 102, MPEG Player Event Properties Window 

 

Table 29, Editable MPEG Player Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure the MPEG player is selected. 

Setup time If desired, indicate how long after the MPEG player is activated that 

picture and/or sound is produced. 
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FIELD DESCRIPTION 

Reset If desired, enter time the MPEG player will be busy and unavailable for 

scheduling after the end of the program.   

Filename Use this field to choose the MPEG or slide file you want to display.  The 

file’s storage area will appear in the “Storage device” field and, if 

selected, the “Video bitrate,” “Video bitrate type,” and “Audio sample 

rate” fields will display the MPEG file’s corresponding properties. 

In point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to begin, 

select the “In point” field and either type the desired file start point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the in point as follows: 

1. Specify the clip’s playback start point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the  

button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 
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FIELD DESCRIPTION 

Out point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to end, 

select the “Out point” field and either type the desired file end point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the out point as follows: 

1. Specify the clip’s playback end point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length The length of the file is automatically entered into this field. 

Time If the event is locked, the event start “Time” can be modified.  This is the 

scheduled “On-Air” time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.    

Command 

(Event end) 

Choose between “STOP” and “<None>.”    It will almost always be 

“STOP.”  

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the 

event. 

Comment Use to enter a description with up to 31 characters.   

Media ID Assign as a library tracking number. 

Field Name 1–x Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 
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FIELD DESCRIPTION 

Maximum view Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 81).  

To toggle between these views, select and deselect the “Maximum view” 

checkbox. 
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Internal MPEG Recorder Device Resources 

The MINI-T-NX internal MPEG recorder is a paid option available from LEIGHTRONIX.  

The MPEG recorder loops to the “Preview” Output on the rear panel of the MINI-T-NX, 

allowing users to conveniently view the programming being recorded.  Users without the 

MPEG recorder option cannot schedule programming for display on a preview monitor.  

However, all users can use the control panel to switch inputs to the “Preview” output (see 

“Displaying Programming through the “Preview” Output,” on page 194). 

Dragging the MINI-T-NX internal MPEG recorder device resource onto the schedule 

reveals the box in Illustration 103, MPEG Recorder Event Properties Window.  Refer to 

Table 30, Editable MPEG Recorder Event Properties, for a description of the editable 

event properties. 

NOTE: Before recording MPEG files for on-air playback, first create a short test 

MPEG file. Play this test file on your MINI-T-NX MPEG player to check your 

recorder settings.  Verify that your audio levels match the audio levels from 

other MINI-T-NX sources. Once you have determined the proper MPEG 

recorder settings, make note of them for use during future recording sessions. 

If you would like to play an MPEG file within the same schedule it was recorded, 

create and schedule an MPEG library resource with the same filename and length given to 

the MPEG recording event.  See “MPEG Library Resources” on page 110 for further 

instructions on creating an MPEG library resource.  The library resource will be available 

for playback once the MPEG recording event ends. 

Illustration 103, MPEG Recorder Event Properties Window 
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Table 30, Editable MPEG Recorder Event Properties 

FIELD DESCRIPTION 

Lock At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 

Add to 

Library 

The “Add to library” option causes WinLGX to automatically create a 

library playback resource for the recording event.  This library resource 

may be used to schedule a playback event with the recorded MPEG file.  

To enable this option, check the “Add to library” box at the bottom of the 

event properties window.  The “Add to library folder” window shown in 

Illustration 104 will display.  Select the library folder you would like to 

contain the library resource and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that 

possesses the same video filename and length as a pre-

existing library resource. 

  If the new file possesses the same title as another 

resource, but has a different video filename and/or 

length, WinLGX will copy the new file to the library with a 

numbered increment added to its title.  For example, if 

this is the first time you have reused the title of a pre-

existing library resource, WinLGX will add the new file to 

the library under the name “title01.” 

Illustration 104, “Add to library folder” Window 

 

Title Allows a name up to 31 characters to be typed. 

Input Select the input signal you want the MPEG recorder to record. 
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FIELD DESCRIPTION 

Device Ensure MPEG recorder is selected. 

Setup time If desired, indicate how long after the selected MPEG recorder is activated 

that recording starts. 

Reset If desired, enter time the MPEG recorder will be busy and unavailable for 

scheduling after the end of the program. 

Record 

Preset 

Select one of the three recording settings configured under “System 

Configuration.” 

Record 

Overwrite 

Select “Always” to automatically record over an existing file with the same 

name or “Create Unique” to record a file entered under an existing MPEG 

filename with the first 14 characters of the original filename followed by 

“yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as 

year/month/ day and hh/mm/ss is the file record time in 

hours/minutes/seconds). 

Record CC 

data 

Select “Yes” to capture any closed caption data from the source.  Closed 

captions are hidden in the video signal and decoded for display on 

televisions with built-in decoders or televisions connected to external 

decoders. 

MPEG 

Filename 

Perform one of the following: 

 Enter up to 27 characters to create a new filename for the 

recording event.  You will not be able to schedule the recorded file 

for playback within the same schedule. 

NOTE: Do not include spaces in the filename.  The MINI-T-NX 

cannot display files that have spaces in their filenames. 

 If you created a playback library resource for the MPEG file to be 

recorded, enter the exact filename used for the library resource.   

Storage 

device 

Automatically selects the internal hard drive. 

Length Enter recording duration.  If you created an MPEG library resource for the 

MPEG file to be recorded, enter the same time duration used for the 

library resource.  

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The “RECORD” command is automatically displayed. 

Command 

(Event end) 

Choose either “STOP” or “<None>.”    It will almost always be “STOP.”   
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FIELD DESCRIPTION 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the event. 

Comment Use to enter a description with up to 31 characters.   

Media ID Assign as a library tracking number. 

Field 1–x Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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SCHEDULING/EDITING LIBRARY RESOURCES 

Adding or editing a library resource event opens windows like the examples shown in this 

section.  Editable event fields are highlighted in each event properties window.  Click “OK” 

to submit the event or “Cancel” to abort the add/edit. 

Tape and DVD Library Resources 

Dragging a tape or DVD library resource onto the schedule reveals a box like Illustration 

105, Example of DVD Event Properties Window, appears.  Refer to Table 31, Editable 

Tape and DVD Library Event Properties, for a description of the editable event properties. 

Illustration 105, Example of DVD Event Properties Window 

 

Table 31, Editable Tape and DVD Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 
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FIELD DESCRIPTION 

Device Allows a same format device to be chosen.  Its associated input will 

appear in the “Input” field.   

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Choose either the “PLAY” or “RECORD” command.  It will nearly always 

be “PLAY.”   

Command 

(Event end) 

Choose from the following commands:  “STOP,” “PAUSE,” or “<None>.”  

It will usually be “STOP.”   

NOTE: For DVD, check your interface manual and switches to 

determine the actions performed by the “STOP” command.  By 

default, “STOP” stops the DVD at the current location.   

Switchback 

input 

Enter the input to be taken to the output at the end of the event. 

Comment Use to change or enter a description with up to 31 characters.   

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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Switch Library Resources 

Dragging a switch library resource onto the schedule reveals a box like Illustration 106, 

Switch Event Properties Window.  Refer to Table 32, Editable Switch Event Properties, 

for a description of the editable event properties. 

Illustration 106, Switch Event Properties Window 

 

Table 32, Editable Switch Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 

Device Allows a same format device to be chosen.  Its associated interface and 

input will appear in the corresponding fields. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air” time of the event. 
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FIELD DESCRIPTION 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the event. 

Comment Use to change or enter a description with up to 31 characters.   

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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Slide Library Resources 

Dragging a slide library resource onto the schedule reveals a box like Illustration 107, 

JPEG Slide Event Properties Window.  Refer to Table 33, Editable JPEG Slide Library 

Event Properties, for a description of the editable event properties. 

Illustration 107, JPEG Slide Event Properties Window 

 

Table 33, Editable JPEG Slide Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 

Device Automatically displays the internal MINI-T-NX MPEG player.  Its 

associated input will appear in the “Input” field.   
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FIELD DESCRIPTION 

Length The default slide length specified in the “Application” tab of the 

“Preferences” window is automatically displayed once the slide filename is 

selected (see page 75 for more information), but may be edited to any 

value greater than 5 seconds. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The PLAY command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the event. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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Slide Show Library Resources 

Dragging a slide show library resource onto the schedule reveals a box like Illustration 

108, JPEG Slide Show Event Properties Window.  Refer to Table 34, Editable JPEG 

Slide Show Library Event Properties, for a description of the editable event properties.  

Each slide in a slide show will automatically transition from one slide to the next with a fast 

cut transition and display for 10 seconds at a time.   

NOTE: Slides must be enabled and authorized in the Storage Manager before 

they will appear in slide shows (see “Managing SLIDES: Uploading to 

the MINI-T-NX and Authorizing for Display,” on page 211). 

Illustration 108, JPEG Slide Show Event Properties Window 

 

Table 34, Editable JPEG Slide Show Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the 

“Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” field, 

causing WinLGX to assign a time to the event that starts at the end of the 

event above it in the schedule. 
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FIELD DESCRIPTION 

Device Automatically displays the internal MINI-T-NX MPEG player.  Its 

associated input will appear in the “Input” field.   

User list If desired, edit the user list to change the corresponding slide selections.  

Length Enter the display duration for the slide show.  Each slide within the slide 

show will automatically display for 10 seconds at a time. 

Time If the event is locked, the event start “Time” can be modified.  This is the 

scheduled “On-Air” time of the event. 

Command 

(Event start) 

Choose “PLAY” or “STOP.”  It will nearly always be “PLAY.”   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the event. 

Comment Use to change or enter a description with up to 31 characters.   

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” 

view (for instructions, see “Event Editor Tab” on page 81).  To toggle 

between these views, select and deselect the “Maximum view” checkbox. 
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MPEG Library Resources 

Dragging an MPEG library resource onto the schedule reveals a box like Illustration 109, 

MPEG Library Event Properties Window.  Refer to Table 35, Editable MPEG Library 

Event Properties, for a description of the editable event properties. 

Illustration 109, MPEG Library Event Properties Window 

 

Table 35, Editable MPEG Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Device Automatically displays the internal MINI-T-NX MPEG player.  Its 

associated input will appear in the “Input” field.   
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FIELD DESCRIPTION 

In point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to begin, 

select the “In point” field and either type the desired file start point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the in point as follows: 

1. Specify the clip’s playback start point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the  

button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Out point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to end, 

select the “Out point” field and either type the desired file end point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the out point as follows: 

1. Specify the clip’s playback end point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length The MPEG file library resource length is automatically entered. 

Time If the event is locked, the event start “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.   
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FIELD DESCRIPTION 

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the 

event. 

Comment Use to change or enter a description with up to 31 characters.   

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum view Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 81).  

To toggle between these views, select and deselect the “Maximum view” 

checkbox. 
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MPEG Loop Library Resources 

Dragging an MPEG loop library resource onto the schedule reveals a box like Illustration 

110.  Refer to Table 36, Editable MPEG Loop Library Event Properties, for a description 

of the editable event properties. 

Illustration 110, MPEG Loop Event Properties Window 

 

Table 36, Editable MPEG Loop Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Device Automatically displays the internal MINI-T-NX MPEG player.  Its 

associated input will appear in the “Input” field.   
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FIELD DESCRIPTION 

In point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to begin, 

select the “In point” field and either type the desired file start point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the in point as follows: 

1. Specify the clip’s playback start point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the  

button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Out point (in 

HH:MM:SS:FF, 

where 

FF=frames) 

To specify where in the selected file you would like playback to end, 

select the “Out point” field and either type the desired file end point or 

click the ellipsis button to open the control panel clip editor for the 

MPEG player. If using the control panel, specify the out point as follows: 

1. Specify the clip’s playback end point using one of the following 

methods: 

 Click the  button to start playing the file and click the 

 button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 button. 

 Click the  or  button to move between groups of pictures 

(GOPs) in the MPEG file and click the  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 
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FIELD DESCRIPTION 

Length To change the number of times or length of time you would like the file 

to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to display 

the “MPEG Loop Calculator” (see Illustration 72, MPEG Loop 

Calculator).  

2. Enter the number of times you would like the file to loop in the 

“Loop count” field and/or enter a length of time, up to 24 hours, in 

the “Loop length” field. 

Time If the event is locked, the event start “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, enter the input to be taken to the output at the end of the 

event. 

Comment Use to change or enter a description with up to 31 characters.   

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 

selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel
®
 formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum view Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 81).  

To toggle between these views, select and deselect the “Maximum view” 

checkbox. 
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MPEG File/Slide Playlist Resources 

Dragging a playlist of MPEG files and/or JPEG slides onto the schedule reveals an event 

properties window for each item in the playlist (see Illustration 111 for an example).  

Perform either of the options below:  

NOTE: If the playlist resource is dragged into a switchback interval between events 

with a shorter time duration than the playlist itself, WinLGX will display a dialog 

asking whether or not you would like to trim/discard the ending playlist items to 

fit the interval or abort the operation.   

Illustration 111, Playlist Event Properties Window 

 

 Change the editable fields for each resource item according to the tables referenced 

below.  Click “Ok” after changing or reviewing each resource or “Cancel” to abort entire 

operation. 

 Slide: see Table 33 on page 176 

 Slide Show: see Table 34 on page 178 

 MPEG File: see Table 35 on page 180  

 Looped MPEG File: see Table 36 on page 183 

 Click “Ok to all” to enter all playlist resource properties into the schedule without editing 

or “Cancel” to abort entire operation. 
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EDITING PROGRAM INTERVALS 

Filling Schedule Switchback Intervals with MPEG/Slide Library Resources 

WinLGX gives you the option to use digital library resources (MPEG videos, JPEG slides 

and slide shows, and slide/video playlists) to simultaneously fill time between all programs 

within your schedule.  The bottom of your schedule window includes a “Channel 

switchback count” that automatically displays the total number of empty time slots 

between programs on all of the channel output tabs (see Illustration 112).  Just drag a 

digital library resource onto a program interval and check the “Apply to all switchbacks” 

option on the resource’s event properties window before clicking “Ok” (see Illustration 112 

and Illustration 113). Whether you selected “By the day” or “By the week” on the 

“Application” tab of the “Preferences” window will determine if the program intervals will be 

filled on just the selected channel output’s day tab or all of the channel’s day tabs (see the 

“Application” tab section of the “Setting WinLGX Viewing and Communication 

Preferences,” on page 75). 

Illustration 112, Digital Library Resource Dragged into Schedule Program Interval 

 

“Apply to all 

switchback” Option 

Schedule 

Event Counter 

Schedule 

Switchback 

Counter 
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Illustration 113, Digital Library Resource Apply to all Switchbacks Option 

 

 

Manually Changing Switchback Inputs for Program Intervals 

The “Channel Switchback Editor” (see Illustration 114), under the WinLGX 

“Tools”/”System Tools” menu, provides a quick way to change the inputs selected to fill 

the empty time slots between programs.  Change the switchback inputs on each of your 

channel/day tab windows to any of your external inputs.  Perform the following steps: 

Illustration 114, "Channel Switchback Editor" 

 

“Apply to all 

switchbacks” 

Option 
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1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel 

Switchback Editor” (see Illustration 114). 

2. Select the channel output/day tab schedule window containing the switchback inputs 

you would like to change by selecting a channel output under “Channel” and a day 

under “Day of week.”  You may select “All” under “Day of week” to select all schedule 

windows for the channel output. 

3. Under “Replace all,” select the switchback input you would like to change. 

4. Use the “With” drop down menu to select a new switchback input. 

5. Click “OK” to make the changes or “Cancel” to abort. 
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CHECKING SCHEDULE AND LIBRARY RESOURCES FOR MISSING MPEG FILES 

Ensure your image files’ schedule events and library resources do not contain MPEG files 

that have been removed from your MINI-T-NX’s internal hard drive as described below:  

1. If you have not already done so, open a MINI-T-NX image file in WinLGX. 

2. Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync 

Library Resources” menu item.  Those events containing missing MPEG files are 

highlighted in the schedule (red is the WinLGX default color) and a “Sync Library 

Resources” box pops up to report the total number of schedule events and each library 

resource containing MPEG files no longer available on the MINI-T-NX internal hard 

drive.  Perform any of the following from the popup window: 

 Delete library resources and corresponding schedule events: empty library 

resources and their schedule events may be removed from the MINI-T-NX image 

file by selecting each resource in the “Sync Library Resources” window and then 

clicking the “Delete” button.  When prompted, click “Yes” to delete the library 

resource and any events scheduled with the resource or “No” to abort. 

 Update status report on popup window: if modifications are made to the schedule 

and/or library resources while the “Sync Library Resources” window is open, click 

the “Refresh” button to update the popup window.   

 Close popup window: click “Done” to close the window. 

Illustration 115, Synced Schedule 
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SENDING MINI-T-NX IMAGE FILES 

To activate a schedule of event actions, send an image file to each connected MINI-T-NX 

server/controller as follows: 

NOTE: Users must have “Send, receive, rename and delete” rights in order to send an 

image file to a MINI-T-NX system (refer to “Setting User Account Rights 

(Including WinLGX Password Changes),” on page 61, for more information on 

user rights).   

1. Send an image file to one or more of the currently connected server/controllers 

according to the following steps: 

 One server/controller: ensure the server/controller’s product tab is selected and 

choose “Send” in the “File” menu or click its  icon on the main toolbar.  A dialog 

box will ask whether you want to send the tab’s currently loaded image to the 

connected MINI-T-NX server/controller.  Click “Yes” to complete the send and 

open the status box shown in Illustration 116. 

 Multiple server/controllers: from any of the product tabs, select “Send all” in the 

“File” menu.  For each connected server/controller, a separate dialog box will ask 

whether you want to send the server/controller’s loaded image.  Click “Yes” for 

each server/controller to finish sending all of the images.  You will see a status box 

like the one shown in Illustration 116 each time you click “Yes.” 

Illustration 116, “Send image” Status Box 

 

NOTE: To interrupt the send, click the “Cancel” button.  If the send action appears 

to be stalled, cancel it and check your default location IP address and your 

network connections. 

2. Once each transfer is completed, the MINI-T-NX system(s) will contain and execute 

the scheduled events.   
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USING CONTROL PANEL TO PERFORM IMMEDIATE DEVICE AND 

SWITCH ACTIONS 

Use the Control Panel to perform unscheduled control actions, such as starting and 

stopping a schedule loaded on the MINI-T-NX, switching an input to a different output, 

and controlling your input devices.   

1. Open the Control Panel window (see Illustration 117) by clicking “Control Panel” under 

the “Tools” menu or  icon on the main toolbar.   

NOTE: The switcher and external device information displayed in the control panel 

depends on the switcher configuration (see “Configuring MINI-T-NX 

System’s Switcher Properties,” on page 85) and the external device 

configurations (see “Creating External Device Resources,” on page 95). 

Illustration 117, Control Panel Window 

 

2. If desired, sort the device icons by right-clicking in the “Devices” column and selecting 

one of the sorting filters in the right-click menu that appears (see Illustration 118, 

Control Panel Device Sorting Menu). 
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Illustration 118, Control Panel Device Sorting Menu 

 

3. Perform any of the following steps: 

 Start/stop a schedule (see page 193). 

 Force a switch and view switcher status (see page 193). 

 Display any input’s programming through the “Preview” Output (see page 194). 

 Select a device in the “Devices” column and refer to one of the following sets of 

control steps: 

 “Controlling Internal MPEG Player,” on page 194 

 “Controlling Internal MPEG Recorder,” on page 201 

 “Controlling External Devices,” on page 205 

4. When finished, click “Close” to close the control panel. 

STOP/START A SCHEDULE 

Once an image file with a schedule of events has been sent to the MINI-T-NX (see “ 

Sending MINI-T-NX Image Files” on page 191), you may use the stop/start schedule 

button on the bottom of the control panel window (see Illustration 117, Control Panel 

Window) to perform the following: 

 Stop the currently running schedule by clicking the “Stop Schedule” button. 

 Restart the current schedule by clicking the “Start Schedule” button. 

PERFORMING FORCED SWITCHES AND VIEWING SWITCHER STATUS 

From the bottom of the Control Panel window (see Illustration 119, Switch Control Panel 

for Internal Switcher, for an example), click an input button to take that input to the output 

for the selected row.   

Illustration 119, Switch Control Panel for Internal Switcher 

 

The input button will turn green when clicked if the switch is valid or red if the switch is 

invalid.  To the right of each output icon is a box showing the currently selected input.  
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Green means valid video present, gray indicates no valid video, while red indicates an 

invalid switch.   

DISPLAYING PROGRAMMING THROUGH THE “PREVIEW” OUTPUT 

The “Rec/Prev” row on the bottom of the control panel allows users to switch any input’s 

programming to a preview monitor attached to the “Preview” Output on the rear panel of 

the MINI-T-NX.  To display programming on the “Preview” Output, click any available input 

in the “Rec/Prev” row (see Illustration 120). 

NOTE: If you purchased the internal MPEG recorder option for your MINI-T-NX, any 

input switched to the “Preview” Output is routed to the internal MPEG recorder 

as well as the preview monitor. 

Illustration 120, Switching to the “Preview” Output 

 

CONTROLLING INTERNAL MPEG PLAYER 

Select either the MPEG player icon in the Control Panel window’s “Device” list and click 

the “Play” tab to display the corresponding device control panel (see Illustration 121, 

MPEG Player Control Panel).  

Illustration 121, MPEG Player Control Panel 

 

The following is a list of the operations that may be performed: 

 “Queuing a File” on page 195 

 “Looping an MPEG File” on page 198 

“Play” 

Tab 
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 “Playing a File” on page 198 

 “Queuing the Next File” on page 198 

 “Displaying a Slide with Audio from an MPEG File” on page 198 

 “Stopping a File” on page 199 

 “Pausing a File” on page 199 

 “Creating a Library Clip Resource” on page 199 

Queuing a File 

Open the “Select File” window for either JPEG slides or MPEG video files as follows: 

 MPEG video files:  

1. Click the button next to “Queued Video File” to open the “Select File” video 

window (see Illustration 122, “Select File” Video Window).   

Illustration 122, “Select File” Video Window 

 
 

2. Select the storage device containing the desired MPEG video file from the 

“Storage device” drop down list. 

3. If desired, display an MPEG video file’s storage device, name, length, video 

bitrate, and audio sample rate by highlighting the file and clicking the 
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“Properties” button (see Illustration 123, “File Properties” Window).  Click “OK” 

to close the “File Properties” window and return to the “Select File” dialog. 

Illustration 123, “File Properties” Window 

 

4. Select the desired file by double-clicking or highlighting the file and clicking 

“OK.”  The MPEG player control panel will then display the properties of the 

selected file under “Queued Video File” (see Illustration 124, Queued MPEG 

Video File Properties).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 

video window. 

Illustration 124, Queued MPEG Video File Properties 
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 JPEG slides:  

1. Click the button next to “Queued Slide” to open the “Select File” slide window 

(see Illustration 125, “Select File” Slide Window).   

Illustration 125, “Select File” Slide Window 

 

2. Select the desired username from the “Users” drop down list to display the 

desired slides. 

3. Select the desired file by double-clicking or highlighting the file and clicking 

“OK.”  The MPEG player control panel will then display the properties of the 

selected file under “Queued Slide” (see Illustration 126, Queued JPEG Slide).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 

slide window. 

Illustration 126, Queued JPEG Slide  

 
Looping an MPEG File 
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Click the “Loop” checkbox to set up an MPEG file for repeat playback.  Once the  

button is clicked, the file will play over and over, from beginning to end, until the  

button is clicked or a scheduled event occurs. 

Playing a File 

Click the  button under “Audio/Video” for an MPEG file or “Slide” for a JPEG slide to 

play the most recently queued file.  The activated file moves into the current position on 

the control panel.  While an MPEG file is playing, the counter displays the file playback 

time in HH:MM:SS:FF (FF=frames).  The counter displays “**” in the FF or frames place 

holder during playback (furthest to the right) (see Illustration 127), showing the current 

frame number when the file is paused. 

Illustration 127, MPEG File Counter 

 

Queuing the Next File  

While a file is playing, another file may be loaded into the “Queued Video File” position 

(see “Queuing a File” on page 195 and Illustration 128, Queued and Currently Playing 

Files). 

NOTE: Clicking the  button while another file is playing will cause the queued file to 

override the current file and begin playing. 

Illustration 128, Queued and Currently Playing Files 

 

Displaying a Slide with Audio from an MPEG File 

1. Ensure the “Synced” box is checked. 

2. Ensure that the desired MPEG file and JPEG slide have been queued (see “Queuing a 

File” on page 195 for more information). 

3. Control the synced files as follows from either the “Audio/Video” or “Slide” controls: 

 Click the  button to simultaneously activate the MPEG file and JPEG slide. 
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 To stop both files, click the  button. 

 To pause the audio track from the MPEG file, click the  button. 

 

Stopping a File 

Click the  button under “Audio/Video” for an MPEG file or “Slide” for a JPEG slide to 

stop a file.  Stopping a file unloads it from the “Current Video File” position. 

Pausing an MPEG File 

Click the  button under “Audio/Video” to pause an MPEG file in the “Current Video 

File” position.  When an MPEG file is paused, the counter displays the current frame 

number in the FF or frames place holder (furthest to the right) (see Illustration 129).  To 

reactivate the file, click the  button again. 

Illustration 129, MPEG File Counter with Frame Number Displayed 

 

Creating a Library Clip Resource 

Use the MPEG Player clip creation panel to create a library resource for a clip of an 

MPEG file. 

 

1. Click the “Clip” tab to display the clip creation panel (see Illustration 130). 

Illustration 130, MPEG Player Clip Creation Panel 
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2. Load the file you would like to use to create a clip according to the following steps: 

a. Click the button next to “Storage device” to display the “Select File” window (see 

Illustration 131). 

Illustration 131, “Select File” Window 

 

b. Single click on the desired file to highlight it and either double click or click “OK” on 

the bottom of the window to finish loading the file. 

3. Specify the clip’s playback start point using one of the following methods: 

 Click the  button to start playing the file and click the  button at the 

desired spot. 

 Drag the playback bar to the desired spot and click the  button. 

 Click the  or  button to move between groups of pictures (GOPs) in the 

MPEG file and click the  button. 

4. Specify the clip’s playback end point using one of the methods outlined above for 

selecting an in point and click the  button. 

5. To move to the selected in point and/or out point, click the  or  

button. 

6. Preview the clip before airing by clicking the  button. 
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7. Once you have specified the desired in and out points, create a new library item for the 

clip by clicking the “Add to library” button to display the “Add to library folder” window 

(see Illustration 132) and performing the following steps: 

Illustration 132, “Add to library folder” Window 

 

a. Select the library folder in which the corresponding MPEG file library resource will 

be created. 

b. If desired, rename the clip in the “Resource name” field. 

c. Click “OK” to add the clip to the library or “Cancel” to abort the changes. 

CONTROLLING INTERNAL MPEG RECORDER 

Select the MPEG recorder icon in the control panel window’s “Device” list to display the 

corresponding recorder control panel (see Illustration 133, MPEG Recorder Control 

Panel).  Perform the following steps: 

Illustration 133, MPEG Recorder Control Panel 

 

1. Select the MPEG file recording parameters: 
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a. Check the “Record CC data” box to capture any closed caption data from the 

source during recording.  Closed captions are hidden in the video signal and 

decoded for display on televisions with built-in decoders or televisions connected to 

external decoders. 

b. Select one of the following record overwrite options: 

 “Never”: WinLGX does not allow a file entered with an existing filename to 

record and displays an error message  

 “Always”: WinLGX records over an existing file with the same name 

NOTE: Selecting the “Always” option disables the “Add to library” option. 

 “Create unique”: if an existing filename is entered, WinLGX automatically 

records the file under the first 14 characters of the original filename followed by 

“yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as 

year/month/ day and hh/mm/ss is the file record time in 

hours/minutes/seconds) 

c. Under “File,” enter up to 27 characters for the filename. 

d. Select one of the user-defined record presets for the desired recording quality.  

See “Configuring MPEG Recording Presets for Recorder Option,” on page 90 for 

more information on defining the recording quality settings. 

e. If you would like a library resource for the MPEG file added to the “Library” tab 

window, select the “Add to library” option.  Once the MPEG recorder stops, 

WinLGX displays the “Add to library” window (see Illustration 134).  Select the 

library folder in which the corresponding MPEG file library resource will be created. 

  NOTES:  WinLGX will not create a library resource for a file that possesses the 

same video filename and length as a pre-existing library resource. 

  If the new file possesses the same title as another resource, but has 

a different video filename and/or length, WinLGX will copy the new 

file to the library with a numbered increment added to its title.  For 

example, if this is the first time you have reused the title of a pre-

existing library resource, WinLGX will add the new file to the library 

under the name “title01.” 



MINI-T-NX 

Software Operation 

LEIGHTRONIX, INC.  Page 203 

2018-06-08  WinLGX ver. 6.0.1.48 
 

Illustration 134, “Add to library folder” Window 

 

2. Select and record an input through one of the following options: 

 Use the switcher panel (see “Switcher Panel” on page 203)  

 Use the “MPEG Ingest” option (see “MPEG Ingest Option” on page 204) 

 Switcher Panel 

a. From the switcher panel on the bottom of the Control Panel window (see 

Illustration 119, Switch Control Panel for Internal Switcher, for an example), 

go to the “Rec/Prev” output row and click on the external input device or 

switcher resource that you would like to record.  If you connected a monitor 

to the “Preview” Output on the rear panel of the MINI-T-NX, the input’s 

programming will display on the monitor. 

b. Click the  button to begin recording. 

c. Once the file reaches the desired length, click the  button to stop the 

recording.   



MINI-T-NX 

Software Operation 

Page 204   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

 MPEG Ingest Option 

Use the MINI-T-NX MPEG ingest option to record playback from your switch 

resources or any of the external devices connected to your switcher inputs.  

This option also allows you to activate a selected external input device, enter an 

MPEG recorder activation delay, and set a record time length.  Perform the 

following steps: 

a. Click on the “MPEG Ingest” button on the MPEG recorder control panel to 

display the window shown in Illustration 135, “MPEG Ingest” Window. 

Illustration 135, “MPEG Ingest” Window 

 

b. From the “Input/Source” drop down list, select the external device or switch 

resource that you would like to record. 

c. TASCAM DVD players only: to cue a specific DVD title:chapter for 

playback, enter the desired title and chapter in the “Title:Chapter” field and 

then click the “CUE” button. 

d. If desired, set a delay time for the MPEG recorder from the “Recorder delay” 

field.  This is the time it will take before the recorder begins ingesting 

playback after both devices have been activated.  Once the recorder has 

been activated, WinLGX displays a countdown window that allows you to 

cancel the delay. 

e. If desired, enter a record time in the “Length” field.   The input device and 

MPEG recorder automatically stop at the end of the record time. 

f. Activate the source and MPEG recorder according to one of the following 

steps: 

 If you selected an external input device, either: 

 Click  to simultaneously activate both devices. 

OR 

 Click the  button to start playback of the source device and then 

the  button to activate the MPEG recorder. 

 If you selected a switch resource, just click the  button to activate 

the MPEG recorder. 
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g. If you did not enter a record time in the “Length” field, stop the input device 

or switch resource and MPEG recorder by performing one of the following 

steps: 

 If you selected an external input device, either: 

 Click  to simultaneously stop both the device and MPEG 

recorder. 

OR 

 Click the  button under “Input/Source” to stop playback of the 

source device and then the  button under “Destination” to stop 

the MPEG recorder. 

 If you selected a switch resource, just click the  button under 

“Destination” to stop the MPEG recorder. 

h. Click the “Close” button to exit the window. 

CONTROLLING EXTERNAL DEVICES 

IR or PRO-BUS-Controlled Devices (VCRs, DVD, ¾”, 8mm, Beta SP, and HI-8mm 

Players) 

When one of the above devices is selected in the control panel window’s “Device” list, the 

corresponding device control panel is displayed (see Illustration 136, Example of a PRO-

BUS-Controlled Device Control Panel).  

NOTE: Some interface commands trigger a control sequence unique to the device’s 

brand and/or model.  To determine the device-specific actions triggered by the 

control commands, consult the PRO-BUS interface manual for a PRO-BUS-

controlled device or Table 11, IR Port Configuration Options, for an IR-

controlled device.   

Illustration 136, Example of a PRO-BUS-Controlled Device Control Panel 

 

 Device properties: the left side of the panel displays the following: 

1. “Format”: type of device 

2. “Interface type”: device interface to which the device is connected 
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3. “Device”: the device interface number 

4. “Input”: if applicable, the switcher input number to which the device is 

connected   

 Playing a File 

To play a file, click the  button. 

 Recording a File 

To record a file, click the  button and then the  button. 

 Stopping a File 

To stop a file, click the  button. 

 Rewinding a File 

To rewind a file, click the  button.  

GPI Output Devices 

Select the GPI device icon in the “Device” list to display the corresponding control panel 

(see Illustration 137, Control Panel: GPI Device Control) and perform the following steps: 

Illustration 137, Control Panel: GPI Device Control   

 

 Device properties: the left side of the panel displays the following: 

1. “Format”: type of device 

2. “Interface type”: always a “PRO-BUS” device interface for GPI devices 

3. “Device”: device number given to the PRO-BUS address via switches on the 

PRO-BUS interface. 

 Control options: depending on how you configured your GPI PRO-BUS interface’s 

dip switches (refer to your PRGPI PRO-BUS Interface Manual for more details), 

the buttons on the right side of the panel will either: 
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1. Close the corresponding GPI output until a command is sent to close a different 

GPI output. 

Or 

2. Pulse the corresponding GPI output closed for 750 mS.  
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MANAGING DIGITAL FILE STORAGE 

Manage digital media for one or more LEIGHTRONIX digital servers/controllers with the 

WinLGX “Storage Manager” window.   This manual focuses specifically on using the 

Storage Manager to manage your MINI-T-NX MPEG videos and JPEG slides.  Just select 

the file type you want to manage and then add and delete the files to and from your PC 

and MINI-T-NX storage areas.   

GETTING STARTED 

1. Select “Storage Manager” from the “File” menu or click the  icon on the main 

toolbar to open the window shown in Illustration 138.   

Illustration 138, Storage Manager Window 

 

2. Select one of the following to display the corresponding file type: 

 “Video”: displays MPEG files only 

 “Slides”: displays JPEG slides only 
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3. The left side of the Storage Manager window allows you to access the storage areas 

on your MINI-T-NX and PC or network.  Select a storage area as follows: 

 “Local storage device”: select to access files stored on your PC or network.  

Navigate to and open the folder containing your videos or slides. 

 “Remote storage device”: select to access your MINI-T-NX storage areas.  

Select your MINI-T-NX from the “Controller” drop down menu.   

NOTE: If you selected the “Slide” file type, use the ”Folder” drop down menu to 

select the desired user folder. 

4. The right side of the Storage Manager window allows you to access your MINI-T-NX 

storage areas.  Select your MINI-T-NX from the “Controller” drop down menu.  

NOTE: If you selected the “Slide” file type, use the ”Folder” drop down menu to 

select the desired user folder. 

5. Perform any of the file management operations listed under the following sections: 

 “Managing Videos and Slides” on page 209 

 “Managing SLIDES: Uploading to the MINI-T-NX and Authorizing for Display,” on 

page 211 

When you are finished, click the “Close” button to exit the “Storage Manager” window. 

MANAGING VIDEOS AND SLIDES 

 Select multiple files 

 Right-click on a file and select “Select All” from the right-click menu. 

 Hold down “Shift” or “Ctrl” key and click on desired files. 

 Copy files from one storage area to another 

Double-click or right-click on the desired file(s) and select “Copy” from the right-click 

menu.  A dialog box appears (see Illustration 139, Storage Manager Copy Dialog Box) 

asking whether or not you would like the file copied to the file directory selected on the 

opposite side of the screen.  If you would also like a library resource created for the file, 

click the “Add to library” option. 

Illustration 139, Storage Manager Copy Dialog Box 

 

 Move file(s) from one storage directory to another 

Right-click on the desired file(s) and select “Move” from the right-click menu.  The file 

will be removed from its original location and transferred to the selected storage area.  

A dialog box appears asking whether or not you would like to move the file to the file 
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directory selected on the opposite side of the screen.  If you would also like a library 

resource created for the file, click the “Add to library” option. 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving 

a file fragment which should be deleted.  Cancel only when necessary.  

When multiple files are finished, a summary dialog appears giving the final 

results. 

 Delete files from your storage areas 

 Select desired file(s) and press the “Delete” key. 

 Right-click on the desired file(s) and select “Delete” from the right-click menu. 

 Rename files 

Right-click on desired file(s) and select “Rename” from the menu. Enter new volume 

name in the “Rename File” window. 

NOTE: The MINI-T-NX will not display files with filenames containing spaces. 

 Create library resources for your files 

Right-click on the desired file(s) on one of your remote storage devices and select “Add 

to library” from the right-click menu to display the “Add to library folder” Window shown 

in Illustration 134.  Select the library folder you want to contain the corresponding 

library resource(s) and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that 

possesses the same filename and length as a pre-

existing library resource. 

  If the new file possesses the same title as another 

resource, but has a different filename and/or length, 

WinLGX will copy the new file to the library with a 

numbered increment added to its title.  For example, if 

this is the first time you have reused the title of a pre-

existing library resource, WinLGX will add the new file to 

the library under the name “title01.” 

 Rename internal hard drive 

Right-click in either of the file display windows and select “Rename” from the right-click 

menu.  Enter the new volume name in the “Rename Volume” window. 

 Refresh file listing 

Click the “Refresh” button to update the files on the storage file manager window. 
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MANAGING SLIDES: UPLOADING TO THE MINI-T-NX AND AUTHORIZING FOR 

DISPLAY 

NOTE: For instructions on how to display your slide on-air, refer to the following 

sections: 

Scheduling 

 “Slide Library Resources” on page 176 

 “Slide Show Library Resources” on page 178 

Immediately Displaying Slides Using the Control Panel 

“JPEG Slides” on page 197 

 Preview your slides: single click on a slide to display it in the “Preview” window. 

 Upload slides onto your MINI-T-NX 

The MINI-T-NX can hold a total of up to 300 JPEG slides on its compact flash.  Up to 

32 different users with the appropriate user rights may upload slides into their own 

corresponding user folders on the MINI-T-NX and the “Public” folder.  The “Public” 

folder serves as a common storage area to which all users can add slides and cannot 

be scheduled.  

NOTE: JPEG slides created with any third-party graphic program may be uploaded 

to the MINI-T-NX.  To avoid distortion when displaying slides on television 

monitors, use resolutions of 720x540, 800x600, or 640x480.  Refer to “Slide 

File Specifications,” on page 22 for more information on creating slides for 

the MINI-T-NX. 

1. On the left side of the screen, select 

the “Local Storage Area” option and 

navigate to the folder containing the 

slide you want to upload. 

Illustration 140, Select Local Slide Storage 

Area 
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2. On the right side of the screen, select 

the user folder that you want to hold the 

new slide. 

Illustration 141, Select Slide User Folder 

 

3. Right click on the slide to select it and display the file management menu (see 

Illustration 142).  Select either “Move” to remove the file from its local storage area and 

transfer it to the selected user folder or “Copy” to create a duplicate of the slide in the 

selected user folder. 

Illustration 142, Transfer Slide to User Folder 

 
 

 Enable and authorize slides for display in slide shows 

Slides must be enabled and authorized before they will display in slides shows (see 

Illustration 143).  All users who have the right to upload slides can indicate their slides 

are appropriate for slide shows by checking the “Enable” box next to each slide in their 

user folders.  However, the “Authorize” box next to each slide must also be checked 

before it will display on-air in slide shows.  Only the “admin” user and users with the 

“Slide administrator” right can authorize slides in any user folder.  Slides uploaded by 
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users with the “Automatic slide authorization” right into their own user folders will be 

automatically approved for display.  Refer to “Setting User Account Rights (Including 

WinLGX Password Changes)” on page 61. 

Illustration 143, Slide Show Authorize and Enable Options 

 

 

 Create a Default Slide 

The default slide will display if a slide show is scheduled in a slide show without slides 

or without approved slides. 

1. The “admin” user must upload the slide into his “admin” user account folder (see 

the “Upload slides onto your MINI-T-NX” on page 211). 

2. Right-click on the file and select “Rename” from the menu.  Change the slide 

filename to “Default.jpg.” 

3. Enable and approve the slide for display (see the “Enable and authorize slides for 

display in slide shows” section on page 213). 
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RETRIEVING LOG FILES 

Each MINI-T-NX Controller keeps track of everything done to or by it in internal log files.  

The MINI-T-NX log files cannot be deleted, written to, or manipulated by a user in any 

way; however, once downloaded, you can then save, write, and format the file just like any 

other text document. 

WinLGX allows you to access the MINI-T-NX log files with the “Get log” menu item under 

the “File” menu or  icon on the main toolbar.  Selecting one of these options will display 

the "Select Controller Log File" Window shown in Illustration 144.   

Illustration 144, "Select Controller Log File" Window 

 

At the top of the “Select Controller Log File” window, you will see three different tabs for 

accessing the MINI-T-NX log files.  Access the MINI-T-NX event, system, and firmware 

log files as follows: 

Event Log Files 

Especially useful for tracking playback events, the MINI-T-NX logs its event execution 

status into a .CSV file spreadsheet on a monthly basis (see Illustration 145).  The 

execution results for each event are logged under the spreadsheet’s “Result” column, with 

“Ok” indicating the event was successfully executed and “Exception” meaning the event 

was not executed.  For those events with the “Exception” status, refer to the “Report” 

column on the spreadsheet for more information about why the event did not occur.  Also 

Log File Tabs 
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logged are each event’s date and time of excecution, format type, device type, and other 

major event descriptors. 

Illustration 145, Example of Event Log File 

 

To access event log files, perform the following steps: 

1. Click on the “As played” tab on the “Select Controller Log File” window.   

2. Single click on the desired .CSV file to select it and then click “OK.”   

3. A “Save as Played log File” window will open.  Save the .CSV file to a new file path or 

use the WinLGX default log file path (Shared 

Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).   

4. Click the “Save” button to save the file to your chosen file path.  The “Save as Played 

log File” and “Select Controller Log File” windows will close.   

5. Navigate to the file path for the saved .CSV file and open it in Excel. 

 

System Log Files 

The MINI-T-NX system activity log files are called “EVENTS.LOG” and 

“OLDEVNTS.LOG.”  When a new MINI-T-NX is powered on for the first time, it creates a 

file called “EVENTS.LOG.”  The MINI-T-NX will continually write to this file until it reaches 

7 MB.  Once “EVENTS.LOG” reaches 7 MB, the MINI-T-NX will rename it to 

“OLDEVNTS.LOG” (deleting the previous “OLDEVNTS.LOG”) and then create a new 

“EVENTS.LOG.”  This ongoing cycle ensures that recent events are always logged.  
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The MINI-T-NX system log files are useful in identifying specific events within the system, 

such as when a particular program aired, when a user logged in from a remote terminal, 

and more.  To view a system log file, perform the following steps: 

1. Click on the “System” tab on the “Select Controller Log File” window (see Illustration 

146, “System” Tab on the “Select Controller Log File” Window).  

Illustration 146, “System” Tab on the “Select Controller Log File” Window 

 

2. Select one of the log files from the listing and then download log records based on the 

following filter options: 

 “Date/Time filter”: check box to enable the date/time fields 

 Within a range of dates and times: use the start/end date and start/end time 

fields to download all log records within the selected dates and times  

 No filter: click the “Raw data (no filter)” button to download all log records  

 MPEG playback events of low severity: click the “MPEG Play” filter preset 

button to download all noncritical log records containing the text “MPEG Play” in 

their action descriptions 

 Severity of event action: download all log records with the event severity code 

selected with the “Severity filter” drop down menu 
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 Group action type: download all log records with the group action type 

selected with the “Group filter” drop down menu 

 Action descriptions: download all log records with action descriptions 

containing one of the text options selected with the drop down menu under “Text 

filter.”  To create your own action description filter, select “User text” from the 

drop down menu and type in the desired keyword in the “User text” comment 

field. 

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired location, 

the log is displayed in a text editor of your choosing (see Illustration 147).  This will 

also turn off the log LED  that appears on the MINI-T-NX front panel when a 

severity 1 or 2 event action is logged. 

NOTE: The default viewer is Notepad, but the viewer can be changed from the 

“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 

WinLGX Viewing and Communication Preferences,” beginning on page 75).  

Illustration 147, Example of Log File 

 

Each action performed through or by the MINI-T-NX is recorded in the log file along with 

its date and time, severity, and action type.  The following information identifies and 

explains each part of the “EVENTS.LOG” file in more detail. 
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 Date 

 Time 

 Severity of event action—event actions are classified according to the following 

three levels of severity: 

 0: events that occur during the course of normal operations 

 1: warning events 

 2: critical events or failures 

 Types of actions recorded: 

 Deck: actions based on PRO-BUS and IR interface functions 

 Diagnostic: MINI-T-NX health and status  

 File: actions involving files, typically file transfers (also MINI-T-NX image 

send/retrieve)  

 Front Panel: actions performed based on commands given by user through the 

front panel of the MINI-T-NX 

 MPEG: MPEG player/recorder actions 

 Remote: actions performed based on commands given by user from the 

WinLGX control panel 

 Schedule: actions performed based on user-created schedule  

 Switcher: actions based on switcher events and functions 

 USB drive: actions pertaining to the internal USB hard drive 

 Descriptive message of actions performed 
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FIRMWARE/SOFTWARE UPDATES 

LEIGHTRONIX emails all firmware/software update links unless otherwise requested.  

Save the update files to an accessible directory on your PC. 

UPDATING MINI-T-NX CONTROLLER FIRMWARE 

1. Open the WinLGX software and log in to your MINI-T-NX (see “Opening and Logging 

into WinLGX” on page 130). 

2. Log in to the MINI-T-NX and choose “Controller” under the “Tools” menu to open the 

“Controller” window shown in Illustration 148. 

Illustration 148, Controller Window 
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3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” 

window shown in Illustration 149.   

Illustration 149, “Choose Controller Firmware File” Window  
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4. Navigate to and open the .fmw update file for your MINI-T-NX Controller’s firmware.  

Once you have selected and opened the file, the firmware version and file size will be 

entered into the “Controller” window (see Illustration 150). 

Illustration 150, “Controller” Window with Selected MINI-T-NX Firmware File 

 

5. Click “Update” to start the firmware update.  Click “Yes” when prompted to start the 

update. 

6. Once the update has completed, click “OK” to apply the changes and reboot the MINI-

T-NX.  You will be logged out and the “Site Manager” window will be displayed. 

NOTE: You will not be able to log back in until the MINI-T-NX finishes 

rebooting.   

7. After the MINI-T-NX finishes rebooting, log back in and confirm MINI-T-NX has been 

upgraded to the latest firmware version in the “Site Manager” database.   

UPDATING WINLGX SOFTWARE 

1. Close WinLGX. 

2. Navigate to and open the WinLGX installer file.  Follow the prompts to install the latest 

version of the client software.  
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3. Click “OK” to continue WinLGX update. 

4. Follow the prompts to complete the installation. 
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TROUBLESHOOTING 

Always ensure the MINI-T-NX system physical connections (power cable, video/audio 

cables, PRO-BUS, and Ethernet cables) are secure. 

PARTS REPLACEMENT 

Due to the placement and sensitivity of components inside the MINI-T-NX, the unit does 

not contain any user-serviceable parts.   

The MINI-T-NX must be sent back to the factory if battery replacement is necessary.  

Whenever the MINI-T-NX is unplugged, its backup battery automatically provides standby 

power to the unit.  Leaving the MINI-T-NX unplugged for extended periods of time will 

drain its backup battery. 

 

CONTACTING LEIGHTRONIX TECHNICAL SUPPORT 

If you are experiencing a problem that you are unable to resolve, you may: 

Visit our Web site: www.leightronix.com 

E-mail us at: support@leightronix.com 

Call us at: 

(800) 243-5589 

(517) 694-1600 Fax 

Our technical support phone lines are open Monday through Friday, excluding holidays, 

from 8:30AM – 5:30PM, Eastern Standard Time (EST). 

When you report a problem, please provide the following information: 

 Your name, and your company name, address, and phone number 

 Model number 

 Serial number 

 Software version 

 Firmware version 

 Description of the problem 

 Status of the unit when the problem occurred (please try to include information on user 

and network activity at the time of the problem) 
 

Please contact the LEIGHTRONIX Technical Support Department at the number below 

for an RMA (Return Material Authorization) number before sending an item in for repair. 

LEIGHTRONIX, INC. 

2330 Jarco Drive 

Holt, MI  48842 

Phone:  (800) 243-5589 

Fax:  (517) 694-1600 

http://www.leightronix/
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WARRANTY 

LEIGHTRONIX, INC. warrants this MINI-T-NX Controller against defective workmanship 

or materials for a period of five (5) years from the original date of purchase. 

During this warranty period, any parts found to be defective will be replaced at no charge.  

Labor to repair or replace defective parts will also be performed at no charge during the 

warranty period. 

This warranty does not cover abuse, shipping damage, neglect, tampering by 

unauthorized personnel, acts of God, damage inadvertently caused by the user, preventive 

maintenance, or any product whose serial number is removed or defaced. 

The sole responsibility of LEIGHTRONIX shall be to repair or replace in accordance with 

this warranty.  The seller’s and manufacturer’s only obligation shall be to repair or replace 

such quantity of the product proved to be defective. 

The customer shall bear the cost of shipping products returned to LEIGHTRONIX for 

warranty repair.  The cost for return shipment to the customer will be assumed by 

LEIGHTRONIX and shipped via an equal priority service shipper prepaid and insured. 

Neither seller nor manufacturer shall be liable for any injury, loss or damage, direct or 

consequential, arising out of the use of, or the inability to use the product.  Before using, 

the user shall determine the suitability of the product for his/her intended use, and user 

assumes all risk and liability whatsoever in connection therewith. 

The warranty and the obligations and liabilities thereunder shall replace all other 

warranties or guarantees, express or implied.
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DECLARATION OF STANDARDS CONFORMITY 

FCC NOTICE 

NOTE:   This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to part 15 of the FCC Rules.  These 

limits are designed to provide reasonable protection against harmful 

interference when the equipment is operated in a commercial 

environment.  This equipment generates, uses, and can radiate radio 

frequency energy and, if not installed and used in accordance with the 

instruction manual, may cause harmful interference to radio 

communications.  Operation of this equipment in a residential area is 

likely to cause harmful interference in which case the user will be 

required to correct the interference at his own expense. 

 

CAUTION 

Changes or modifications to this device not expressly approved by 

LEIGHTRONIX, INC. could void the user’s authority to operate this 

device. 

This equipment is intended to be installed in a controlled environment with restricted 

access. 
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APPENDIX A: TOTAL BACKUP 

With Total Backup, you can ensure that your MPEG videos, slides, and critical MINI-T-NX 

system information are automatically protected against loss.  Perform immediate or 

scheduled backups of the MINI-T-NX “Internal” storage area to save copies of your MPEG 

videos, slides, and current schedule and the internal “System” storage area to preserve 

your network configuration settings (IP address), usernames and passwords, and the 

front panel password.  Storage information may be copied on a PC, network, or hard drive 

connected to your PC.   

Restoring your MINI-T-NX storage areas is just as easy.  Total Backup lets you instantly 

download saved backup information to the MINI-T-NX in just a few mouse clicks. 

OPENING & LOGGING INTO TOTAL BACKUP 

1. Select “Preferences” under the “Tools” menu to open the “Preferences” window.  

Ensure the file path under “Total Backup application folder” matches the location 

where the Total Backup program is installed on your computer or network (see 

Illustration 151) and then click “OK” to close window. 

Illustration 151, File Path Field for MINI-T-NX Total Backup 

 

2. Open the Total Backup program using one of the following methods:     
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 Double click the Total Backup desktop icon.  This method automatically displays 

the NEXUS settings for Total Backup.  To display the MINI-T-NX settings and log 

into your controller, perform the steps in the note below. 

 From WinLGX, select “Total Backup” from the “Tools” menu or click the  icon 

on the toolbar.  Total Backup will automatically log into your current MINI-T-NX 

controller connection and display the “MINI-T-NX Total Backup” Window shown in 

Illustration 152. 

Illustration 152, “MINI-T-NX Total Backup” Window 

 

NOTE: To log in or change the Total Backup controller connection, click the “Login” 

button to display the “Login” window.  Enter the following information and 

then click “OK” to log in or “Cancel” to abort. 

 “IP Address”: IP address of the controller you want to backup or restore 

 “User”: username for the entered IP address 

 “Password”: corresponding password for the entered IP address 

SELECTING STORAGE LOCATIONS FOR MINI-T-NX INFORMATION 

Next, specify where you would like to create fully redundant copies of your MINI-T-NX 

internal storage areas by performing the following steps: 

1. From the “Total Backup” window, select “Local Path Settings” from the “File” menu to 

display the backup path window shown in Illustration 153.   
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Illustration 153, Backup Path Window 

 

2. Save your MINI-T-NX data to one or more of the following locations: 

 One Storage Location: click the top radio button.  Browse to a local or network 

storage area in the “Browse for Folder” window and click “OK.”  

 Multiple Storage Locations: click the bottom radio button and make the following 

selections:  

 “System” information: select a storage location for your system information, 

including network configuration settings (IP address), usernames and 

passwords, and the front panel password.  Click the “Browse” button to 

display the “Browse for Folder” window.  Navigate to a local or network 

storage area and click “OK.” 

 “Internal” information: select a storage location for your MPEG videos, 

slides, and the current schedule on your MINI-T-NX.  Click the “Browse” 

button to display the “Browse for Folder” window.  Navigate to a local or 

network storage area and click “OK.” 

3. Click “OK” to save storage path settings and close the “Settings” window. 

4. Perform one of the following: 

 Immediately perform file backup: perform steps under “Performing an Immediate 

Backup,” on page 229 

 Schedule automatic file backups: perform steps under “Performing Scheduled 

Backups,” on page 229 

 Restore MINI-T-NX storage areas: perform steps under “Restoring MINI-T-NX 

Information,” on page 230 
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PERFORMING AN IMMEDIATE BACKUP 

Total Backup uses your “Local Path Settings” to determine where to save the backup 

information for the selected MINI-T-NX storage areas. 

1. On the “MINI-T-NX Total Backup” window, check the boxes next to the MINI-T-NX 

storage areas you would like backed up.   

2. Click the “Backup” button to start an immediate backup.  Click the “Stop” button to halt 

a backup before it finishes.  To restart, click the “Backup” button again.  The backup 

will resume from where it left off. 

PERFORMING SCHEDULED BACKUPS 

Total Backup uses your “Local Path Settings” to determine where to save the backup 

information for the selected MINI-T-NX storage areas. 

You must leave the Total Backup software running in order for a scheduled 

backup to occur.  Total Backup will run as a background task without interfering 

with other programs open on your computer. 

1. Click the “Modify” button or “Scheduler Settings” under the “File” menu to open the 

“Backup Scheduler” Window shown in Illustration 154. 

Illustration 154, “Backup Scheduler” Window 

 

2. Using the date and time drop down boxes, specify how often you would like the backup 

to occur. 

3. Check boxes next to the MINI-T-NX storage areas you would like backed up. 



MINI-T-NX 

Appendix A 

Page 230   LEIGHTRONIX, INC. 

WinLGX ver. 6.0.1.48  2018-06-08 
 

4. Click “OK” to make backup schedule changes or “Cancel” to abort. 

RESTORING MINI-T-NX INFORMATION 

Total Backup uses your “Local Path Settings” to find the backup information for the MINI-

T-NX storage areas you wish to restore. 

1. On the “MINI-T-NX Total Backup” window, click the “Restore” button to open the 

“Restore” Window shown in Illustration 155. 

Illustration 155, “Restore” Window 

 

2. Check the “Unit Settings” box if you would like to restore network configuration 

settings, usernames and passwords, and front panel password. 

3. Check boxes next to the MINI-T-NX storage areas you would like to restore with the 

last saved backup information. 

4. Select “Overwrite existing files?” to replace existing files that have the same name as 

the backup files. 

5. Click “OK” to restore files or “Cancel” to abort.
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APPENDIX B: TOTAL IMPORT  

In a few steps, Total Import allows you to create MINI-T-NX-compatible, high quality digital 

video files from non-encrypted MPEG-1 and MPEG-2 DVDs.  Just insert a DVD into your 

PC’s disc drive and specify where on your PC or network you would like to save the digital 

video files.  You may also customize the files for your video system by changing the Total 

Import encoding settings and filename assignments. 

Each title on a DVD is segmented into one or more ½ hour MPEG-1 or 2 video and audio 

files.  Total Import saves the files within the selected DVD title on your PC or network and 

then converts the files into one industry standard MPEG-2 file with layer 2 audio.  Once 

converted, simply use the Storage Manager in the LEIGHTRONIX management software, 

WinLGX, to transfer the MPEG file from your PC to the internal hard drives in your MINI-

T-NX. 

 

1. Double click on the Total Import desktop icon to display the Total Import program 

window (see Illustration 156, Total Import Main Window). 

Illustration 156, Total Import Main Window 
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2. Insert a DVD into your PC’s DVD drive.  Load the DVD titles (files) into the “Source” 

panel on the Total Import window according to the following steps (see Illustration 

157): 

Illustration 157, Total Import DVD “Source” Panel 

 

a. Click the “Browse” button.  In the “Browse for folder” window that appears, navigate 

to your local DVD drive and select the DVD drive letter.  Click “OK” to display a list 

of your DVD’s titles on the “Source” panel. 

b. Select each DVD title you would like to import by checking the boxes to the left of 

the titles.  A selected title will have a green checkmark in its box.   

3. In the “Settings” panel, perform the following (see Illustration 158): 

 Select the target audio bit rate that will be used to encode the DVD audio files into 

Audio layer II.  

 Uncheck the “Stream copy video” option to reveal the “Target Video Bitrate” field.  

Set the video bit rate to no higher than 5.0 Mbps for optimal playback on your MINI-

T’s internal MPEG player. 

Illustration 158, Total Import "Settings" Panel with Selectable Video Bit Rate 
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4. Under “Destination,” specify where on your PC you would like your newly encoded 

MPEG file(s) saved (see Illustration 159).  Total Import will create a separate MPEG 

file for each DVD title within the specified storage area.   

Illustration 159, Total Import "Destination" Panel 

 

a. Click the “Browse” button and in the “Browse for folder” window that appears, 

navigate to a storage area on your PC large enough to hold the MPEG files.  The 

Total Import encoding process will create MPEG files that are larger than the 

original DVD titles. 

b. Use the “Temporary Storage” field’s “Browse” button to specify where on your PC 

you would like Total Import to store the imported DVD titles.  Total Import 

automatically deletes the imported titles once they are converted into an MPEG-2 

file.   

c. Assign filenames with either the “Filename” or “Filename Prefix” field as follows: 

NOTE: The MINI-T-NX does not recognize filenames with spaces. 

 “Filename”:  this field becomes available if you are only converting one title.  

Enter up to 27 characters, no spaces, in the field.  Total Import will 

automatically add “.mpg” to the filename.  

 “Filename Prefix”:  if you are converting more than one title, the “Filename” field 

is disabled and the “Filename Prefix” field becomes available.  Enter up to 17 

characters, no spaces, in the field and your entry will be added before each 

converted DVD title’s job ID and title numbers (for example, “promotional_video-

DVD000-01.mpg”). 

d. Check the “Overwrite” box if you want to save the file over an existing file with the 

same name. 

5. Click the “Start” button to import and encode the DVD titles.  The percentage of the job 

completed will be displayed in the “Source” panel next to the “Start” and “Stop” 

buttons.  Click “Stop” if you need to prematurely end the job.  Any of the job’s DVD 

titles not fully encoded will need to be reimported and encoded from the beginning. 

6. Once you have finished importing and encoding your DVD titles through Total Import, 

use the Storage Manager in WinLGX to transfer the new MPEG files to your MINI-T-

NX’s internal hard drive.  See “Managing Digital File Storage,” on page 208, for 

instructions.
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APPENDIX C: PRO-BUS INTERFACE CONNECTIONS 

Each MINI-T-NX comes equipped with a LEIGHTRONIX PRO-BUS control port.  By 

connecting addressable PRO-BUS interfaces to your MINI-T-NX, you can use pre-

programming or immediate remote control to operate up to 8 of your devices (play, rewind, 

record, and stop).     

PRO-BUS interfaces use standard phone cables with RJ-11 connectors that loop 

between each interface.  The MINI-T-NX provides both control signals and power to your 

devices through PRO-BUS interfaces.  Connect your PRO-BUS interfaces as follows 

(refer to Illustration 160, PRO-BUS Interface): 

Illustration 160, PRO-BUS Interface 

 

SET SWITCHES 

ASSIGN INTERFACE AN ADDRESS 

Each PRO-BUS interface relays the LEIGHTRONIX Controller commands issued to its 

address number.  The interface’s activity LED toggles from its previous state (ON or OFF) 

when the interface receives a command.  To assign your interface an address, set 

Switches 1–4 (see Illustration 160, PRO-BUS Interface) according to Table 37, PRO-BUS 

Address Configuration.  For organizational purposes, please: 

 Assign your interfaces consecutive address numbers, starting with “01” at the 

Controller. 

 If possible, match each device’s interface address to its switcher input number. 

 Label devices and interfaces with their address and input numbers. 

 Document your entire PRO-BUS interface/device/switcher setup. 

Table 37, PRO-BUS Address Configuration 

DEVICE 01 DEVICE 02 DEVICE 03 DEVICE 04 

DEVICE 05 DEVICE 06 DEVICE 07 DEVICE 08 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 

DIP Switches 
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CONFIGURE INTERFACE TO SEND CONTROL COMMANDS 

When an interface receives a PRO-BUS command, it checks the settings of Switches 5–

8 and emits the corresponding command(s). The emitted command(s) will change the 

device from its initial, operational mode to a new mode.  The settings for Switches 5–8 

vary depending on the PRO-BUS interface model, so refer to the corresponding PRO-

BUS manual for more information. 

ATTACH PRO-BUS TO CORRESPONDING DEVICE 

LEIGHTRONIX PRO-BUS interfaces are sold separately for many brands and models of 

professional video equipment and are available with infrared, mini-jack, and multi-pin 

connectors. Refer to your PRO-BUS interface’s manual for more information on 

connecting the interface to a device. 

CONNECT PRO-BUS TO CONTROLLER AND OTHER PRO-BUS 

INTERFACES 

Starting from the PRO-BUS port on your LEIGHTRONIX Controller, daisy-chain the 

provided RJ-11 cables between interfaces as shown in Illustration 161, PRO-BUS Daisy 

Chain, observing the “IN” and “OUT” labels on the interfaces.  These labels indicate the 

signal path from the Controller.  Do not loop the last interface back to the Controller!  

It should have an OPEN “OUT” connector.   

 

CAUTION 

Interfaces will not work and equipment may be damaged if the “IN” and 

“OUT” labels are not observed! 

Illustration 161, PRO-BUS Daisy Chain 
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APPENDIX D: COPYRIGHT STATEMENTS 

The MINI-T-NX firmware contains portions of the following software. 

WHITSOFT SLIMFTPD 

Portions of the LEIGHTRONIX FTP Server are derived from WhitSoft SlimFTPd. 

 

Copyright (c) 2006, Matt Whitlock and WhitSoft Development 

All rights reserved. 

 

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

 

  * Redistributions of source code must retain the above copyright notice, 

    this list of conditions and the following disclaimer. 

  * Redistributions in binary form must reproduce the above copyright notice, 

    this list of conditions and the following disclaimer in the documentation 

    and/or other materials provided with the distribution. 

  * Neither the names of Matt Whitlock and WhitSoft Development nor the names 

    of their contributors may be used to endorse or promote products derived 

    from this software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 

CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 

LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 

USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 

AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 

ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE. 

THE PHP LICENSE, VERSION 3.0 

Copyright © 1999–2002 The PHP Group. All rights reserved. 

--------------------------------------------------------------------  

Redistribution and use in source and binary forms, with or without modification, is 

permitted provided that the following conditions are met: 
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1. Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3. The name “PHP” must not be used to endorse or promote products derived from this 

software without prior written permission. For written permission, please contact 

group@php.net. 

4. Products derived from this software may not be called “PHP”, nor may “PHP” appear 

in their name, without prior written permission from group@php.net.  You may indicate 

that your software works in conjunction with PHP by saying “Foo for PHP” instead of 

calling it “PHP Foo” or “phpfoo” 

5. The PHP Group may publish revised and/or new versions of the license from time to 

time. Each version will be given a distinguishing version number.  Once covered code 

has been published under a particular version of the license, you may always continue 

to use it under the terms of that version. You may also choose to use such covered 

code under the terms of any subsequent version of the license published by the PHP 

Group. No one other than the PHP Group has the right to modify the terms applicable 

to covered code created under this License. 

6. Redistributions of any form whatsoever must retain the following acknowledgment: 

“This product includes PHP, freely available from <http://www.php.net/>”. 

 

THIS SOFTWARE IS PROVIDED BY THE PHP DEVELOPMENT TEAM ``AS IS’’ AND 

ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 

TO,THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

PHPDEVELOPMENT TEAM OR ITS CONTRIBUTORS BE LIABLE FOR ANY 

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 

DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 

GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of 

the PHP Group. 

The PHP Group can be contacted via Email at group@php.net. 

For more information on the PHP Group and the PHP project, please see 

<http://www.php.net>. 

This product includes the Zend Engine, freely available at <http://www.zend.com>. 
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GD STATEMENT  

 Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 

2004 by Cold Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the 

National Institutes of Health. 

 Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 

Boutell.Com, Inc. 

 Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip 

Warner. 

 Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg Roelofs. 

 Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John Ellson 

(ellson@graphviz.org). 

 Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson 

(ellson@graphviz.org). 

 Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 2003, 

2004, Doug Becker and copyright © 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 

2002, 2003, 2004 Thomas G. Lane. This software is based in part on the work of the 

Independent JPEG Group. See the file README-JPEG.TXT for more information. 

 Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David 

Rowley, with modifications for thread safety by Thomas Boutell. 

 Portions relating to GIF decompression copyright 1990, 1991, 1993 by David Koblas, 

with modifications for thread safety by Thomas Boutell. 

 Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo 

and Johan Van den Brande. 

 Portions relating to GIF animations copyright 2004 Jaakko Hyvätti 

(jaakko.hyvatti@iki.fi) 

IJPEG STATEMENT 

 “this software is based in part on the work of the Independent JPEG Group” 

FREETYPE STATEMENT 

“Portions of this software are copyright © 1996-2002 The FreeType Project 

(www.freetype.org).  All rights reserved.” 

mailto:jaakko.hyvatti@iki
http://www.freetype/
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GLOSSARY 

The following terms are used throughout this manual. 

TERM DEFINITION 

Baud Rate Controller’s data transmission rate in bits per second  

Bit Rate Bit rate is the speed at which pieces of information are 

transmitted. A bit is the single smallest piece of information 

that is transmitted, and the speed is expressed as the 

number of bits that are transmitted per second.  

BNC Type of connector used with coaxial cables 

CBR Constant Bit Rate; the MINI-T-NX CBR recording preset 

option ensures the internal MPEG recorder records a 

program at the user-defined video bit rate. This option 

works best for video with little motion and allows you to 

reliably predict the record time of a video file. 

Character Generator Electronic device which produces graphics and characters 

for creating video titles 

Client (software) Software program that is used to contact and obtain data 

from a server software program on another computer 

Controller Provides unattended, automatic control over a wide variety 

of video devices including digital video servers, digital disc 

recorders, DVD players, video/audio routing switchers, 

VCRs, and the like 

Cross-Over Cable A twisted pair patch cable wired to route the transmit 

signals from one piece of equipment to the receive signals 

of another piece of equipment, and vice versa. 

Decoder A software program and/or hardware device that converts a 

signal back into its original format 

Destination Output 

Device Any source (input) controlled by a PRO-BUS, IR, DVply, or 

switch interface; also referred to as “deck” 

Direct Connect Non-network connection 

DHCP Dynamic Host Configuration Protocol; protocol that 

automatically assigns IP addresses to devices as they are 

attached to a network 

DTE Data Terminating Equipment; refers to a communications 

device that is the source or destination of network signals 
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TERM DEFINITION 

Encoder A software program and/or hardware device that converts a 

signal back into a coded format 

Ethernet Method of networking computers in a local area network 

(LAN) 

Event Control element that holds information about “what” is 

supposed to happen and “when” 

Event Action Any switch or device function 

Fallback Input If valid video is lost on an output, the selected fallback input 

will be switched to the output  

FAT File Allocation Table; part of a hard disk where data is 

stored 

Firmware Software contained in a hardware device 

FPTV Full-power television 

Gateway Address IP address of computer or router that transfers 

communications from the local network to the broader 

network 

GPI General Purpose Interface 

Host IP-capable machine connected to an IP network 

Image File See MINI-T-NX Image File 

Immediate (control) Control of MINI-T-NX through front panel 

IP Address Internet Protocol; 4-byte address used to identify devices on 

a network 

IRD Integrated Receiver Decoder 

JPEG file Graphic file that may be used to create slides and slide 

shows.  Use the stock JPEG images included with the 

MINI-T-NX and add messages with the text editor or upload 

any JPEG files you have created with third-party software.   

LAN Local Area Network; computer network that covers a 

relatively small area (single building) 

LED Light-emitting diode 

Library Resource Contains the event actions of a frequently scheduled device 

medium.  Each library resource contains event actions for a 

specific MPEG video, slide, tape, disc, or switch action. 

Locked Event An event with an editable, fixed time entered by the user 
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TERM DEFINITION 

Log File List of MINI-T-NX actions and alarms 

LPTV Low-power television 

MATV Master-antenna television 

Mb/s Megabytes per second 

MPEG Moving Pictures Expert Group; standards for compressing 

digital video and audio data 

Network A group of connected computers that can communicate 

with one another. Networks enable computers to share files 

and resources and exchange messages. 

MINI-T-NX Image File Contains system, device, and library properties and may 

contain a schedule of events 

NIC Network Interface Card; Ethernet card used to connect to a 

network 

OS Operating System 

PC Personal Computer 

Preroll Amount of time Controller waits before switching device on-

air (prevents the transmittal of black video or static found at 

beginning of a program) 

PRO-BUS Interfaces used to connect VCRs/DVD players to an 

Controller 

RCA Plug and jack connector for a two-wire coaxial cable 

Remote (control) Control of Controller through WinLGX 

Reset Time Time the device is unavailable for scheduling after the end 

of the event, usually due to “Rewind” time. 

Setup Time Amount of time device needs to prepare for playback; 

begins when device receives a playback command and 

ends at the first sign of video 

Slide JPEG file 

SMTP Simple Mail Transfer Protocol; protocol used to transfer 

email between or among servers 

Source Input (video and/or audio) 

Subnet Mask Separates IP address into network address and host 

address as assigned within the network 

Switchback Input Once the scheduled event time ends, the selected 
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TERM DEFINITION 

switchback input will be switched to the event’s schedule 

tab output 

TCP/IP Transmission Control Protocol/Internet Protocol 

Unlocked Event An event whose start time is assigned by WinLGX to 

coincide with the ending time of the event above it.  This 

time is not fixed and will be adjusted by WinLGX if events 

above it are inserted, deleted, moved, or modified. 

VBR Variable Bit Rate; the MINI-T-NX VBR recording preset 

option allows the internal MPEG recorder to automatically 

adjust the record rate of a program between the user-

defined minimum and maximum video bit rates. This option 

ensures that the MPEG recorder captures the more detailed 

portions of the program (particularly important for motion-

intensive video). 

VFD Vacuum Fluorescent Display 

Video MPEG file 
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ETHERNET 
Connecting directly to a PC via 
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FALLBACK SETTING .............................. 86 

FCC NOTICE ...................................... 223 

FORCING A SWITCH ............................. 191 

FRONT PANEL 
Display............................................. 27 

Keypad ............................................ 27 

LEDs ............................................... 30 

Password, changing ........................ 65 

Password, entering ......................... 39 

IMAGE FILES 
Creating ........................................... 51 

Opening ......................................... 135 

Saving ........................................... 138 

Sending to MINI-T-NX ................... 189 

INSERTING LIBRARY RESOURCE EVENTS 153 

INSTALLATION CHECKLIST ..................... 12 

IR PORTS 
Configuration options ....................... 87 

Connections..................................... 35 

Control options........................... 19, 31 

Immediate control .......................... 203 

Scheduling devices ................ 154, 156 

Scheduling media .......................... 170 

LIBRARY EVENT PROPERTIES ............... 170 

LOG FILES 
Downloading from MINI-T-NX ....... 212 

Viewer .............................................. 77 

MPEG CLIP ....................................... 197 

MPEG FILE SPECIFICATIONS ................ 23 

MPEG FILES 
Filename conventions ...................... 26 

Supported file sizes from third-party 

sources ............................................ 26 

Supported resolutions ...................... 26 

MPEG PLAYER CONTROL PANEL ........ 192 

MPEG RECORDER 
Control panel ................................. 199 

Ingest function ............................... 202 

PREFERENCES WINDOW ........................ 75 

PREVIEW OUTPUT 
Displaying Programming on a Monitor

 ............................................... 192, 201 

Rear panel ports .............................. 31 

Specifications................................... 18 

PRINTING MINI-T-NX SCHEDULES 
Page layouts .................................... 70 

Print templates ................................. 68 

Printer and paper settings ............... 71 

Printing ........................................... 131 

PRO-BUS 
Connections............................. 35, 232 

Control options................................. 19 
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Scheduling devices................ 154, 156 

Scheduling media .......................... 170 

REAR PANEL......................................... 31 

REBOOTING MINI-T-NX FROM WINLGX 67 

REPLACING LIBRARY RESOURCE EVENTS

....................................................... 150 

SAFETY INSTRUCTIONS .......................... 16 

SCHEDULE COLUMN HEADINGS .............. 72 

SLIDE FILE SPECIFICATIONS .................. 22 

SLIDES 
Approving for slide show displays . 210 

Default slide ................................... 211 

Filename conventions ...................... 22 

Individual default display length ....... 76 

Previewing from WinLGX .............. 209 

Recommended resolutions .............. 22 

Uploading to the MINI-T-NX .......... 209 

STORAGE MANAGER ........................... 206 
Copying videos and slides ............. 207 

Deleting videos and slides ............. 208 

Moving videos and slides .............. 207 

Renaming videos and slides .......... 208 

SWITCHBACK INPUT ............................ 144 

SWITCHER CONFIGURATION ................... 84 

TCP/IP ADDRESSES 
Gateway address ............................ 41 

IP address ....................................... 40 

Subnet mask .................................... 40 
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Restore files ................................... 228 

Scheduled backup ......................... 227 

TOTAL IMPORT .................................... 229 
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USER-DEFINED DATA DIALOG BOX ......... 72 

WARNING .............................................. 16 
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WINLGX 
FACTORY-DEFAULT USERNAME AND 

PASSWORD .......................... 47, 50, 129 
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and schedule columns ..................... 57 

Installation ........................................ 44 

Main window components ............... 52 

Moving windows .............................. 59 
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headings .......................................... 59 
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	1. Read these instructions.
	2. Keep these instructions.
	3. Heed all warnings.
	4. Follow all instructions.
	5. Do not use this apparatus near water.
	6. Clean only with dry cloth.
	7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
	8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
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	14. When the apparatus is turned off, certain components in the power supply and system board remain energized. In order to remove all electrical power from the apparatus, unplug the power cord from the MAINS socket outlet.

	MINI-T-NX Controller Features/Specifications
	Control Features
	Limits on Control of DVD Players
	Automatic Power Saving Features
	Playback of Commercial Movies
	Playback of Your Own DVDs
	DVD Player/Recorder Control Methods
	Supported DVD Players and Recorders

	Slide File Specifications
	MPEG File Specifications
	MINI-T-NX MPEG Recorder Option Specifications
	Encoding a Background Audio File
	Creating MPEG Files with Non-LEIGHTRONIX Sources

	MINI-T-NX Front Panel
	Keypad
	Display
	LEDs

	MINI-T-NX Rear Panel

	Controller Installation & Configuration
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	Packing List
	MINI-T-NX Installation Overview
	Connecting Signal Wiring
	1. Rack mount your MINI-T-NX as follows, ensuring that the ventilation holes on the side of the unit are not covered.
	a. Insert the MINI-T-NX into the rack, aligning the holes of the Controller’s mounting bracket with those of the rack.
	b. Secure the MINI-T-NX to the rack with user-supplied rack screws.

	2. Route the video/audio from your VCRs, DVD players, studio/satellite feeds, character generator, etc. to the switcher video/audio inputs.
	3. Connect switcher video/audio Output 1 to the desired destination, such as a modulator.
	4. If desired, attach a monitor to the “Preview” Output video/audio ports.  The “Preview” Output (labeled “Rec/Prev” in WinLGX) allows you to conveniently view the programming on any input.
	5. In order to send basic control commands (PLAY, STOP, REWIND, RECORD) to your external devices, connect supported VCRs and DVD players to the following interfaces.  For information on supported VCRs and DVD players, visit the LEIGHTRONIX Web site (w...
	6. Attach the included power cord to the power cord connecter on the back of the MINI-T-NX, and then plug it into an AC power source.
	7. Turn on the MINI-T-NX by simultaneously pressing the right and left arrows on the front panel for one second.
	a. Initial boot up screen: gives the bootware version, memory size, and memory check status (see Illustration 14, MINI-T-NX Bootware Screen).
	b. Boot up progress screens: give the MINI-T-NX’s boot progress (see Illustration 15, MINI-T-NX Boot Progress Screens).  During initialization, any saved MINI-T-NX settings and active schedule are implemented.

	8. Proceed to “Configuring Ethernet Network Host Management,” on page 37, to configure MINI-T-NX for remote control through Ethernet network host management.

	Configuring Ethernet Network Host Management
	Connecting MINI-T-NX to an Existing Ethernet Network
	1. Obtain the following from your technical support personnel or network administrator and enter into the front panel of your MINI-T-NX (see “Configuring Front Panel Settings,” on page 39):
	2. Using a straight-through RJ-45 Ethernet cable, connect the MINI-T-NX’s Ethernet port to a 10/100 BASE-T hub or switch on the TCP/IP network.
	3. Ensure the PC from which you wish to control your MINI-T-NX has been configured and attached to the TCP/IP network.
	4. Ensure your Controller and PC have been properly configured for Ethernet network access (see “Confirming Ethernet Network Configuration,” on page 38).

	Connecting MINI-T-NX Directly to a PC via Ethernet
	1. If necessary, install and configure a 10/100 BASE-T Ethernet Network Interface Card (NIC) on the PC.  Refer to the NIC documentation and technical support for help in getting the NIC operational.
	2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows:
	a. Click on the Windows “Start” menu.
	b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on your keyboard to open the command.com window.
	c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your PC’s IP and subnet mask address.

	3. Enter the following IP and subnet mask addresses into the front panel of your MINI-T-NX Controller (see “Configuring Front Panel Settings,” on page 39):
	4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the MINI-T-NX to the PC’s network interface card (NIC).
	5. Ensure your Controller and PC have been properly configured for Ethernet network access (see “Confirming Ethernet Network Configuration,” on page 38).

	Confirming Ethernet Network Configuration

	Turning the MINI-T-NX ON/OFF
	Configuring Front Panel Settings
	Entering Password
	1. Press the right arrow key from any one of the status screens to display the password entry screen (see Illustration 16, MINI-T-NX Password Entry Screen).
	2. Press five-key password.
	3. If the password entered is correct, the MINI-T-NX’s configuration menu will be displayed (see Illustration 17, MINI-T-NX Configuration Menu Screen).  If an incorrect password is entered, the display returns to the status screens.  The menu allows y...

	Editing IP Address
	Editing Subnet Mask
	Editing Gateway Address


	Software Installation & Configuration
	About this Section
	WinLGX Minimum System Requirements
	Installing WinLGX Software
	1. Place the LEIGHTRONIX PRODUCT RESOURCE DISC in your CD-ROM drive.  The HTML page shown in Illustration 18 should automatically load.
	a. Open the Windows “My Computer” folder.
	b. Double click your CD-ROM drive.

	2. From the LEIGHTRONIX HTML page, click the “MINI-T-NX” button.  This will load a new page with content specifically for your system.
	3. From the WinLGX software HTML page, click on the “WinLGX Software” link.  A new window containing the executable file will open.
	4. Double click on the file “WinLGX v* Installer.EXE” to start the installer.
	5. Choose “YES” to continue installing the software.
	6. Setup will then prompt you for a program folder.  The default is “Leightronix, Inc.,” but you may change it to anything you desire.
	7. Once you have selected a file path, setup installs the software and creates icons.  It will prompt you again when it is finished.
	8. Click “Finish” to close the installer and return to Windows.

	Adding / Deleting MINI-T-NX Locations in the Site Manager
	1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the “Controller Site Manager” window shown in Illustration 19.
	2. Click “Add” on the “Controller Site Manager” window (see Illustration 19) to open the “Add new controller” window shown in Illustration 20.  Complete the following fields:
	3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, serial number, and time zone displays in the “Add new” window.
	4. Click “OK” to enter your MINI-T-NX server in the site manager database or “Cancel” to abort entry.
	5. If applicable, repeat steps 2–4 for each additional MINI-T-NX server in your system.
	1. Highlight the NEXUS series IP address you wish to delete.
	2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the MINI-T-NX IP address from the site manager location.
	3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the database, or click “Cancel” to discard your changes.

	Connecting to Your MINI-T-NX Server/Controller
	1. Open the WinLGX “Site Manager” window (see Illustration 27) by performing one of the following:
	2. Once the WinLGX “Site Manager” is open, you should see a list of your MINI-T-NX systems.  If not, refer back to “Adding / Deleting MINI-T-NX Locations in the Site Manager,” on page 46.
	3. If desired, reorder your MINI-T-NX server listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	4. Connect as follows (see Illustration 27):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the MINI-T-NX system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen MINI-T-NX server/controller(s) and close the login dialog box.  Once you are connected, a tab appears for each MINI-T-NX server/controller on the main window beneath the toolbar.  If you log...


	Creating New MINI-T-NX Image Files
	1. WinLGX automatically opens with an empty image file loaded.  If you need to clear any settings, select “New” under the “File” menu.
	2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 88, “Save As” Window.”
	3. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the MINI-T-NX image file.
	4. Type a name for the image in the “File name” field.
	5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	6. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”
	7. As you enter your configuration settings according to the “Configuring WinLGX” section starting on page 52, periodically save your settings in your image file by selecting “Save” from the “File” menu or clicking the  toolbar button.

	Configuring WinLGX
	About the Main Window Components
	Configuring the Main Window Components
	Setting User Account Rights (Including WinLGX Password Changes)
	1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see Illustration 31).
	2. WinLGX user rights are described in Table 9, User Control and Configuration Rights (see page 63) and Table 10, User File Access Rights (see page 64).  Perform any of the following according to the steps below:
	3. When finished configuring user information, exit the “User Accounts” window by clicking the “Close” button.

	Changing Front Panel Password
	1. Select “Set front panel password” in the “Tools” menu to open the window shown in Illustration 32.
	2. Click on a combination of five arrows for the new front panel password.
	3. Click “Set” to accept new password or “Clear” to cancel.
	4. Click “Done” to close the “Set Front Panel Password” window.

	Configuring Site Information, Clock, Updating Firmware, and Rebooting
	1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 33, “Controller” Window.
	2. Use the “Controller” window to set the following configuration maintenance settings.  After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for confirmation to perform the action on the connected MINI-T-NX.  Clicking “Yes” op...
	3. Click “Close” to close the “Controller” configuration window.

	Creating Templates for Exporting/Printing Schedules
	1. Create a schedule template per the following steps:
	a. Click “Export/Print templates” in the “Tools” menu to open the window shown in Illustration 34.
	b. Select template display items as follows:
	 Determine which event windows will be filtered for the schedule template:
	 Check the “Export/print switchbacks” checkbox to display switchback intervals between programs.
	 Check “Export/print all records” to include all events in the selected event windows.
	 Add/remove schedule fields (columns) in template as follows:
	c. Click “Save” to save the template to a file.

	2. To revise a template:
	a. Click “Export/Print Templates” in the “Tools” menu to open the window shown in Illustration 34, “Export/Print Templates” Window.
	b. Click “Load.”  In the “Select Export/Print Template” window that appears, browse for the desired template and open.  The filename will then appear in the “Template” box at the top of the “Export/Print Templates” window.

	3. Click “Done” when finished to close the “Export/Print Templates” window.

	Configuring Page Layouts For Schedules Printed from WinLGX
	1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 35, “Page Setup” Window, and configure the schedule printout according to the following options:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Configuring Printer and Paper Settings for Schedules Printed from WinLGX
	1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 37, “Print Setup” Window, which allows you to configure the printer and paper settings as follows:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Configuring User-Defined Schedule Columns
	1. Click “User defined data” under the “Tools” menu to open the window shown in Illustration 39.
	2. Select the fields displayed on your schedule as follows:
	3. Click on the field which you would like to rename.  In the “Edit Field Options” window that appears (see Illustration 40), perform the following:
	a. Enter a new schedule heading into the “Menu title” field.
	b. Add a list of menu items that will be used to define schedule events under the renamed column.  The number of menu items that may be added corresponds to the number of options shown over each section of field names on the window.

	4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit Field Options” window and return to the “User Defined Data” window.
	5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined Data” window.

	Setting WinLGX Viewing and Communication Preferences
	1. Under “Format type,” select the format of the device/library event properties window you would like to configure.
	2. Perform any of the following options:

	Configuring MINI-T-NX System’s Switcher Properties
	Configuring MINI-T-NX IR Port Properties
	1. IR Port: configure each IR port for a VCR or DVD input device by selecting the corresponding format from each IR port field’s drop down list.
	2. “Manufacturer”: choose the corresponding, LEIGHTRONIX-supported manufacturer for each input device format (see Table 11, IR Port Configuration Options, for a list of the LEIGHTRONIX-supported VCR/DVD manufacturers).
	3. “Type”: configure each IR port to match the connected device’s communication mode.  Refer to Table 11, IR Port Configuration Options, for a list of the LEIGHTRONIX-supported VCR/DVD manufacturers and their corresponding communication modes.

	Configuring MPEG Recording Presets for Recorder Option
	Editing Internal MPEG Player and Recorder Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices” window (refer to Illustration 55, “Devices” Window).
	2. In the “Resource View,” click on the desired MINI-T-NX internal device icon to reveal the corresponding properties fields.

	Creating External Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 57, New Device Properties).
	2. Right click in the “Resource View” window and select “New” to display the device type menu.  Select a device type to add a new device to the window (see Illustration 57, New Device Properties).
	3. Complete the “Properties” fields for one of the following device resources:

	Creating Library Resources


	Software Operation
	About this Section
	Performing General WinLGX Operations
	Opening and Logging into WinLGX
	1. Double click the WinLGX desktop icon. The login window shown in Illustration 79 automatically appears when WinLGX is opened or when you click one of the following:
	2. If desired, reorder your IP address listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	3. Log in as follows (see Illustration 79, “MINI-T-NX Site Manager” Window):
	a. Select the IP addresses of the LEIGHTRONIX Digital Server/Controller IP you want to log into.  You may select up to eight addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with your username and password.  To simultaneously log into multiple LEIGHTRONIX Digital Server/Controllers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen MINI-T-NX controller(s) and close the login dialog box.  Once you are connected, a tab appears for each MINI-T-NX on the main window beneath the toolbar.
	d. If you logged into more than one MINI-T-NX controller, switch between the controllers by clicking on the MINI-T-NX tabs on the main window.


	Displaying WinLGX Version Number
	Printing Schedules from WinLGX
	1. Create a print template to select the desired schedule information for printing (see “Creating Templates for Exporting/Printing Schedules,” on page 68).
	2. Determine the page layout of your schedule printout (see “Configuring Page Layouts For Schedules Printed from WinLGX,” on page 70).
	3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the template selection window shown in Illustration 81.
	4. Choose the desired template from the “File name” list in the “Select Export/Print Template” Window (see Illustration 81) and click “Open,” or double click the template file to open the “Print” window.  Click “Cancel” to abort the print.
	5. In the “Print” window, configure the printer and copy settings according to the following steps. Click “OK” to print or “Cancel” to abort the print.

	Exporting Schedules into Microsoft Excel® or a Comma Delimited Format
	1. Create a template (see “Creating Templates for Exporting/Printing Schedules,” on page 68).
	2. Select “Save as” in the “File” menu to open the window shown in Illustration 82, which allows you to export the loaded schedule under a new name and a Microsoft Excel® or comma delimited file format as follows:
	a. Select a folder in the “Save in” field.  The default is “MINI-T-NX images.”
	b. Type a name for the exported file in the “File name” field.  If you leave the extension off, WinLGX puts it on for you.
	c. Select the export format (Comma Separated or Excel®) in the “Save as type” field.
	d. Click “Save” to open the template selection window shown in Illustration 83, “Select Export/Print Template” Window.

	3. Choose the desired template from the “File name” list in the “Select Export/Print Template” (see Illustration 83) and click “Open” or double click the template file to create the export schedule file.  The file can then be opened in your favorite d...

	Logging out of WinLGX
	1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open the “Site Manager” window shown in Illustration 79.
	2. Select the LEIGHTRONIX Digital Server/Controller address(es) you would like to disconnect.  If you want to disconnect from more than one address, hold down your keyboard “Ctrl” key and click on each address with the left mouse button.
	3.  Click the “Disconnect” button.  A box will appear asking whether or not you would like to disconnect from the current LEIGHTRONIX Digital Server/Controller location(s).  Click “Yes” to disconnect or “No” to remain connected.

	Exiting WinLGX
	1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main window.
	2. If an image file has not been saved for one of the connected controllers, the dialog box shown in Illustration 84 appears and asks if you want to save the changes.  Select one of the following options:


	Opening MINI-T-NX Image Files
	Opening a Saved Image File
	1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 85.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data is then loaded into WinLGX.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 142, periodically save your settings in an image file as described in “Saving MINI-T-NX Image Files,” on page 140.

	Opening an Image File as New
	1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 86, Open Image File as New Window.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data minus the schedule is then loaded into WinLGX as an unnamed file.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 142, periodically save your settings in an image file as described in “Saving MINI-T-NX Image Files,” on page 140.

	Receiving Image Files from the Connected MINI-T-NX Server/Controller(s)
	1. Download the last image file sent to one or more of your MINI-T-NX server/controllers as follows:
	2. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 142, periodically save your settings in an image file as described in “Saving MINI-T-NX Image Files,” on page 140.

	Associating MINI-T-NX Image Files with WinLGX

	Saving MINI-T-NX Image Files
	1. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the MINI-T-NX image file.
	2. Type a name for the image in the “File name” field.
	3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	4. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to overwrite it.

	Scheduling Events
	About Schedule Window Components
	Scheduling/Editing/Deleting All Events
	1. Select a scheduling event window as follows:
	a. Click the desired day tab to select the day you want the event to occur.
	b. If your MINI-T-NX has the record option, select one of the following channel tabs:

	2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event window.  This opens an “Event properties” box with editable event information like the one shown in Illustration 91, Day/Channel Output Event Properties Box.
	3. To add or change the event information, click on each of the desired editable fields (described on pages 156–188) and enter the new information.  An icon can be dragged and dropped into a day/channel output event window in the following five ways:
	a. To select a date, change “Absolute date” to “Yes.”  A date field appears below to allow date entry.
	b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be toggled quickly by double clicking on the day name.
	a. Select the desired device or library resource icon.
	b. Click on the desired editable resource fields in the “Properties” window and make the changes.
	c. WinLGX displays a dialog box that gives you the option to merge the resource editing changes into each event in the WinLGX-LT event window that was created from the same resource.

	1. If you would like to change your library resource before using it to replace event(s), select the library resource in the “Resource View” window and then edit its resource properties.
	2. Drag a library resource onto a same-format library resource event you would like to replace.  The event properties window for the library resource will open, displaying a “Replace” button on the bottom of the window (see Illustration 95).
	3. If desired, edit the properties of the library resource.
	4. Click the “Replace” button to open the “Find and Replace” window shown in Illustration 96.  This window gives you a variety of options for replacing the selected event or all schedule events like the selected one with the dragged library resource.
	5. To make a replacement, click one of the replacement buttons on the bottom of the “Find and Replace” window.  The replacement buttons are described in Illustration 96.
	1. If you would like to change your library resource before inserting it in your schedule, select it in the “Resource View” window and then edit its resource properties.
	2. Drag a library resource onto an unlocked library resource event of the same format.  The event properties window for the library resource will open. If there is enough time available to accommodate the new resource’s length, an “Insert” button will...
	3. If desired, edit the properties of the library resource.
	4. Click the “Insert” button to assign the selected event’s start time to the dragged library resource event.  All unlocked events below the inserted event will shift downward in the schedule by an amount of time equal to the length of the inserted ev...

	Scheduling/Editing Device Resources
	Scheduling/Editing Library Resources
	Editing Program Intervals
	1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel Switchback Editor” (see Illustration 114).
	2. Select the channel output/day tab schedule window containing the switchback inputs you would like to change by selecting a channel output under “Channel” and a day under “Day of week.”  You may select “All” under “Day of week” to select all schedul...
	3. Under “Replace all,” select the switchback input you would like to change.
	4. Use the “With” drop down menu to select a new switchback input.
	5. Click “OK” to make the changes or “Cancel” to abort.

	Checking Schedule and Library Resources for Missing MPEG Files
	1. If you have not already done so, open a MINI-T-NX image file in WinLGX.
	2. Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync Library Resources” menu item.  Those events containing missing MPEG files are highlighted in the schedule (red is the WinLGX default color) and a “Sync Library Reso...


	Sending MINI-T-NX Image Files
	1. Send an image file to one or more of the currently connected server/controllers according to the following steps:
	2. Once each transfer is completed, the MINI-T-NX system(s) will contain and execute the scheduled events.

	Using Control Panel to Perform Immediate Device and Switch Actions
	1. Open the Control Panel window (see Illustration 117) by clicking “Control Panel” under the “Tools” menu or  icon on the main toolbar.
	2. If desired, sort the device icons by right-clicking in the “Devices” column and selecting one of the sorting filters in the right-click menu that appears (see Illustration 118, Control Panel Device Sorting Menu).
	3. Perform any of the following steps:
	4. When finished, click “Close” to close the control panel.
	Stop/Start a Schedule
	Performing Forced Switches and Viewing Switcher Status
	Displaying Programming through the “Preview” Output
	Controlling Internal MPEG Player
	Controlling Internal MPEG Recorder
	1. Select the MPEG file recording parameters:
	a. Check the “Record CC data” box to capture any closed caption data from the source during recording.  Closed captions are hidden in the video signal and decoded for display on televisions with built-in decoders or televisions connected to external d...
	b. Select one of the following record overwrite options:
	c. Under “File,” enter up to 27 characters for the filename.
	d. Select one of the user-defined record presets for the desired recording quality.  See “Configuring MPEG Recording Presets for Recorder Option,” on page 90 for more information on defining the recording quality settings.
	e. If you would like a library resource for the MPEG file added to the “Library” tab window, select the “Add to library” option.  Once the MPEG recorder stops, WinLGX displays the “Add to library” window (see Illustration 134).  Select the library fol...

	2. Select and record an input through one of the following options:

	Controlling External Devices

	Managing Digital File Storage
	Getting Started
	1. Select “Storage Manager” from the “File” menu or click the  icon on the main toolbar to open the window shown in Illustration 138.
	2. Select one of the following to display the corresponding file type:
	3. The left side of the Storage Manager window allows you to access the storage areas on your MINI-T-NX and PC or network.  Select a storage area as follows:
	4. The right side of the Storage Manager window allows you to access your MINI-T-NX storage areas.  Select your MINI-T-NX from the “Controller” drop down menu.
	5. Perform any of the file management operations listed under the following sections:

	Managing Videos and Slides
	Managing SLIDES: Uploading to the MINI-T-NX and Authorizing for Display
	3. Right click on the slide to select it and display the file management menu (see Illustration 142).  Select either “Move” to remove the file from its local storage area and transfer it to the selected user folder or “Copy” to create a duplicate of t...


	Retrieving Log Files
	1. Click on the “As played” tab on the “Select Controller Log File” window.
	2. Single click on the desired .CSV file to select it and then click “OK.”
	3. A “Save as Played log File” window will open.  Save the .CSV file to a new file path or use the WinLGX default log file path (Shared Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).
	4. Click the “Save” button to save the file to your chosen file path.  The “Save as Played log File” and “Select Controller Log File” windows will close.
	5. Navigate to the file path for the saved .CSV file and open it in Excel.

	Firmware/Software Updates
	Updating MINI-T-NX Controller Firmware
	1. Open the WinLGX software and log in to your MINI-T-NX (see “Opening and Logging into WinLGX” on page 130).
	2. Log in to the MINI-T-NX and choose “Controller” under the “Tools” menu to open the “Controller” window shown in Illustration 148.
	3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” window shown in Illustration 149.
	4. Navigate to and open the .fmw update file for your MINI-T-NX Controller’s firmware.  Once you have selected and opened the file, the firmware version and file size will be entered into the “Controller” window (see Illustration 150).
	5. Click “Update” to start the firmware update.  Click “Yes” when prompted to start the update.
	6. Once the update has completed, click “OK” to apply the changes and reboot the MINI-T-NX.  You will be logged out and the “Site Manager” window will be displayed.
	7. After the MINI-T-NX finishes rebooting, log back in and confirm MINI-T-NX has been upgraded to the latest firmware version in the “Site Manager” database.

	Updating WinLGX Software
	1. Close WinLGX.
	2. Navigate to and open the WinLGX installer file.  Follow the prompts to install the latest version of the client software.
	3. Click “OK” to continue WinLGX update.
	4. Follow the prompts to complete the installation.



	Troubleshooting
	Parts Replacement
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	Appendix A: Total Backup
	Opening & Logging Into Total Backup
	1. Select “Preferences” under the “Tools” menu to open the “Preferences” window.  Ensure the file path under “Total Backup application folder” matches the location where the Total Backup program is installed on your computer or network (see Illustrati...
	2. Open the Total Backup program using one of the following methods:

	Selecting Storage Locations for MINI-T-NX Information
	1. From the “Total Backup” window, select “Local Path Settings” from the “File” menu to display the backup path window shown in Illustration 153.
	2. Save your MINI-T-NX data to one or more of the following locations:
	3. Click “OK” to save storage path settings and close the “Settings” window.
	4. Perform one of the following:

	Performing an Immediate Backup
	1. On the “MINI-T-NX Total Backup” window, check the boxes next to the MINI-T-NX storage areas you would like backed up.
	2. Click the “Backup” button to start an immediate backup.  Click the “Stop” button to halt a backup before it finishes.  To restart, click the “Backup” button again.  The backup will resume from where it left off.

	Performing Scheduled Backups
	1. Click the “Modify” button or “Scheduler Settings” under the “File” menu to open the “Backup Scheduler” Window shown in Illustration 154.
	2. Using the date and time drop down boxes, specify how often you would like the backup to occur.
	3. Check boxes next to the MINI-T-NX storage areas you would like backed up.
	4. Click “OK” to make backup schedule changes or “Cancel” to abort.

	Restoring MINI-T-NX Information
	1. On the “MINI-T-NX Total Backup” window, click the “Restore” button to open the “Restore” Window shown in Illustration 155.
	2. Check the “Unit Settings” box if you would like to restore network configuration settings, usernames and passwords, and front panel password.
	3. Check boxes next to the MINI-T-NX storage areas you would like to restore with the last saved backup information.
	4. Select “Overwrite existing files?” to replace existing files that have the same name as the backup files.
	5. Click “OK” to restore files or “Cancel” to abort.


	Appendix B: Total Import
	1. Double click on the Total Import desktop icon to display the Total Import program window (see Illustration 156, Total Import Main Window).
	2. Insert a DVD into your PC’s DVD drive.  Load the DVD titles (files) into the “Source” panel on the Total Import window according to the following steps (see Illustration 157):
	a. Click the “Browse” button.  In the “Browse for folder” window that appears, navigate to your local DVD drive and select the DVD drive letter.  Click “OK” to display a list of your DVD’s titles on the “Source” panel.
	b. Select each DVD title you would like to import by checking the boxes to the left of the titles.  A selected title will have a green checkmark in its box.

	3. In the “Settings” panel, perform the following (see Illustration 158):
	4. Under “Destination,” specify where on your PC you would like your newly encoded MPEG file(s) saved (see Illustration 159).  Total Import will create a separate MPEG file for each DVD title within the specified storage area.
	a. Click the “Browse” button and in the “Browse for folder” window that appears, navigate to a storage area on your PC large enough to hold the MPEG files.  The Total Import encoding process will create MPEG files that are larger than the original DVD...
	b. Use the “Temporary Storage” field’s “Browse” button to specify where on your PC you would like Total Import to store the imported DVD titles.  Total Import automatically deletes the imported titles once they are converted into an MPEG-2 file.
	c. Assign filenames with either the “Filename” or “Filename Prefix” field as follows:
	d. Check the “Overwrite” box if you want to save the file over an existing file with the same name.

	5. Click the “Start” button to import and encode the DVD titles.  The percentage of the job completed will be displayed in the “Source” panel next to the “Start” and “Stop” buttons.  Click “Stop” if you need to prematurely end the job.  Any of the job...
	6. Once you have finished importing and encoding your DVD titles through Total Import, use the Storage Manager in WinLGX to transfer the new MPEG files to your MINI-T-NX’s internal hard drive.  See “Managing Digital File Storage,” on page 208, for ins...

	Appendix C: PRO-BUS Interface Connections
	Set Switches
	Assign Interface an Address
	Configure Interface to Send Control Commands

	Attach PRO-BUS to Corresponding Device
	Connect PRO-BUS to Controller and other PRO-BUS Interfaces

	Appendix D: Copyright Statements
	WhitSoft SlimFTPd
	The PHP License, version 3.0
	1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
	2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
	3. The name “PHP” must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact group@php.net.
	4. Products derived from this software may not be called “PHP”, nor may “PHP” appear in their name, without prior written permission from group@php.net.  You may indicate that your software works in conjunction with PHP by saying “Foo for PHP” instead...
	5. The PHP Group may publish revised and/or new versions of the license from time to time. Each version will be given a distinguishing version number.  Once covered code has been published under a particular version of the license, you may always cont...
	6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes PHP, freely available from <http://www.php.net/>”.
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